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Dedication 

 

The latest Spartan release (Spartanô26), is the first in more than 37 years since its initial 

conception in 1989 (2 years before Wavefunction Inc. was founded) without Spartanôs 

founding architect, Warren J. Hehre.  
 

Our founder had a knack for the transformative, he was instinctively drawn towards it. From 

the underpinnings of molecular orbital theory, learned as Roald Hoffmanôs first research 

assistant (as an undergraduate at Cornell University) to supporting John Pople at the Mellon 

institute in building the (ñPople-Hehreò) basis sets that went on to form backbone of modern 

quantum chemical calculations, Warren Hehre was there. When SGI first introduced 

graphics capable of a facsimile of his vision, the application Spartan was born. 
 

Early utility as a graphical interface to the Gaussian computational code (which, along with 

John Pople, Warren also helped establish) led to a large initial adoption by computational 

chemists. Warrenôs view, however, was somewhat more inclusive and encompassing. He 

envisioned a tool (or set of tools) that the mainstream chemistry community could depend 

upon, combining the power of molecular modeling with the rapidly accelerating technology 

of the personal computer, and that these tools would be accessed via graphical interface 

designed to democratize computational chemistry.  
 

Molecular visualization exploded in the early 1990ôs making accurate computational 

approaches like density functional theory more practical. In the early 2000ôs Wavefunction 

partnered with Q-Chem establishing an ongoing collaboration bringing the computational 

pipeline (including significant contributions from Martin Head-Gordon, Anna Krylov, Peter 

Gill, John Herbret, and others) from numerous computational groups to chemists across 

numerous disciplines: Analytical & Instrumentation chemists, Synthetic & Process 

chemists, Natural Products chemists, Organometallic chemists, Chemistry educators, and 

those involved in Cheminformatics. 
 

Warrenôs attention to the practical is seen throughout the Spartan user interface but also in 

the computational developments he pursued while leading Wavefunction Inc. These include 

a host of molecular visualization options (notably the electrostatic potential map and the 

polar and accessible area properties based upon ESP), the T1 thermochemical recipe 

providing rapid accurate heats of formation, and the host of NMR workflows for flexible 

organic molecules including the 2019 QM-NMR protocol and the more recently the MLXD 

and MLHF-NMR protocols. Recent efforts are representative of that knack for the 

transformative and leverage machine learning approaches in pursuit of structure elucidation.  
 

Warren J. Hehre submitted his final calculations in January of 2026. He was in the middle 

of several projectsïsome of these available for the first time in Spartanô26. Eternally missed, 

perpetually channeled, and never forgotten; the world is a less clever place without him. 
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Scope of this Guide 
 

This guide provides a general working reference for Spartanô26 for Windows, Macintosh 

and Linux. Following an introduction which presents Spartan as a tool for exploring 

organic, bioorganic and medicinal, inorganic and organometallic chemistry by way of 

molecular mechanics, quantum chemical calculations, and machine learning approaches, 

together with an array of graphical models for conveying the results of these calculations, it 

comprises 27 chapters grouped into five sections (along with several appendices). 

Section I (New Feature Tutorials) provides a set of tutorials featuring use of the new 

machine learning (neural network) routines and their application to energy, structure, and 

multi-step conformational searching and NMR protocols. 

 

Section II (Operations and Overview; Chapters 1-2) describes the operation of Spartanôs 

graphical user interface and presents a ñwalk throughò illustrating basic interface 

components. 

 

Section III (Organic Molecules; Chapters 3-7) comprises a set of 

tutorials that illustrate Spartanôs building capabilities (both 2D and 3D), show how 

information can be retrieved from the Spartan Spectra and Properties Database (SSPD) and 

how quantum chemical calculations can be set up, submitted, and the results 

accessed/interpreted. 

 

Section IV (Advanced Tutorials; Chapters 8-15) provides additional tutorials that extend 

coverage to inorganic and organometallic molecules as well as molecules of interest to 

medicinal chemists. These tutorials also address a number of capabilities not covered in the 

previous section, including multi-molecule documents and associated spreadsheet and 

plotting functions and procedures for identifying low-energy conformers and establishing 

conformer distributions, for obtaining NMR spectra of organic molecules with several 

degrees of conformational freedom, for finding reaction transition states and assigning 

reaction regio and stereochemistry based on matching calculated and experimental  

NMR spectra and for assessing the ñsimilarityò of molecules, either in terms of structure or 

of chemical function descriptors (CFDs).  

 

Finally, a set of tutorials is provided to illustrate the access/use of the Cambridge Structural 

Database from within Spartan. The tutorials in this section are much closer to ñresearch 

gradeò than the earlier tutorials especially with regard to the use of NMR spectroscopy. 

 

Section V (Features and Functions; Chapters 16-27) describes in detail the functions 

available from the menus incorporated into the graphical user interface for Spartan. The 

focus is on graphical input and manipulation of structure, input of other required information 



 

and text, spectral and graphical output resulting from molecular mechanics and quantum 

chemical calculations, and on use of databases of previously calculated structures, energies, 

properties and spectra accessible from Spartan. This section is intended as a general 

reference to Spartanô26.  

 

What this guide does not do is thoroughly document the performance and cost (in 

computation time) of the different molecular mechanics and quantum chemical models 

available in Spartanô26 or explicitly recommend specific models or combinations of models 

for use on chemical problems. Nor does it show the utility of graphical models in presenting 

and interpreting the results of the calculations. However, the choice of models used in the 

tutorials can be taken as implicit recommendation as to what we feel as suitable both in 

terms of accuracy and practicality, and limited information about the relative cost of these 

models is supplied, specifically. performance and cost in Appendix A. They are covered in 

greater depth in A Guide to Molecular Mechanics and Quantum Chemical Calculations* 

included as a PDF under the Help menu. The guide also provides a collection of illustrative 

examples. 

 

Additional appendices provide an overview of the programôs overall architecture as well as 

its present capabilities and limitations (B), a directory of functions under its menus (C), a 

listing of commonly-used options (D), a listing of units (E), the proper journal citation for 

Spartanô26 and the SSPD (F), instructions for installing the Cambridge Structural Database 

(G), directions for making databases from Spartan calculations (H), examples of 

pharmacophore input (I ), input of experimental infrared, UV/visible and NMR spectra (J), 

setting up and accessing remote Spartan servers (K ) and providing chemical shift standards 

for NMR calculations with different theoretical models (L ). Additional materials relating to 

several of these appendices may be found as PDFs under the Help menu. Finally, a practical 

glossary is included defining many specialized terms and acronyms unique to computational 

chemistry, quantum chemical calculations, and methodology nomenclature.  

 

An up-to-date version of this Tutorial and Userôs Guide is available via online 

documentation at: https://www.wavefun.com/spartan-documentation. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

* This 2003 reference is somewhat dated as some models cited have certainly been overtaken (replaced) by 

modern models (in particular, missing are assessment of the new Head-Gordon and Truhlar functionals). An 

updated version is this guide is a work in progress.  
  

https://www.wavefun.com/spartan-documentation
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Introduction 
Every few decades chemists are presented with a new tool so powerful that it changes the 

very landscape of the subject. NMR spectroscopy is an excellent example, for it 

fundamentally altered the way that the structures of molecules are revealed, in many cases 

replacing difficult and time-demanding synthesis with a simple spectral measurement. We 

believe that computational methodology (ñmolecular modelingò) especially in light of 

advances in artificial intelligence and machine learning models, is poised to have an equal 

or perhaps greater impact on the way chemistry is done. 

Molecular mechanics and quantum chemical calculations provide structures, relative 

stabilities, properties and spectra of isolated molecules. Because of their inherent simplicity, 

molecular mechanics calculations have long been used throughout multiple sub-disciplines 

of the mainstream chemical community. On the other hand, quantum chemical calculations 

are more time demanding, and only in the last ten to twenty years have fast enough 

computers become widely available to make their application routine among mainstream 

chemists.  

Under the umbrella of Artificial Intelligence are Machine Learning (ML) models. These 

include Neural Network (NN) modelsò or simply ñneural netsò trained to provide specific 

data. In the chemistry space, this often includes energies, structures, properties, NMR 

chemical shifts, etc. based (arguably sufficient levels of) experimental data. In the case of 

Spartan a series of similarly developed ML approaches (technically neural network models) 

trained on a large (potentially infinite) source of quantum-chemical data, are included. These 

models have been formally  defined and validated within the last several years in a set of 

increasingly detailed publications,1-5 in an area of chemistry that is exploding (application 

of AI or Machine Learning). The latest Spartan versions take advantage of  more as many 

as 8 different neural network models (often used in multi-step workflows (flexible NMR 

prediction, conformational analysis) to supplement and in specific instances replace time-

consuming quantum chemical calculations. 

Quantum chemical calculations are called upon to furnish information about the mechanisms 

and product distributions of chemical reactions, either directly by calculations on transition 

states, or indirectly based on the Hammond Postulate, by modeling the steric and electronic 

demands of the reactants. Quantitative calculations leading directly to information about the 

geometries of transition states, and about reaction mechanisms in general, are becoming 

more and more common, while qualitative models are required for systems that are too large 

or too complicated to be subjected to the more rigorous treatments. Quantum chemical 

 
1  J. Comp. Chem. 2025, 46(1), 70016 
2  J. Chem. Inf. Model. 2025, 65(5), 2314-2321 
3 J. Comp. Chem. 2025, 46(12), 70129 
4 J. Org. Chem. 2025, 90(32), 11478-11485 
5 ChemRxiv 2026, preprint 

https://doi.org/10.1002/jcc.70016
https://doi.org/10.1021/acs.jcim.4c01898
https://doi.org/10.1002/jcc.70129
https://pubs.acs.org/doi/10.1021/acs.joc.5c00927
https://pubs.acs.org/doi/10.1021/acs.joc.5c00927
https://doi.org/10.26434/chemrxiv.15001441/v1
https://doi.org/10.26434/chemrxiv.15001441/v1
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calculations are also able to furnish infrared, Raman spectra, and new in this release VCD 

spectra. QM also supports excited state calculations, UV/visible spectra, and NMR spectra 

(shifts and couplings).  

The use of calculations to support or challenge structures assigned by NMR or to employ 

NMR to distinguish between regio and stereoisomers that might result from a specific 

chemical reaction is of particular value. Finally, quantum chemical calculations can supply 

information to complement existing experimental data or to replace it altogether, for 

example, the use of atomic charges for QSAR analyses, and intermolecular potentials for 

molecular mechanics and molecular dynamics calculations. Machine Learning models have 

joined the ranks of general ñmethodsò available from Spartan. While currently more 

restricted in application, they are often incredibly fast, and while not an exact replacement 

for quantum chemical calculations, they are proving demonstrably reliable. There is every 

reason to believe that for some tasks, neural network models will become a popular (perhaps 

the most common) computational approach. 

Spartanô26 (ñSpartanò) has been designed to address the ever increasing role that 

calculations play in chemistry and related fields. It represents a continuing collaboration 

between Wavefunction Inc., and Q-Chem Inc. Q-Chem code supplements and extends the 

traditional strengths of Spartan: an easy to learn and use tool for molecular mechanics and 

quantum chemical and now, machine learning calculations. Spartan is intended to be use by 

chemists, not only computational chemists who are already familiar with the capabilities of 

molecular mechanics and quantum chemical calculations (QSAR, Cheminformatics) and 

ML modeling, but also experimental chemists who may have little or no prior experience 

but want to use calculations much in the same way as experimental techniques like NMR or 

Mass spectroscopy are employed. 

Spartan includes a series of independent modules, tightly connected via a highly functional, 

but simple and uncluttered graphical user interface. The interface has become less 

ñunclutteredò over the years, but the Spartan  philosophy of keeping things as simple as one 

can is embraced throughout. The interface has been designed not only to greatly reduce the 

drudgery and possibility for human error associated with the preparation of input, but also 

to guide and simplify the interpretation of output. 
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Spartanôs interface provides the gateway to a range of modern methods, including molecular 

mechanics models, semi-empirical and Hartree-Fock molecular orbital models, and 

correlated models including a wide variety of density functional models, Mßller-Plesset 

models and a selection of high-order wave function-based models such as the popular 

CCSD(T) approach. Thermochemical recipes such as G3(MP2) and G3 intended to closely 

mimic the results of CCSD(T) and other high-level correlated models at a small fraction of 

the computational cost are also supported. A full range of basis sets is supported including 

the computationally efficient series from Pople-Hehre, cc-pVDZ, cc-pVTZ and cc-pVQZ 

series from Dunning and the def2 series from Alhrichs and Weigand as well as basis sets 

customized for individual properties. None of these models is likely to be ideal for every 

application. While the most sophisticated quantum chemical models may yield excellent 

results, they will likely be too time consuming for routine application, and it may be 

necessary to contend with lesser treatments. Spartanôs interface facilitates mixing and 

matching different molecular mechanics and quantum-chemical models. Results from one 

model may easily be passed on for further analysis with other (more rigorous) models. 

Machine learning (ML) or neural network (NN) approaches offer the possibility of a new 

class of computational methods that offer the potential of both high reliability and quality as 

well as low computational cost. Implemented in Spartanô26 v.1 (and later) are a growing set 

of seven published neural network models. These were developed to (i) improve conformer 

energy differences provided from MMFF94 molecular mechanics, (ii) accurately estimate 

ɤB97X-D/6-31G* equilibrium geometries starting from MMFF geometries, (iii) accurately 

estimate total energies from one of the following three: 

ɤB97X-V/6-311+G(2df,2p)//ɤB97X-D/6-31G* 

ɤB97M-V/6-311+G(2df,2p)//ɤB97X-D/6-31G* 

ɤB97M(2)/6-311+G(2df,2p)//ɤB97X-D/6-31G* 
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(above) models, starting from either ɤB97X-D/6-31G* equilibrium geometries and energies 

or from estimated ɤB97X-D/6-31G* geometries and energies (via neural network), and (iv) 

provide fast, accurate 1H and 13C chemical shifts, trained to reproduce results from the 

empirically corrected ɤB97X-D/6-31G* model. All machine learning models are supported 

for closed shell uncharged structures comprising the elements: H, C, N, O, F, S, Cl and Br 

(only). Continued neural network development is underway; additional machine learning 

models will almost certainly find their way into future Spartan releases. 

Two of the most important quantities to come out of calculation are energy and geometry. 

While these are unique for a rigid molecule, molecules with one or more rotatable single 

bond and/or six or higher-member ring comprise a series of conformers, each with its own 

geometry and energy. Spartan provides automated (single human step) protocols to furnish 

either the ñbestò (lowest-energy) conformer or the set of low-energy conformers that 

represent the Boltzmann distribution. Molecular mechanics and a variety of quantum 

chemical models may be used to analyze conformation. In some cases, machine learning 

(neural network) models may also be employed. 

Spartan provides access to several common spectral quantities, in particular infrared spectra 

(molecular mechanics, semi-empirical, Hartree-Fock, density functional and MP2 models), 

Raman spectra and VCD spectra (Hartree-Fock and density functional models), NMR 

spectra (Hartree- Fock,  density functional models and a Machine Learning approach for 1H 

and 13C) and UV/visible spectra (CIS, CIS(D) and time-dependent density functional 

models). Experimental IR, NMR and UV/visible spectra from freely available on-line 

databases are easily accessed and superimposed for comparison with calculated spectra. 

Spartan provides tools to quantify both the similarity of molecular structures and of 

chemical environments characteristic of these structures. Also available is the ability to 

identify molecules that fit into a specific chemical environment (a so-called 

pharmacophore). Pharmacophores may be extracted from small molecules bound to 

macromolecules (proteins and nucleotides) from the PDB (Protein Databank). 

Spartan includes a variety of graphical tools to assist in interpreting the results of 

calculations as well as similarity analyses. These include structure models as well as 

molecular orbitals, electron and spin densities, local ionization potentials and electrostatic 

potentials that can be displayed as surfaces, slices, and property maps. 

Spartan accesses several different databases of calculated and (where available) 

experimental information. The SSPD (Spartan Spectra and Properties Database version 7) 

comprises calculated geometries and NMR spectra obtained from the ɤB97X-D/6-31G* 

density functional model for >300k molecules. Most entries also include energies from three 

additional models (these came primarily as the ñtraining setò data for our energy neural 

networks): ɤB97X-V/6-311+G(2df,2p), ɤB97M-V/6-311+G(2df,2p) and the ɤB97M(2)/6-

311+G(2df,2p) model, allowing more accurate reaction energies to be calculated (ñon-the-

flyò). About 90% of the SSPD entries have been appended with supplementary IR spectra, 

calculated using the ɤB97X-D/6-31G* density functional model. This allows enthalpies, 
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entropies and Gibbs energies to be accessed (ñon-the-flyò). Finally, heats of formation from 

the T1 thermochemical recipe are available for about 90% of  the SSPD entries. 

SSPD also includes å8,000 calculated transition-state geometries obtained from the ɤB97X-

D/6-31G* model for concerted reactions (primarily Diels-Alder, 1,3-dipolar, Cope, Claisen, 

ene and hydroboration) with improved energies from ɤB97X-V/6-311+G(2df,2p).  

Spartanô26 allows the user to construct a database to be used by itself or in conjunction with 

the SSPD v. 7 collection, the minimum requirement being an equilibrium or transition-state 

geometry obtained from the ɤB97X-D/6-31G* model. 

Additionally, Spartan accesses the freely available data collections such as the PDB of 

>253,000 protein structures, IR, UV/vis, and thermodynamic data from NIST, and chemical 

shift data from the NMRShiftDB. Finally, and by separate license, Spartanô26 can search 

the latest release(s) of the Cambridge Structural Database (the CSD) of more than a million 

X-ray crystal structures. 

New features in Spartanô26: 

Several improvements distinguish Spartanô26 from its predecessor(s), most notably: 

Machine Learning (Neural Network) routines: These presently fall into 3 groups, neural 

networks that provide improved energies, a single routine that provides structure 

(equilibrium geometries), and neural net models for  NMR shifts (proton and 13C). A full 

description is available in the Topics section of the Activities menu, or from Appendix A 

(to this reference). 

Neural Networks for Conformational Energy Differences: 

Spartanô26 includes a neural network termed Corrected MMFF or DLFF03 (the name 

ñcorrectedò is not intended negatively towards MMFF, as the routine relies on MMFF94 

structure. It attempts ɤB97X-V/6-311+G(2df,2p)[6-311G*] quantum chemical level 

improvement. From a performance perspective, these energies are essentially ñfreeò. In 

practice, they run on a time scale of less than a second to a few seconds per calculation. 

While of significant utility alone, this routine is most useful in the context of conformational 

searching. In Spartanô26 we provide new options for utilizing this neural network in 

conjunction with) MMFF. Available from the Equilibrium Geometry task as well as the 

multi-step density functional-based routines: Equilibrium Conformer, Conformer 

Distribution, and the NMR Spectrum task. 

Quantum Mechanics Quality Energies 

Given input geometries from either: ɤB97X-D/6-31G* or DLFFG1 (a neural network 

trained to estimate ɤB97X-D/6-31G* geometry), these are termed: 

DLXD2XV or Est. Density Functional: ɤB97X-V/6-311+G(2df,2p)//ɤB97X-D/6-31G* 

DLXD2MV or Est. Density Functional: ɤB97M-V/6-311+G(2df,2p)//ɤB97X-D/6-31G* 

DLXD2M(2) or Est. Density Functional: ɤB97M(2)/6-311+G(2df,2p)//ɤB97X-D/6-31G* 
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This represents a significant time savings, over high-quality energy calculations from:  

ɤB97X-V/6-311+G(2df,2p), ɤB97M-V/6-311+G(2df,2p), and ɤB97M(2)/6-311+G(2df,2p) 

models lead to significantly improved reaction and conformer energies compared to those 

from the much less costly ɤB97X-D/6-31G* model. These routines are also offered as either 

stand-alone calculations, or as options in a number of multi-step protocols accounting for 

conformational analysis and flexible molecule NMR shift prediction. 

A Neural Network model for Structure (Equilibrium Geometry) 

Spartanô26 includes a neural network routine that, provided an optimized MMFF structure, 

will furnish an Est. Density Functional ɤB97X-D/6-31G* structure (Equilibrium 

Geometry) using DLFFG1. This is not an instantaneous calculation; unlike the neural 

network routines that provide energies, this approach performs an optimization of structure.  

DLFFG1 was trained against a large dataset of >6 million energy and force calculations, 

using organic molecules ranging from å200 to 600 amu). This geometry neural network 

sufficiently reproduces ɤB97X-D/6-31G* geometries such that 90% of 13C shifts, based on 

its geometry results, fall within 1 ppm of reference (ɤB97X-D/6-31G*//ɤB97X-D/6-31G* 

GIAO calculations with linear scaling and empirical corrections). Note, this routine was not 

trained for high quality energies, nor does it supply a wave function (necessary for 

calculation of most graphical models). As such, this neural network is often used in 

conjunction with either: an Energy (single point energy) calculation at ɤB97X-D/6-31G*, 

or one of the above three QM energy neural networks (in the context of conformational 

searching). 

Estimating accurate Proton and 13C NMR Chemical Shifts 

In recent years, the challenging task of assigning structure has been supported by density 

functional calculations (typically GIAO-based). Calculations have become a useful tool to 

aid or challenge constitutional and stereochemical assignments. Spartanôs 2019 QM-based 

multi-step protocol is often successfully applied in support of confirming structural 

assignment (especially of flexible systems). The major limiting factor to more routine 

application of the multi-step protocol remains the unfortunately long calculations times 

(many hours to days). While the original QM-based NMR Spectrum task remains an option, 

beginning in Spartanô26, QM and ML protocols from a convenient NMR Protocol task, 

with four pre-configured and published workflows that furnish 1H or 13C chemical shifts for 

flexible organic molecules. Use of available neural network models for both geometry and 

NMR shifts results in performance gains of two to three orders of magnitude over ɤB97X-

D/6-31G*//ɤB97X-D/6-31G* density functional model GIAO calculations. Typical neural 

network performance is on the order of within .1 ppm for proton and within 1 ppm for 13C 

shifts of reference shifts from density functional calculations. 

Collectively, the 7 neural networks can be applied to a number of Spartan tasks including: 

Energy is available from five of these routines, however results from equilibrium 

geometries from Est. Density Functional ɤB97X-D/6-31G* task need additional energy 

calculations performed. 
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Equilibrium Geometries are available in two ways, from Corrected MMFF, and directly 

from the Est. Density Functional ɤB97X-D/6-31G* (DLFFG1) approach.  

Conformational Searching. Neural network models are also optionally available in the 

following tasks featuring conformational searching: Equilibrium Conformer, Conformer 

Distribution, NMR Spectrum, and NMPR Protocol. The Corrected MMFF routine can 

be used, in isolation, to improve energy results from MMFF optimized structures, and in 

conjunction with the above-mentioned machine learning approaches (in a workflow).  

NMR shifts both proton and 13C are available from neural network models from the Energy, 

Equilibrium Geometry, and NMR Spectrum tasks. 

Databases 

SSPD (Spartan Spectra & Properties Database). SSPD has been extended to include an 

additional å12,000 organic molecules (primarily drug/drug candidates, pesticides, and 

natural products), as well as another å8,000 transition states for concerted reactions 

(primarily Diels-Alder, dipolar cycloadditions, Cope, Claisen and ene reactions). These 

include structures from ɤB97X-D/6-31G* and energies from ɤB97X-V/6-

311+G(2df,2p)//ɤB97X-D/6-31G* calculations. Transition states are accessed from the 

Guess Transition State mode in Spartan graphical user interface. 

Natural Products. The collection of natural products included in the previous SSPD 

(bundled with Spartanô26) has been extended and modified to provide calculated 

information on only the lowest energy conformer (ɤB97X-V/6-311+G(2df,2p)[6-311G*] 

energies from ɤB97X-D/6-31G* geometries). This provides both calculated proton and 13C 

chemical shifts and experimental 13C shifts for å 2800 published natural products molecules. 

Custom (user-generated) database formation. New in Spartanô26, a computational task, 

a one-step submission for SSPD compatible, which performs (minimally) an ɤB97X-D/6-

31G* geometry and optionally includes ɤB97X-V/6-311+G(2df,2p) energies, ɤB97X-D/6-

31G* NMR chemical shifts and thermodynamic/frequency data (and for legacy purposes, 

EDF2/6-31G* thermodynamic/frequency data). The SSPD Compatible task also applies to 

transition states (absent the NMR option). User entries can be automatically placed 

alongside the distributed SSPD. This new task provides an easy to specify option for 

generation of user-databases of spectra & properties, it also offers a head start in the 

availability of the current SSPD collection, a curated collection of  >309k equilibrium 

geometries of organic and organometallic molecules, with a full range of pre-calculated data 

available from high quality density functional models for structure and energy. Also included 

are roughly 8,000 pre-calculated transition states. 

Parallel Processing 

The easy access to high end computational hardware (via cloud computing) has enabled 

performance assessment on several configurations of high-performance computers. Users 

running the greater than 16-core license are encouraged to reach out to us via 

support@wavefun.com for access to (and assistance with) benchmarking data. 
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Graphical Interface 

Generate Isomers. The isomer generation tools have been refined with improved defaults 

and provide automatic stereoisomer/regioisomer elaboration. 

2D/3D Display. Improvements have been made to the 2D display mode, originally 

developed as a building device ï in general all features available to 3D are also supported 

in a new 2D viewing mode.  This greatly simplifies some tasks (such as assignment of 

experimental NMR shifts to atoms). Additionally, all Spartan versions open native 

ChemDraw files. Spartanô26 for Windows, as in previous releases, provides the ability to 

build in ChemDraw (2D), and import/auto-convert into 3D in Spartan (Note: ChemDraw 

interface can be enabled from Options menu > Preferences > Settings tab).  

Dual Display. A display window provides 2D structure view when utilizing the 3D user 

interface, and for 3D display when using the flat 2D sketch display. 

NMR menu. The NMR menu (previously named Expt. Data) has been refined, offering a 

new, atom-level spreadsheet with scratch pad for import, organization and assignment of 

NMR data (also allows assignment of experimental proton and CH coupling data). 

Output Summary. The HTML presentation format has been improved resulting in an order 

or magnitude (or more) speed increase as some data tables are calculated on-the-fly upon 

opening. All data from the Output Summary is available for export in single or multi-

molecule format. A References section has been added to select standard tasks and will be 

extended going forward. 

Computational Enhancements 

Spartanô26 (by default) takes advantage of up to 16 cores for parallel jobs, with the option 

to license/utilize >16 cores for high performance multicore systems. In the initial release, 

significant computational enhancements come by way of the new machine learning models 

available for several routine tasks and included our implementation of the latest Q-Chem 

6.3/6.4 version. This release is the result of continued collaboration with Q-Chem, Inc. (first 

initiated with the release of Spartanô02 in 2002).  

Through this collaboration customers benefit from both GUI and significant computational 

enhancements (the T1 thermochemical recipe, the multi-step protocols for conformational 

searching in conjunction with Boltzmann weighted NMR data, and the new machine 

learning models), as well as a growing range of computational options and modern QM 

development in Q-Chem. Spartanô26 includes an updated version of our quantum engine to 

the current Q-Chem version.  

Spartan users have consistently and diligently made suggestions and reported program bugs 

via support@wavefun.com. Many reported issues from the previous release have been 

addressed in this current update, including update to user documentation (this document). 

Wavefunction would like to thank our customers for their continued help in improving and 

simplifying Spartan. User feedback is greatly appreciated! 
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Section I 
New Feature Tutorials 

 

Neural Network Calculations  

The following tutorials provide a number of examples utilizing the new neural network 

(machine learning) routines incorporated in Spartanô26. In order to reduce calculation time 

and also to provide for assessment of results, these tutorials often start from a file containing 

results of previous density functional (QM) calculations. These include geometries, isomer 

energies and conformer energies, NMR shifts, etc. Sections are loosely organized around 

specific neural network routine tasks: Estimate ɤB97X-D/6-31G* Equilibrium 

Geometries, NMR from Estimated ɤB97X-D/6-31G* Equilibrium Geometries, Multi -

step Conformer Distribution Protocols, Improvi ng Energy results, and NMR Protocols 

for Flexible Molecules.  
 

Basic knowledge of Spartan operation is assumed. New Spartan users should visit the 

Activities menu and minimally review the first three tutorials, as well as the seventh tutorial: 

Groups of Organic Molecules, before attempting the following examples. 
 

While the primary intent is to expose users to the machine learning models, a secondary goal 

is to quantify the computational time savings when employing (one or more) neural network 

routines in place of calculation step(s) previously performed with quantum chemical models. 

Throughout, an attempt is made to estimate the total time required to perform all steps in the 

tutorial (including calculations). Calculation time estimates are based on Spartanô26 

running on either: a 24-core i9 Intel® CoreÊ i9 Windows 11 machine or 64-core AMDÊ 

Ryzen Threadripper PROÊ Ubuntu 24.04 server. Note, in general Linux (and Macintosh) 

operating environments show superior parallel performance (over Windows) for most 

multicore calculations; the Linux implementation includes the most efficient memory 

allocation. 

 

Estimate ɤB97X-D/6-31G* Equilibrium Geometries 

While the ɤB97X-D/6-31G* density functional model has proven remarkably successful for 

calculation of equilibrium geometries (structures), it becomes impractical for routine 

calculations on rigid or nearly rigid molecules with molecular weights greater than perhaps 

1000 amu and for even smaller molecules with multiple degrees of conformational freedom 

(hundreds to thousands of accessible conformers). Routine usage would benefit from an 

alternate (fast) approach. A good deal of time has been spent exploring post-molecular 

mechanics options including semi-empirical models such as PM3, PM6, PM7, etc. While 

these alternatives meet the needs for faster results and are applicable to larger and more 

flexible systems and generally provide reasonable equilibrium geometries, experience 

shows that these options are no better than molecular mechanics at providing accurate 
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energies or conformer energy differences, Boltzmann distribution(s). 
 

Spartanô26 employs the DLFFG12 neural network model trained to reproduce our default 

workhorse default: ɤB97X-D/6-31G* geometries starting from molecular mechanics 

(MMFF94). This is available for neutral, closed-shell organic molecules including H, C, N, 

O, F, S, Cl, and Br. Examples follow. 

 

Monacustin structure     [10-30 minutes] 

 

1. Open the file monacustin from the neural network folder inside the Tutorials  directory.3  

 
monacustin 

This file contains the equilibrium geometry for the natural product monacustin, obtained 

from the ɤB97X-D/6-31G* density functional model, and will serve as the reference to 

compare results from a neural network calculation. The provided calculation results required 

approximately 4 and a half minutes wall time on an 8-core Intel I7 processor), you can 

review the Output  via the Display menu. The Output tab includes timing data, toward the 

bottom of text output. Optional: To test performance on your machine, you can, click the 

Minimize entry from the Build  menu, open the Calculations dialog, and submit an 

Equilibrium  Geometry using the default ɤB97X-D/6-31G* density functional model. 

Note the anticipated calculation on a modern quad-core laptop is on the order of 6-10 

minutes. 

2. From the Spreadsheet (Display menu > Spreadsheet), make a copy of the monacustin 

molecule, and paste this into the Label column under the existing entry (right-click on 

monacustin and choose Copy then click in the empty cell underneath monacustin and 

choose Paste, and then to Paste Molecule(s). Rename the second copy monacustin neural 

net (double-click in the new cell and overwrite the auto-generated name). With the copy 

 
2 Hehre, T.; Klunzinger, P. E.; Deppmeier, B.; Ohlinger, W.; Hehre, W. Accurate Prediction of ɤB97X-D/6-31G* 

Equilibrium Geometries from a Neural Net Starting from Merck Molecular Force Field (MMFF) Molecular Mechanics 

Geometries. J. Chem. Info. Mod. 2025, 65 (5), 2314ï2321. https://doi.org/10.1021/acs.jcim.4c01898  
 
3 For Windows, the Tutorials directory is found in Program Files/ Wavefunction/Spartan26.  

Suggested: copy this to Documents or Desktop prior to opening it in Spartan. 

For Macintosh, this is located at the top of the Spartan26 disc image.  

Suggested: copy this to another location available to the user (we recommend Documents or Desktop). 

For Linux , the Tutorials directory is found in the install directory.  

Suggested: copy the Tutorials directory to a location that allows write permission, typically the userôs home directory. 

 

https://doi.org/10.1021/acs.jcim.4c01898
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(monacustin neural net) selected, estimate the equilibrium geometry calculation:  
 

3. Open the Calculations dialog, select Equilibrium Geometry  and Est. Density 

Functional to the right of Calculate. At present, ɤB97X-D/6-31G* is the only selection 

available. Make certain that the Global Calculations is not checked. Submit the job. 

4. When completed (a few seconds), return to the spreadsheet, select (click on) the first 

molecule, monacustin ɤB97X-D/6-31G* (the full calculated density functional ɤB97X-D/6-

31G* equilibrium geometry). Select Align  from the Geometry menu and click on the Align 

by button at the lower right of the user interface. (Note: aligning by Structure).  

5. Qualify (visually inspect) the results. From the Spreadsheet, click inside the boxes to the 

left of the two monacustin molecules (this enables simultaneous display). From the (default) 

Ball and Spoke display style, it appears that the two structures are nearly identical. Switch 

to the Space Filling (Model menu) style; this more accurately displays the overlap of atoms. 

In the space filling model, visual differences are more difficult to discern, the two appear 

essentially identical.  

6. Quantify the results. From the Spreadsheet, click the Add button near the bottom left. 

Click the Molecule List tab, and from the bottom center, click on Alignment Scores to post 

these to the spreadsheet. In the alignment assessment, a score of 1.0 is a perfect alignment 

and a score of 0.0 is a terrible alignment. By this metric, the molecules are identical. 

7. Explore structural detail. Use the Measure feature (Measure Distance, Angle and 

Dihedral Angle from the Geometry menu). Click again inside the check boxes to the left 

of the moleculeôs names in the spreadsheet, to turn off simultaneous display. With either 

example selected, use the measuring options tools to explore distances, angles, and 

dihedrals. For example, measure the CO bond lengths in the two carbonyl groups. The 

distances appear at the bottom right of the screen and can be posted to the spreadsheet by 

clicking on        .  

8. Explore additional organic molecules. Repeat the above tutorial procedure (steps 2 ï 7) 

for two additional natural products: simaroubin A and bimsic, sample .spartan files can be 

found in the neural network folder inside the Tutorials  directory. 

9. Do results generally agree between the QM and neural network calculated structures? 

Results will very closely follow the ɤB97X-D/6-31G* calculations, see Appendix A for 

assessment. This neural network modelôs definition, training description, and validation 

assessment are included in the defining paper: J. Chem. Inf. Model. 2025, 65(5), 2314-2321.   

10. When finished, close monacustin, simaroubin A, and bimsic. Note, while the 

geometries are close to identical, this neural network was not trained on energy and resulting 

structures typically need an additional calculation to obtain a reasonable energy. See 

comments below.  
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NMR from Estimated ɤB97X-D/6-31G* Equilibrium Geometries  

The neural network routine used to estimate ɤB97X-D/6-31G* equilibrium geometries (Est. 

Density Functional ɤB97X-D/6-31G*) provides an optimized structure, it does not, 

however, provide an acceptable energy (or the wave function) currently needed to calculate 

NMR chemical shifts using Density functional GIAO approaches, nor can one generate 

graphical models such as molecular orbitals or electrostatic potential maps. In order to obtain 

wave function-based data, an energy (a so called ñsingle point energyò) calculation is needed 

from ɤB97X-D/6-31G*. Use of the neural network for structure generation saves å 

anywhere from 1-3 orders of magnitude in wall/CPU time when compared to the standard 

ɤB97X-D/6-31G* optimization. Note: new in Spartanô26 v.1 are proton and 13C neural 

networks that will accept geometries from either ɤB97X-D/6-31G* or Est. Density 

Functional ɤB97X-D/6-31G*. 

 

Ethyl 2-methylpropanoate     [10-20 minutes] 

 

1. Sketch or build ethyl 2-methylpropanoate: 

 
ethyl 2-methylpropanoate 

 

2. Open the Spreadsheet and make two copies of the molecule (right-click, choose Copy, 

right-click cell underneath and choose paste, repeat the paste procedure again). For the first 

molecule, enter the Calculations dialog, select Equilibrium Geometry  to the right of 

Calculate. Select Density Functional, ɤB97X-D, and 6-31G* from the three menus below 

and to the right of with . Check the NMR check box. Make sure the Global Calculations 

box at the bottom right of the dialog is not checked and click OK . 

 

     
 

3. For the second molecule, enter the Calculations dialog, select Energy to the right of 

Calculate. Select Density Functional, ɤB97X-D, and 6-31G* from the three menus below 

and to the right of with . From the menu(s) to the right of Start From: , select Equilibrium 

Geometry then using: Est. Density Functional. Check the NMR check box. Confirm 
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Energy Model is selected and that the Global Calculations box is not checked.  

  

   
 

4. For the third molecule, enter the Calculations dialog, select Equilibrium Geometry  to 

the right of Calculate. Select Est. Density Functional, geometry. Check the NMR check 

box. Confirm the NMR estimator is selected (not ɤB97X-D/6-31G*) and that the Global 

Calculations box is not checked. Submit the job. 

5. When completed (several minutes), compare the structures and the NMR chemical shifts. 

Open the Properties dialog (Display menu), click on the carbonyl carbon, and from the 

Atom Properties dialogue, click on the  Post        button next to Chem. Shift, to post the 

calculated NMR chemical shifts for this carbon center (for all three examples) into the 

spreadsheet. One after another, click on the two ethoxy carbons, and post their chemical 

shifts into the spreadsheet. How closely do the NMR results match? 

6. From the Spreadsheet. Confirm the first entry is selected. From the Geometry menu 

select Align . Confirm that Structure is selected from the dropdown menu at the lower right 

of the interface, click on the Align by  button.  

7. From the spreadsheet, click the Add button near the bottom left. Click the Molecule List 

tab, and from the bottom center of the Add panel, click on Alignment Scores. How well do 

the results align? Check the box to the left of each entry to turn on display. 

8. From the Model menu turn off the Coupled toggle. Use the center mouse-wheel to zoom 

out if needed. Hold the right mouse-button down to translate the molecules away from each 

other so that the 3 can clearly be seen separately (not overlapping). From the Model menu 

turn off the Hydrogens toggle. Return to the Model menu and click on Configure. From 

the Labels tab, click the radio button to the left of Calc. Chem Shift and click OK . Compare 

the shift values on all carbon centers. Differences are very subtle, on the order of tenths of a 

ppm.  

9. Close the ethyl 2-methylpropanoate. 
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Indiacen B       [10-15 minutes]  

 

 

indiacen b 

 

1. From the neural network folder inside the Tutorials directory, open the file indiacen b 

(a slightly larger natural product molecule, this alkaloid is isolated from certain species of 

myxobacterium or ñslime moldsò). Equilibrium Geometry  and NMR chemical shifts are 

furnished from ɤB97X-D/6-31G*. 

2. Open the Spreadsheet and make a copy of the molecule indiacen b DFT, name it 

indiacen b est DFT.  

3. With the renamed copy selected, enter the Calculations dialog, and specify Equilibrium 

Geometry and Est. Density Functional. Check the NMR check box. Confirm that the 

NMR estimator4 is selected and that the Global Calculations box is not checked. Submit 

the job. 

4. When the job completes (just a few minutes), compare the NMR shifts on the carbonyl 

carbon, the terminal carbon bonded to chlorine, and any other carbon centers you like. Use 

the Atom Properties dialogue and post the calculated shifts (Chem. Shift) into the 

spreadsheet to compare results. While the results are not identical, they are very similar 

(typically within a few tenths of a ppm). Use of neural network routines (in this case) saves 

å a factor of 50 or more in computational time. 

5. This example explored a relatively small and rigid molecule. Time savings for larger and 

more flexible systems is even more significant, where select individual calculation steps 

have the option of utilizing neural network routines rather than QM models.  

6. Close indiacen b. 

 

  

 
4 Hehre, T.; Klunzinger, P. E.; Deppmeier, B. J.; Ohlinger, W. S.; Hehre, W. J. Practical Machine Learning 

Strategies. 4. Using Neural Networks to Replicate Proton and 13C NMR Chemical Shifts Obtained from 

ɤB97X-D/6-31G* Density Functional Calculations. J. Org. Chem. 2025, 90 (32), 11478ï11485. 

https://pubs.acs.org/doi/10.1021/acs.joc.5c00927 

 

https://pubs.acs.org/doi/10.1021/acs.joc.5c00927
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Neural Networks in Multi -step Conformational Protocols I 

For the last several Spartan releases, we have included multi-step workflows combining 

both molecular mechanics (MMFF94) and quantum mechanics (a number of models) to 

obtain, what we believe to be, accurate Boltzmann distributions of flexible organic 

molecules. Both as a stand-alone task (Conformer Distribution ) and in combination with 

NMR calculations in the NMR Spectra5 task, these recipes have proven useful in 

confirming (and in some cases rejecting) structural assignments in the natural products 

space. 

While increasing in importance and utility, the use of predicted NMR (in particular 

Boltzmann weighted shifts) has been limited by the significant computational demands 

required (several hours, to days for very flexible systems).  

Replacing steps in these workflows with neural network calculations significantly reduces 

the required computational requirements, while maintaining quality results. 

Aspochalasin U and Boltzmann Weighted NMR   [30 minutes] 

 

 
 

aspochalasin u 

 

1. From the neural network folder inside the Tutorials directory, open the file 

aspochalasin u. This file contains NMR Spectrum calculation results for the macrocyclic 

natural product aspochalasin u, one of several alkaloid macrocycles isolated from the desert 

shrub ericameria laricifolia (the ñturpentine bushò). Results originate from the default NMR 

Spectrum setup, starting from MMFF conformer searching and including multiple QM 

model steps to provide both an equilibrium conformation and a set of Boltzmann weighted 

NMR chemical shifts. This flexible system with more than 100,000 potential conformations, 

 
5 Hehre, W.; Klunzinger, P.; Deppmeier, B.; Driessen, A.; Uchida, N.; Hashimoto, M.; Fukushi, E.; Takata, Y. Efficient 
Protocol for Accurately Calculating 13C Chemical Shifts of Conformationally Flexible Natural Products: Scope, 

Assessment, and Limitations. J. Nat. Prod. 2019, 82 (8), 2299ï2306. https://doi.org/10.1021/acs.jnatprod.9b00603 

 

https://doi.org/10.1021/acs.jnatprod.9b00603
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required considerable computational time (20 hours on an 8 core i7 Windows 11 system). 
 

2. Make a copy of the molecule named aspochalasin u DFT multi-step and paste it under 

the existing molecule. Rename the second molecule aspochalasin u NN multi-step. With 

the second molecule selected, enter the Calculations dialog and specify: NMR Spectrum 

with Est. Density Functional, and NMR estimator.4 Next to using confirm the settings 

updated to: Est. ɤB97X-V/6-311+G(2df,2p) energy6 and Est. ɤB97X-D/6-31G* 

geometry2:  
 

 
 

Submit the calculation. 
 

3. When the job completes (perhaps 25 minutes on a 24-core i9 Windows 11 machine, just 

under an hour on the same 8-core i7 Windows 11 machine that the QM job was completed 

on), compare the returned equilibrium conformer with the example from the longer QM-

based NMR Spectrum. Align  the two molecules. With the first molecule selected, enter the 

Geometry menu and click on Align . In the lower right of the user interface, click on the 

Align by button (note we are aligning by structure). From the spreadsheet, click the Add 

button near the bottom left. Click the Molecule List tab, and from the bottom center, click 

on Alignment Scores. The neural network example should have good structural alignment 

(.98 or better) to the standard NMR Spectrum task (from the multistep MM/QM protocol). 

4. How well do the calculated (and Boltzmann weighted) NMR shifts compare? Right-click 

on a carbon center; from the resulting contextual menu, choose Properties. From the Atom 

Properties dialog, click        to post the calculated chemical shift into the spreadsheet (this 

is the fourth item down named Chem. Shift). Note, the molecules are numbered identically 

and posting the shift value from an atom on one molecule will also post the corresponding 

shift value from the other copy.  

5. Post the calculated Chem. Shift values for the remaining unlabeled carbons and return to 

the spreadsheet for comparison. How similar are the resulting shifts? In most cases you will 

 
6 Klunzinger, P.; Hehre, T.; Deppmeier, B.; Ohlinger, W.; Hehre, W. Practical Machine Learning Strategies. 

2. Accurate Prediction of ɤB97X-V/6-311+G(2df,2p), ɤB97M-V/6-311+G(2df,2p) and ɤB97M(2)/6-

311+G(2df,2p) Energies From Neural Networks Trained From ɤB97X-D/6-31G* Equilibrium Geometries 

and Energies. J. Comp. Chem. 2025, 46 (13), 70129. https://doi.org/10.1002/jcc.70129  
 

 

https://doi.org/10.1002/jcc.70129
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find the results quite similar, in most cases results vary by only a few tenths to perhaps 1.5 

ppm. The alignment and NMR shift results suggest the neural network calculations perform 

similarly to quantum chemical calculations in the context of the multi-step procedure. In this 

case (with a rather flexible molecule and using the neural network routine for structure), the 

calculation run using available neural network routines saves a factor of å20 in 

computational time.  

 

Improving Energy Results 

The fact that ɤB97X-V/6-311+G(2df,2p), ɤB97M-V/6-311+G(2df,2p) and ɤB97M(2)/6-

311+G(2df,2p) models lead to improved reaction and conformer energies compared to those 

provided by the simpler and much less costly ɤB97X-D/6-31G* model is well known. 

Spartanô26 incorporates three machine learning routines (neural networks) trained to 

reproduce the above energies starting from either an ɤB97X-D/6-31G* geometry, or an est. 

density functional (neural network) geometry, trained to reproduce ɤB97X-D/6-31G* 

geometries. The better energy calculation is almost instantaneous (seconds).  
 

 

Structural Isomers of C15H16O3       [15-20 minutes] 
 

1. Open C15H16O3 isomers. The document contains seven C15H16O3 isomers (all natural 

products) and pre-calculated energies and geometries from ɤB97X-V/6-

311+G(2df,2p)//ɤB97X-D/6-31G* (labeled ref in the spreadsheet). Isomers are ordered by 

relative energies (low to high). The underlying QM calculations required several hours of 

computer time.  
 

2. Inside the Calculations dialog, select Energy with Est. Density Functional6 ɤB97X-

V/6-311+G(2df,2p) from the right of Calculate with and Equilibrium Geometry using 

Est. ɤB97X-D/6-31G*2 from the right of Start From . Make certain that Global 

Calculations (at the bottom right of the dialog) is checked and click on Submit.  
 

3. When the job completes (a few minutes, 15-45 seconds or so per isomer), return to the 

spreadsheet. Confirm that the first molecule is selected, click on Add at the bottom of the 

spreadsheet, click on the Molecule List tab and under Energy from Molecule: click on ȹE 

(kJ/mol) near the top left of the panel. Optionally, rename the ȹE (kJ/mol) column to: est 

ɤB97X-V:est ɤB97X-D), double-click in the ȹE (kJ/mol) header, backspace to view the 

full expression, and at the left of the equal sign, rename the previous to: est ɤB97X-V:est 

ɤB97X-D. 
 

4. Bring up the Plots dialog and click on + to add a new plot. Select ref under X Axis and 

select both ref and ȹE (kJ/mol) or est ɤB97X-V:est ɤB97X-D, if you renamed the column 

from the optional step above from the Y Axes. Click on Create at the bottom right of the 

panel. How well does this combination of neural network routines reproduce the results of 

the reference calculations?  
 

5. Open the file Plot_Est_V_QM. In this modified plot, the reference energies of the 7 

isomers are the larger blue dots, the smaller yellow dots are the energies determined by the 

neural network. The neural networks perform quite well on the task of reproducing both the 
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order and the underlying relative energy results from high-level quantum chemical models 

(in a small fraction of the time it took to run the reference data calculations). 
 

6. Close both C15H16O3 isomers and Plot_Est_V_QM.  

 

Conformers of methyl 4-pentenoate    [10-15 minutes] 
 

1. Open methyl 4-pentenoate conformers. The file contains eleven conformers of the small 

organic molecule methyl 4-pentenoate, pre-calculated from ɤB97X-V/6-311+G(2df,2p) 

from ɤB97X-D/6-31G* geometries (labeled ref in the spreadsheet) and ordered from lowest 

to highest energy. This relatively small molecule with relatively few conformers (11) 

required only 30 minutes of wall time, perhaps 4 hours CPU time to complete.  
 

2. Open the Calculations dialog, select Energy with Est. Density Functional6 ɤB97X-V/6-

311+G(2df,2p) to the right of Calculate and Equilibrium Geometry  using Est. Density 

Functional and Geometry Estimator2 to the right of Start From . Make certain that Global 

Calculations (at the bottom right of the dialog) is checked and click Submit. 
 

3. Once completed (perhaps 5-6 minutes), open the spreadsheet and ensure the first molecule 

in the list is selected. Click on Add at the bottom of the spreadsheet, click on the Molecule 

List  tab and click on ȹE (kJ/mol) at the top left of the dialog (under Energy from 

Molecule). Rename the ȹE (kJ/mol) data column: est ɤB97X-V:est ɤB97X-D.  
 

4. Bring up the Plots dialog and click on +. Select ref under X Axis, both ref and est ɤB97X-

V:est ɤB97X-D under Y Axes and click on Create at the bottom right of the panel. How 

well does this combination of neural network routines reproduce the results of the reference 

calculations? This is a reasonable representation of performance within a conformer 

distribution. Note that while the equilibrium conformer (the global minimum) remains the 

same, there is some change in order based on the energies from the neural network (over 

this relatively small energy window of 6-7 kJ/mol).  
 

5. For comparison, return to the Calculations dialog and specify an Equilibrium Geometry 

using MMFF , make sure the Global Calculations box is checked, and click Submit. 
 

6. When the job completes (less than a minute), return to the Spreadsheet. The ȹE (kJ/mol) 

column has now updated to reflect MMFF energies. In comparison, how well does MMFF 

reproduce the reference energies? Bring up the Plots dialog and click on +. Select ref under 

X Axis, and select all three: ref, est ɤB97X-V:est ɤB97X-D, and ȹE (kJ/mol) under Y 

Axes, then click on Create at the bottom right of the panel. While the results of the combined 

neural network routines do not perfectly match the underlying QM reference data, unlike 

MMFF (reported on the new plot as ȹE (kJ/mol)), the neural network results obtain the same 

global minimum, and in general, better agreement with reference data.  
 

7. Close methyl 4-pentenoate conformers. 
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Neural Network Correction to MMFF Molecular Mechanics 

 

MMFF molecular mechanics is the simplest and perhaps most widely used method to 

explore the accessible conformers of organic molecules. While it provides a reasonable 

account of conformer energy differences for molecules with only a single degree of 

conformational freedom (many of which were used to parameterize MMFF), it has not 

proven to be reliable for molecules with multiple degrees of conformational freedom. 

ɤB97X-V/6-311+G(2df,2p) calculations using MMFF geometries are much better, although 

they are much more costly (hours as opposed to seconds). Spartanô26 incorporates a neural 

network trained to reproduce conformer energy differences from ɤB97X-V/6-

311+G(2df,2p)//MMFF density functional calculations and intended to improve on MMFF 

results without greatly adding to its cost.  

 

1,10-oxymyrcene hydroxide      [10-15 minutes] 
 

 

1. Open 1,10-oxymyrcene hydroxide. This document contains 40 conformers of the slightly 

larger and more flexible example (compared to methyl 2-pentenoate from the previous 

tutorial), the organic molecule: 1,10-oxymyrcene hydroxide. Conformers are ordered by 

energy (low to high) from the ɤB97X-V/6-311+G(2df,2p)[6-311G*]//MMFF density 

functional model (labeled ref and in units of kJ/mol in the spreadsheet). The reference 

calculations took just under 3 hours wall time and roughly 17 hours CPU time to complete 

(on a 24-core i7 Windows 11 machine). Two additional empty columns, one labeled MMFF  

and the other corr MMFF 7, will be utilized following calculations (below).  
 

2. From the Calculations dialog, select Equilibrium Geometry  and specify Molecular 

Mechanics and MMFF to right of with . Make certain that Global Calculations (toward 

the bottom right of the dialog) is checked and click on Submit.  
 

3. When the job completes (less than a minute), ensure that the first molecule in the list is 

selected. Click on Add at the bottom of the spreadsheet, then click on the Molecule List tab 

and finally from under Energy from Molecule, click on ȹE (kJ/mol) toward the top left of 

the dialog. Copy the results from the 40 entries in the ȹE (kJ/mol) column into the MMFF 

column.  
 

4. Bring up the Plots dialog and click on +. Select ref under X Axis, both ref and MMFF  

under Y Axes and click on Create at the bottom right of the panel. The resulting plot shows 

that MMFF is rather poor at reproducing results from ɤB97X-V/6-311+G(2df,2p) [6-

311G*]//MMFF (the ref data).  
 

5. Update the data using the Corrected MMFF model. From the Calculations dialog, select 

Equilibrium Geometry with Molecule Mechanics and Corrected MMFF and click 

 
7 Hehre, T.; Klunzinger, P. E.; Deppmeier, B.; Ohlinger, W.; Hehre, W. Practical Machine Learning Strategies 

I. Correcting MMFF Molecular Mechanics Model to More Accurately Provide Conformational Energy 

Differences in Flexible Organic Molecules. J. Comp. Chem. 2025, 46 (1), 70016. 

https://doi.org/10.1002/jcc.70016 

 

https://doi.org/10.1002/jcc.70016
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Submit.  
 

6. Once completed (perhaps a minute for all 40 conformers), return to the spreadsheet. The 

ȹE (kJ/mol) values have updated. Copy the updated ȹE (kJ/mol) entries into the corr 

MMFF column. From the Plots dialog click on +, select ref under X Axis, both ref and corr 

MMFF  under Y Axes and click on Create at the bottom right of the panel. Compare the 

two plots by moving back and for the between view of Plot1 and Plot2 (optionally, clicking 

the ƹ arrow at the top of the plots pane moves the selected plot into the 3D interface for 

simultaneous display. The results visually confirm the corrected MMFF model does a much 

better job reproducing the results of the reference calculations). 
 

7. Return to the Spreadsheet. Click on Add at the bottom of the spreadsheet, then click on 

the Linear Regression tab. Select ref for the Fit , and choose MMFF  under Using, click 

Apply . Create a second regression with ref fit to the corr MMFF data and click Apply . 

Two new entries appear at the bottom of the spreadsheet. Right-click on the Fit1 cell and 

choose Properties. The Regression Properties dialog appears. The R2 value gives an 

indication of how well the data fit the regression, with 1 being a perfect fit. The fit of MMFF 

energies is essentially a scatter plot. The R2 for the corrected MMFF energies is quite good 

(.9). As (or more) important than the quality of the fit, the RMS value is much better (lower) 

for the corrected MMFF energies (.46 kJ/mol). From a practical perspective, the 

computational time savings is significant, a minute or less compared to several hours.  
 

8. Close 1,10-oxymyrcene hydroxide.  

 

Neural Networks in Multi -step Conformational Protocols II 

 

In a previous example (the flexible macrocycle aspochalasin u) we compared the 

performance of the neural network routines in the Boltzmann weighted NMR Spectrum 

calculation. In the previous example, the NMR results were calculated from structures 

determined by the Est. Density Functional ɤB97X-D/6-31G*2 neural network. Another 

potentially useful strategy would be to utilize the multi-step (NMR Spectrum) routines ï but 

to perform structures (equilibrium geometries) from quantum mechanics and obtain energies 

(for Boltzmann weighting) from neural network energies.  
 

Leucosolenamine and Boltzmann Weighted NMR  [no calculations] 
 

 
leucosolenamine analogue 
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1. From the neural network folder inside the Tutorials directory, open the file 

leucosolenamine. This file contains two copies of a proposed structure for the natural 

product leucosolenamine a. The first example has completed the default NMR Spectrum 

calculation, using MMFF and multiple QM models to provide both an equilibrium 

conformation and a set of Boltzmann weighted NMR chemical shifts. The second molecule 

has replaced the Hartree-Fock geometry step and an initial single point energy ɤB97X-D/6-

31G* step with a Corrected MMFF neural network, and the final energy calculation: 

ɤB97X-V/6-311+G(2df,2p) with an Est. Density Functional neural network equivalent. 

Note that in this case, the final geometry ALSO comes from quantum chemical calculations, 

as do the NMR shifts.  
 

2. Open the Spreadsheet and note that the check boxes to the left of the moleculesô names 

in the far left-hand column are checked, specifying display of both copies. If your mouse 

manipulations move both copies of the leucosolenamine. Visit the Model menu and toggle 

off the Coupled entry. In this decoupled mode, you can move/manipulate the molecules 

independently. To switch focus between molecules, just click on the molecule you wish to 

select.  
 

3. With both copies displayed simultaneously, an additional Annotation box is also 

displayed. Note, the text applies to the initial position of the examples (if you move the 

molecules around, the annotations donôt follow). To insert an annotation box of your own, 

copy any text (either from inside of Spartan, or any other program) to the clipboard and then 

click inside the 3D space in the Spartan UI and right-click then choose paste. To edit or 

expand, right-click on the annotation and choose Properties.). The initial display should 

include the calculation completed using quantum mechanics on the left, and that from the 

neural network calculation(s) on the right. Explore the NMR shifts on select carbons. 
 

4. For qualitative results, a few chemical shift labels have been enabled. Confirm these were 

not ñcherry-pickedò. Compare other carbon centers. Right-click on a carbon center without 

a displayed chemical shift label. From the resulting contextual menu, choose Properties. 

From the Atom Properties dialog, click      to post the calculated chemical shift into the 

spreadsheet (this is the fourth item down named Chem. Shift). Note, the molecules are 

numbered identically and posting the value from an atom of one molecule also posts the 

corresponding shift value from the other copy.  
 

5. Post the calculated Chem. Shift values for the remaining unlabeled carbons and return to 

the spreadsheet for comparison. How similar are the resulting shifts? In most cases you will 

find the results identical, or to vary by only a few tenths of a ppm. 
 

6. Align  the two molecules. With the first molecule selected, enter the Geometry menu and 

click on Align . In the lower right of the user interface, click on the Align by button (note we 

are aligning by structure). From the spreadsheet, click the Add button near the bottom left. 

Click the Molecule List tab, and from the bottom center of the Add panel, click on 

Alignment Scores. The alignment and NMR shift results suggest neural network 

calculations perform similarly to quantum chemical calculations in the context of this multi-

step procedure. In this case (with relatively few conformers), the neural network is a factor 

of å3 times faster. 
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7. The goal (at least one goal), of this tutorial is to demonstrate the option of utilizing only 

the energy related neural networks (retaining the equilibrium geometry at density functional 

ɤB97X-D/6-31G*). This results in NMR shifts that more closely align with those from the 

standard Density functional (MM and QM based) NMR Spectrum task, than utilizing the 

neural net Est. Density Functional: ɤB97X-D/6-31G* for structure calculation. There is 

still considerable time savings in utilizing just the energy-based neural networks. Close 

leucosolenamine. 

 

NMR Neural Networks for proton and 13C Chemical Shifts  

 

Beginning with Spartanô24 v 1.3 (2025) and supported in Spartanô26 v.1, proton and 13C 

shift neural network models, trained to reproduce empirically corrected ɤB97X-D/6-31G* 

GIAO results. A performance assessment and discussion are included in Appendix A. In 

general, the neural networks reproduce proton shifts to within .1 ppm and 13C shifts to within 

less than 1 ppm. The remaining tutorials in this section demonstrate these new NMR Shift 

options. 

 

Kopsonoline: a rigid organic molecule    [5 minutes] 

 

1. From the neural network folder inside the Tutorials directory, open the file kopsonoline. 

The file contains 3 copies of the (rigid) natural product kopsonoline.  
 

2. Open the Spreadsheet and note, calculations on the first copy named kopsonoline 

QM//QM, includes NMR shift results from empirically corrected ɤB97X-D/6-

31G*//ɤB97X-D/6-31G* GIAO calculations. These took roughly 470 seconds starting from 

an MMFF geometry. The second member in the list, named kopsonoline NN//NN includes 

proton and 13C shift results from the neural network models originating from the est. density 

function neural network (trained to reproduce geometries from ɤB97X-D/6-31G*). RMS 

errors for 13C shifts against experiment is included for quality assessment (recall the neural 

network is trained to reproduce density functional GIAO shifts, not experiment). The neural 

network calculations (on the same machine) took less than 3 seconds (a factor of å175 

improvement in computational time). 
 

3. The third entry, named simply kopsonoline, is set for you to run the same neural network 

calculations on your machine. Open the Calculations dialog and click the Submit button.  
 

4. When the job returns (seconds), revisit the Spreadsheet. How do your time and RMS 

value compare?  
 

5. Close kopsonoline. 
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Furoplocamioid A: a flexible organic molecule   [5 minutes] 

 

1. From the neural network folder inside the Tutorials directory, open the file 

furoplocamioid a. Like the previous example, the file contains 3 copies of the same natural 

product molecule, in this case, furoplocamioid a. While only a few hundred systematic 

conformers, this molecule is flexible enough that properly accounting for conformation is 

likely to improve results. It is also hopefully flexible enough to gain an appreciation for the 

speed of the neural network models. 
 

2. Open the Spreadsheet to review existing data. Included are results from NMR Spectrum 

(the multi-step NMR protocol) calculations using the default density functional approach 

(ɤB97X-D/6-31G*//ɤB97X-D/6-31G* GIAO calculations) as well as the est. density 

functional approach (neural network//neural network) have been performed. Compare 

calculation times and RMS errors to experiment. 
 

3. The third entry is set up to test neural network model performance on your machine. Click 

on the third member from the spreadsheet and open the Calculations dialog. The details are 

already specified (NMR Spectrum calculation with Est. Density Functional NMR 

estimator using Est. ɤB97X-V/6-311+G(2df,2p) energy and Est. ɤB97X-D/6-31G* 

geometry). Confirm the Global Calculations box is not selected and click Submit. 
 

4. When the job returns, revisit the Spreadsheet. How do your time and RMS value compare 

to the provided results from the quantum chemical heavy option (the first member in the 

list)? 
 

5. Close furoplocamioid a. 

 

Machine Learning-Based Multistep NMR Protocol Applications 

In previous Spartan releases we have introduced and refined QM-based NMR protocols for 

flexible molecules. The Spartanô26 release introduces fully integrated, automated protocols 

for fast, accurate prediction of 13C and 1H NMR chemical shifts utilizing workflows 

comprised almost exclusively of fast neural network models. Both options, MLHF and 

MLXD utilize a single QM step to calibrate conformer energies which is subsequently 

corrected (via neural network) to the quality needed to estimate Boltzmann weights. 

Evaluating NMR Assignments I - Constitution   [10 minutes] 

This tutorial presents general strategies for confirmation/validation of constitutional 

structure assignment from 13C shift NMR data. We use experimental data from a recent 

structure confirmation study by Hashimoto and co-workers,8 where funginocarterphenyl 

analogs (A-C), whose central phenyl substitution pattern was established, were explored  

 
8 Kanehira, R.; Maeda, H.; Tanaka, K.; Hashimoto, M. Funginocarterphenyls AïC: Thiazole-Containing p-

Terphenyls from Paulkirkia sp. KT4190. Biosci. Biotechnol. Biochem. 2026, 

https://doi.org/10.1093/bbb/zbag042  

 

https://doi.org/10.1093/bbb/zbag042
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with the 2019 QM-NMR protocol.5 In the following steps, general procedures for importing 

experimental 13C shifts and standard NMR Protocol workflows are introduced.  

1. From the neural network folder inside the Tutorials directory, open the file 

funginocarterphenyls A-C. The existing file contains pre-calculated data from the best 

MMFF conformer, optimized with a density functional model (ɤB97X-D/6-31G*), along 

with corrected GIAO NMR shifts for all three related scaffolds. 
 

2. Open the Spreadsheet. This is pre-populated with molecule-level RMS errors (between 

an existing set of DFT results and experiment). Additionally, reference and solvent meta 

data are included. The MLHF RMS column is flagged as pending; entries await results from 

calculation. Close the Spreadsheet. 
 

3. Open the Enter Expt. 1H/13C shifts tool from the NMR menu. This presents an atom-

level spreadsheet for organizing and assigning experimental NMR shifts, as well as 

summary columns including space for experimental (input) and calculated (output), from 

Spartan. The Experimental Chemical Shifts: will be populated, however the Scratch Pad: 

space is empty. 
 

4. (OPTIONAL) Open the Spreadsheet and copy the reference doi URL from the 

reference column. Outside of Spartan, open a web browser (Chrome, Safari, Edge, Firefox), 

visit the URL. Click the PDF link to access the article. This will open a copy in your web 

browser; download the article to your local machine and open with Acrobat (or similar PDF 

reader) in order to perform the remaining steps.  
 

5. With the article open, scroll down to Table 1; this includes per atom shift assignments for 

both 13C and 1H centers. Position your mouse cursor inside the table and Copy (capture) the 

shift data for the entire table: starting with C-1 in the upper left and ending with 3.51, s in 

the lower right . With this data on your clipboard, return to Spartan and position your mouse 

cursor inside the Scratch Pad area. Paste the copied data (via right-click Paste or Edit 

menu Paste or CTRL+V  ) into the Scratch Pad.  
 

6. If done properly, you will immediately be presented with the Select Character-

Separated-Values-Delimiter prompt. Choose the Delimiter Character  that provides the 

most accessible parsing of the data from the table (typically, but not always, Space 

delimited) and click OK . 
 

7. Review the overall format of the data: atom labels, carbon types, shift data, and column 

structure. Shifts can be individually dragged and dropped, but the recommended procedure 

is to edit the scratch pad data to arrange an entire column of assigned shifts in proper order 

and then to copy/paste to the appropriate 13C column under Experimental Chemical Shifts. 

In general, experimental shifts can be imported and copied as a group. Note: As the data 

format (in this case) combines cells for equivalent carbons (example C-2Ω/C-6Ω), some 

individual hand-editing may still be required.  
 

8. A remaining challenge for proper assignment is confirming that a moleculeôs atom labels 

are either identical to or compatible with the atom labeling in the paper (and/or from the 

instrument or other formatted source). No relabeling is needed in this case, however: should 
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atom relabeling be necessary, this is most easily accomplished from the 2D view and with 

Enter Expt. 1H/13C shifts selected from the NMR menu. With the atom table moved to one 

side, NMR Atom Labels appear in blue and can be overwritten either form the 

Experimental Chemical Shifts spreadsheet, or by clicking on the atom label itself and then 

clicking on the corresponding Edit  dialog that appears. 
 

9. (END OPTIONAL) Once youôve reviewed the experimental shifts and familiarized 

yourself with the scratch pad and both shift and atom label editing, open the Calculationsé 

dialog. Choose: NMR Protocol as the task and leave the default 2026 MLHF  option 

selected. This specifies the MLHF-NMR protocol.9 Make sure the Global Calculations box 

is checked and click Submit.  
 

10. The NMR protocol  is specifically designed to assess flexible systems. While the sample 

molecules in this tutorial have only modest single-bond rotation flexibility, they serve as 

introduction to the mechanics of experimental NMR shift import and general NMR protocol 

workflow options. The calculation should require no more than a minute or so per analog, 

even on slower machines. Based on presented structure and default search definitions, 

Spartan will attempt a different number of systematic conformers for each 

funginocarterphenyl analog. As noted, these systems have minimal flexibility, none has 

more than 36 systematic conformers.  
 

11. Once completed, youôll be prompted with the option to Open, Save, or Discard the 

corresponding conformer files. In this case, confirm the Apply To All  check box is selected, 

and choose Discard. In the case of remote submission to an external Spartan resource, an 

initial prompt to Retrieve is presented. Ensure the Apply To All box is checked, and select 

No. If you select Yes, a second prompt gives you the option to Open or Save.  
 

12. Compare the results from the original DFT calculations with the newly populated 

column (MLHF RMS). Optionally choose Configure from the Model menu and enable the 

 ̍(Calc. ï Expt.) for atom labels. Also from the Model menu, optionally turn off Hydrogens 

and change model style to Tube (this provides a less cluttered presentation for ease of view). 

Considering that the initial DFT calculations required more than 3 hours on a reasonably 

configured laptop, the MLHF performs a similar assessment and provides comparable 

(potentially ñslightlyò better results) in less than a minute per molecule. 
 

13. Close funginocarterphenyls A-C. 

 

 

 

 
9 Ohlinger, W.; Klunzinger, P.; Hehre, T.; Driessen, A.; Deppmeier, B.; Johnson, J.;  Ohlinger, C.; Hehre, W.;  

Schnitker, J.; Uchida, N.;  Watanabe, Y.; Cohen, R. D.;  Bruno, I. J.; Hashimoto, M.; Kanehara, R.; Herzon, 

S. B.;  Riseman, H. J.; López-Pérez, J. L. Practical Machine Learning Strategies. 5. Rapid, Accurate Prediction 

of 1H and 13C NMR Shifts in Conformationally Flexible Organic Molecules. ChemRxiv 2026, Preprint. 

(Manuscript submitted for publication) https://doi.org/10.26434/chemrxiv.15001441/v1 

 

NMR protocol options are detailed in the essay NMR Protocols for Flexible Organic Molecules, available in 

the Userôs Guide (Help menu) and from the Topics collection (Activities menu). 

https://doi.org/10.26434/chemrxiv.15001441/v1
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Timing comparisons between default NMR Protocols  [10 minutes] 

When discussing analysis or processing speeds, in general, faster is better. It follows, 

considerably fasterïas  long as accuracy is maintainedïcan  be transformative. This tutorial 

demonstrates timing benchmarks leveraging the same molecules used to explore timing 

across multiple hardware and OS configurations in the defining MLHF and MLXD paper.9 

The 4 standard NMR protocol option times are provided for a similar OS/hardware range 

for comparison to your computational environment.  
 

1. From the neural network folder inside the Tutorials directory, open the file NMR 

Protocol Timings. Open the Spreadsheet. The spreadsheet is pre-populated with molecule-

level RMS error and average timing data from: 2019 QM, 2024 QM, and 2025 MLXD 

approaches across the range of hardware below, a recent sample from a . Additional columns 

for the 2026 MLHF protocol are marked pending, awaiting calculation results from your 

machine.  
 

                    Benchmarking Hardware  
a 3.2 GHz Apple M1҂ chip 2020 
b 4.5 GHz Apple M4҂ chip 2024 
c 4.5 GHz Apple M4 Pro҂ chip 2024  
d 4.5 GHz Apple M5 Pro҂ chip 2025  
e 4.4 GHz Intel® Xeon® W chip 2019 
f 4.8 GHz Intel® i7-10700 chip 2020 
g 4.9 GHz Intel® i7-12700 chip 2022 
h 5.4 GHz Intel® i9-13900H chip 2023 
i 5.4 GHz Intel® i9-13900HX chip 2024 
j 5.7 GHz AMD҂ Ryzen 9҂ 9950X chip 2025 
k 5.2 GHz Intel® i9-10850K chip 2020  
l 4.5 GHz AMD҂ Ryzen 9҂ 7950X chip 2022 

m 4.5 GHz AMD҂ Ryzen Threadripper҂ 5995WX chip 2022 
 

2. The spreadsheet includes a timing analysis and experimental data from two natural 

products, the terpenoid, abundisporin G10 and the alkaloid, uncarialine D.11 Experimental 
13C shifts have already been imported and assigned, allowing for statistical comparisons 

between predicted and observed shifts. Close the Spreadsheet. 
 

3. Open the Calculationsé dialog. Confirm the task is set to NMR Protocol with 2026 

MLHF. Ensure the Global Calculations check box is checked and click Submit. 
 

4. When the calculations complete (a minute or less per natural product on a well-configured 

machine) return to the Spreadsheet. Compare your machineôs MLHF protocol performance 

against the Sample MLHF Time column. How well does your timing compare? NMR 

accuracy is typically reproducible down to the +/- 1ï2 hundredths ppm level, across 

hardware. How well do your MLHF results (use RMS error) compare with the Sample 

MLHF RMS results? Review results from the other NMR protocol options (both QM and 

 
10 Sum, W. C.; Ebada, S. S.;  Kirchenwitz, M. et al. Neurite Outgrowth-Inducing Drimane-Type 

Sesquiterpenoids Isolated from Cultures of the Polypore Abundisporus violaceus MUCL 56355. J. Nat. 

Prod. 2023, 86, (11), 2457ï2467. https://doi.org/10.1021/acs.jnatprod.3c00525 

 
11 Huang, KP.; Xu, L. L.; Li, S. et al. Uncarialines A-E, new alkaloids from Uncaria rhynchophylla and their 

anticoagulant activity. Nat. Prod. Bioprospect. 2023, 13, 13. https://doi.org/10.1007/s13659-023-00377-0 

 

https://doi.org/10.1021/acs.jnatprod.3c00525
https://doi.org/10.1007/s13659-023-00377-0
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ML-based). Timings provided for the remaining NMR protocols are the averages from the 

above Benchmarking Hardware table (14 hardware-configurations, aïm).  
 

5. When finished, close both the Spreadsheet and the file NMR Protocol Timings. 
 

6. For those interested in additional benchmarking, reach out to support@wavefun.com. An 

additional file is accessible through Help content, supporting a parallel performance analysis 

for QM calculations, up to 16-cores (larger configuration test files available from our 

Support Team). 

 

Evaluating NMR Assignments II ï Stereochemistry  [15 minutes] 

For practical purposes, stereochemical assignment is a special case of structural assignment. 

It is assumed that the overall agreement between predicted NMR shifts (typically 13C) and 

experiment is sufficient for confirmation of constitution (with RMSE typically 2.2 ppm or 

less). A discussion on predicted NMR performance and practical confidence ranges are 

deferred to the Topics section (validation of this approach was recently established in work 

carried out by Haniff and co-workers (insert IMNP paper reference).  
 

1. From the neural network folder inside the Tutorials directory, open the file bipoladisin 

F. This file contains a set of four diastereomers from one of a series of recently isolated 

sesterterpenoids.12 While Spartanô26 includes the ability (given suer-specification of stereo-

center) to generate a list possible diastereomers, this step has already been completed. 

Demonstration of the Generate Isomer(s) tool is given in Chapters 9, 11, and 13.  
 

2. Open the Spreadsheet. The diastereomers are named including chiral variations at 

carbons 4, 5, and 11 (the entire group is systematically labeled based on the original isomer 

from which it is generated). Reference and solvent meta data appear in the spreadsheet along 

with a Spartan pre-calc column. This column has been formatted with lower precision 

purposefully; we will revisit this following the calculation. 
 

3. Open the Calculationsé dialog, confirm this is set to complete the NMR protocol task 

with the 2026 MLHF workflow. Confirm the Global Calculations checkbox is checked. 

Submit the job. It should take no more than a minute or so on a reasonably configured 

machine. Upon completion, you may either Save or Discard the auxiliary conformer files 

(these files consist of the conformers retained from each potential diastereomer, often worth 

review but not specifically used in this tutorial).  
 

4. Return to the Spreadsheet. The first two columns will populate with appropriate RMS 

error and DP4 probability (%). Which diastereomer best matches experiment? Reminder, 

RMSE, MAE and MaxAE along with DP4 % (where applicable) are available from the 

NMR tab in the Molecule Properties dialogue (Display menu or right-click the background 

 
12 Shen, Y.; Li, Q.; Ding, N.; Yu, M. et al. Bipoladisins AïG, Uncommon Sesterterpenoids with Three Types 

of Carbon Skeletons from Bipolaris maydis and Their Reversal Activity on Paclitaxel Resistance. J. Nat. 

Prod. 2025, 88, (6), 1286ï1297. https://doi.org/10.1021/acs.jnatprod.5c00024  

 

 

 

mailto:support@wavefun.com
https://doi.org/10.1021/acs.jnatprod.5c00024
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to access), and can be posted to the spreadsheet via the post button (down arrow icon) to the 

left of each metric in the NMR tab. 
 

5. From the Spreadsheet click on the previously mentioned Spartan pre-calc column. 

Right-click on the header cell and choose Format Selectedé In the resulting dialog, set the 

formatting to Decimal and choose 2 for Decimal places (rather than zero). Now compare 

these results to your own. Are they consistent? 
 

6. Close bipoladisin F. 
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Section II 
Operations and Overview 
 

The two chapters that make up this section provide an overview of the components which 

control access to Spartanôs graphical user interface (Operating Spartan) and following 

that, a guided tour through some of the more fundamental operations of the interface 

(Walking Through Spartan). Together, these offer sufficient information to begin use of 

Spartan. Description of the full range of Spartanôs capabilities is deferred to Section V 

which is intended to serve as a reference to the current Spartanô26 feature set. A definitive 

Spartan application article is in revision and planned for publication in late 2026. 
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Chapter 1 
Operating Spartan 
 

This chapter describes the general operating features of Spartanô26. It should be perused 

prior to starting the tutorials. 

 

Starting and Quitting Spartan 

 

To start Spartan under Windows, click on the Windows button, then click on All Programs 

and locate and open Spartanô26 (or double click on the Spartan shortcut icon on the 

desktop). To start under Macintosh, double click on the Spartanô26 icon in the Applications 

list. To open under Linux, bring up a terminal and type spartan26. To quit Spartan, select 

Exit from the File menu (Windows) or Quit Spartanô26 from the Spartanô26 menu 

(Macintosh), or click the Close button  toward the top right of the Spartan interface, 

Windows and Linux, (top left for Mac). 

 

Menus and Icons 

Program functions may be accessed either from the menu bar or from icons in the toolbar 

which is directly underneath the menu bar. The menu bar may either be accessed as pull-

down menus (Classic List), for example, the Setup menu: 

 

or from a list of icons presented in a palette (Button Pad), for example, the Display menu: 
 

 

Selection is made in the Settings tab of the Preferences dialog 

(Preferences... under the Options menu; Chapter 25). 
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Icons for all menu functions (as shown alongside text in both Classic List and Button Pad 

styles) are available on screen below the menus. There are too many icons to be 

simultaneously displayed and the choice (beyond the default initially configured) is made in 

the Icons tab (Preferences... under the Options menu; Chapter 25). Icon size is also user 

selectable in the Settings tab (Preferences... under the Options menu; Chapter 25). 

 

 

File 

 
 

 

Allows you to build or sketch a new molecule, add or delete a molecule from an existing 

Spartan document, read in a molecule that you have previously saved, or a file created 

by another program. It also allows you to print text and graphics, embed external files (for 

example, Word and Excel files) into Spartan documents, to access PDB files online and 

to extract ligands from these files. A Save to Database option is a one stop save to 

database (SSPD) operation. And new in Spartanô26 2D/3D View Toggle. 

 

Edit  

 
 

 

Allows you to transfer information to and from the clipboard, to undo the last operation, 

to find text strings and molecule fragments, to center molecules on screen, and to clear the 

active molecule by deleting it. 
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Model 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Provides control of model style of your model, display of (R/S) chirality labels, hydrogen 

bonds and chemical function descriptors, as well as coupling or decoupling mouse 

function for molecules in a multi-molecule document. Allows display of Ramachandran 

plot for a protein structures brought in from PDB. Enables labels, including atom labels 

by atomic charges or  experimental or calculated NMR chemical shifts (or the difference 

between them) among other quantities (custom label displays also available). 

 

Geometry 

 
 

 

Allows you to measure and constrain bond lengths, angles and dihedrals, make lists of stereo 

and regioisomers and tautomers, define points, ligand points and planes, define NOEs, 

specify frozen atoms, alter default settings for conformational degrees of freedom, select 

centers for similarity analysis and align molecules. 

 



41  

Build  
 

 

 

 

 

 

 

Allows you to sketch molecules in 2D or build them in 3D, and to edit molecules that you 

have already sketched or built. Provides tools for making and breaking bonds, deleting atoms 

or groups of atoms in 3D builder as well as both 2D and 3D minimization tools (MMFF) for 

ñcleaning upò 2D drawings and preparing 3D structures for calculation. Allows seamless 

access to ChemDrawÊ (Windows only). Allows you to define transition states in terms of 

curved (reaction) arrows attached to reactants (or products) in either 2D or 3D, and to guess 

a transition-state geometry based on a library of reactions. Permits experimental proton and 
13C chemical shifts as well as observed HH and CH couplings to be associated with 2D 

drawings or 3D structures. 

Setup 
 

 

 

 

 

Allows you to specify and submit calculations and graphical models, either locally or to a 

remote resource via Spartanôs submission tools. 

Display 

 
 

Allows you to display text output, molecular and atomic properties, QSAR descriptors, 

thermodynamic quantities, orbital energy diagrams, surfaces and property maps and 

infrared, Raman, NMR and UV/visible spectra, as well as to access experimental IR, NMR 

and UV/visible spectra from freely available databases on the internet or from local files. 

Spartanô26 further enhances the utility of the Summary Output providing a series of 

tabbed tables containing spectroscopic data that may be copied or printed. Allows you to 

present data in a spreadsheet and make plots from and perform regression analysis on these 

data, to access the results of a similarity analysis and to compute reaction energies based 
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either on user data or from entries in the SSPD (Spartan Spectra and Properties Database). 

New in Spartanô26 is the dual display option providing a manipulable copy of the userôs 

molecule in 2D (while the UI is in 3D view mode) or 3D (when in the 2D Sketch mode) to 

complement the existing visual mode. 

 
Search 
 

  

 

 

Allows database queries, searching and mining of the SSPD for calculated structures, 

properties and spectra, and searching the SRD for calculated transition-state structures. 

Allows you to search the CSD (Cambridge Structural Database)* and to extract ligands from 

the PDB (Protein Data Bank). Allows you to match an unknown infrared spectrum to 

calculated spectra in the SIRD (Spartan Infrared Database) which is derived from the 

EDF2/6-31G* entries in SSPD or to experimental spectra from the XIRD (NIST database). 

Allows you to guess a transition-state geometry based on a library of reactions. 

 
NMR 
 

 

 

 

 

 

 

Allows you to attach experimental proton and 13C chemical shifts to a 3D structure, and to 

specify observed HH and CH couplings. 

Options 
 

 

 

 

 

 

 

 

Allows one to set display standards, specify databases, monitor executing jobs, and 

customize icons and menu display and other aspects of the graphical interface. Allows one 

to access external Spartan computational servers or configure the local machine to accept 

remotely submitted jobs. 

 
 

*  Requires CSD to be licensed. Visit https://www.ccdc.cam.ac.uk/solutions/csd-licence/ for info.  

https://www.ccdc.cam.ac.uk/solutions/csd-licence/
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Activities 
 

 

 

 

 

 

 

Allows you to display tutorials and topics inside of Spartan and to access our YouTube 

videos and search Wikipedia. 

 
Help 
 

 

 

 

 

 

 

  

 

 

Provides access to information on Spartanôs general operation, the Spartanô26 Tutorial and 

Userôs Guide (current version of this document), and a number of computational FAQôs. 

Also provides access to the programôs License Utility . This allows for modification to the 

license, activation, extending maintenance, transferring to a new machine, and accessing the 

license server to check if license update is available to apply. New in Spartanô26 is a utility 

allowing users to Check for Updatesé This will compare the userôs version with the 

current release available and offer a link to update if a newer version exists (note: while this 

alerts of a new version, the user must choose to download/update, we do not do this 

automatically). 

A complete listing of menu functions is provided in Appendix C. 
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Additional Icons 

A variety of other icons appear in Spartan, both in individual dialogs and in the message 

bar at the bottom of the screen. 

                                               Post to Spreadsheet     Search Transition State Library                                                       

Lock/Unlock Constraints /  Move Up/Down Dialog 

                      Server Shortcut          Help/Tool Tips                         Surface clipping planes 

 

 

                 Play                    Pause                                         Revert to Fullscreen 
 
                 Step                               Stop                                           Extend to Fullscreen 
 

 

 Restore Default Settings                       Look Up in Wikipedia 

      /       Add or Remove Tables               Make List                               Fit 

 

Tabs 

Spartanô26 assigns a tab to each open document. These appear in a single row along 

the bottom of the screen in the order that the documents were created or opened. 

Backward and forward step keys (     and    ) at the far right provide access to tabs 

outside of those displayed. On the left of each tab is a check box. If checked, this 

indicates that the document will be (permanently) displayed on screen, even if it is not 

the selected document. 
 

Mouse/Keyboard Operations 

The following functions are associated with a standard mouse and keyboard. 

Acknowledged, depending on platform there is reasonable variability in mice and mice 

configuration. In general, we try to take advantage of the full range of modern mouse 

features but accommodate older mice (or no mice ï in the case of touch pad or touch-

enabled devices). The table below is also available from within the Spartan GUI from 

the Help menu > Spartanô26 Help entry. 

 

 

 

 

/ 
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Using the Mouse 

The following functions are associated with the two-button mouse. 

 

keyboard left buttona right button a 

 

- selection, X/Y rotate X/Y translate 
Shift range selection, Z rotate scaling 

Control  
multiple selection, global X/Y 

rotateb 
global X/Y translate 

Control + Shift  global Z rotateb scaling 

Alt  group picking ... 

Alt  ("View" mode) group selection c ... 
Alt  ("Build" mode) bond rotate bond stretching 

Control  ("Build" mode) fragment X/Y rotate fragment X/Y translate 

Control + Shift  ("Build" mode) fragment Z rotate scalingb 

 

 Double-click 

left button 
Mouse Wheel 

 

-  Zooming, scroll 

up/down 

-Bonding mode substitution, insertion ... 
-Bonding mode select atom d ... 

 

a) Left and right buttons together with no modifier keys are used for defining a section box. 
b) In this context, 'Global' means all visible molecules. 

c) With both left and right mouse buttons selected a selection box for multiple object selection is available. 

d) Select atom as opposed to selecting an open valence. 

Mouse/keyboard operations may be broadly separated into two categories: selection 

(picking) and manipulation (translation/rotation). 

These broadly fall into two categories: selection (picking) and manipulation 

(translation/rotation/zooming). 

Selection. Clicking (left button) selects objects on screen and/or of menu items. Center 

wheel or both left and right buttons together are used to define a selection box for 

copying to the clipboard, as well as for group selection. Together with the Shift key, 

the left button allows for selection over a range. Together with the Ctrl (Control ) key, 

the left button allows for multiple selection. Both range and multiple item selection 

apply not only to text items in lists, but to atoms and bonds in molecules as well. 

Together with the Alt /Option key), the left button allows for selection of an entire 

group (detached molecular fragment). 

In (3D) Build mode, double clicking (left button) on an atom exchanges it with the atom 

or atomic fragment selected in the model kit. Double clicking on an atom while holding 

down the Ctrl (Win or Linux) or the Command key (Mac) leads to inversion in 

chirality of the atom and double clicking on the molecule while holding down both the 

Ctrl (Win or Linux) /Command key (Mac) and Shift key, will invert the absolute 

configuration of the molecule. In (2D) sketch mode, double clicking on an atom with 

another atom selected in the sketch pane replaces it with the selected atom. Double 

clicking on an atom with charge/radical selected in the sketch pad adds charge or radical 

designation to the atom and adjusts hydrogen count. Unless a ring icon is selected from 

the sketch palette, double clicking on a bond increases the bond order by 1 (single to 

double or double to triple). Double clicking on a triple bond replaces it with a single 

bond. Once an initial fragment, group or ring has been drawn, double clicking on the 
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background in either 2D or 3D mode will insert the selected item alongside the existing 

structure. 

Manipulation . The left button is used for rotation, and the right button is used for 

translation and scaling in Spartanôs main screen. With no keys depressed, moving the 

mouse while holding down the left button gives rise to rotation about the X and y 

(screen) axes, while moving the mouse while holding down the right button gives rise 

to translation in the x and y (screen) directions. Together with the Shift key, moving 

the mouse while holding down the left button gives rise to rotation about the z direction, 

while moving the mouse while holding down the right button gives rise to scaling. The 

center (scroll) wheel on the mouse may also be used for scaling. 

In Edit Build mode (only), the default is focus on the full set of fragments that make 

up the molecule being constructed, and rotations and translations refer to this set of 

fragments as a whole. Use of the Ctrl key changes focus to a single fragment (the 

selected fragment), and rotations and translations now refer only to this fragment. 

In Edit Build mode (only), moving the mouse while holding down the Alt/Option key 

and left mouse button rotates about the selected bond. Bond rotation may also be 

accomplished by moving the mouse up and down inside the marked area at the left of 

the screen while holding down the left button. 

Additional keys control various Spartan functions. 

 

Keyboard Operations 
 

 

 

 

Page Up, Page Down 

Home, End 

 

Insert 

(option for Mac) 

 

 

 

Delete 

 

Moves up (Page Up), down (Page Down), to the top (Home) and 

to the bottom (End) of the set of open molecules. Also, moves 

up and down pages in the Output dialog. 

In Edit Build/Edit Sketch fragment mode only, inserts a new 

fragment on screen. This is accomplished by selecting the 

fragment from the model kit, holding down the Insert key and 

clicking on screen. Insertion may also be accomplished by 

double clicking on the background following selection of a 

fragment. 

Deletes a fragment, free valence, CFD, reaction arrow, the 

contents of a selection box, spectrum, curve, or plot. This is 

accomplished by holding down the Delete key and clicking on 

the fragment, etc. 

Required following text or data entry into spreadsheet or dialogs. 
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Touch-Pad/Track-Pad Operations 

 

  Standard Pad 

 

  Rotate One-finger press and rotate 

  Translate Two-finger press and translate 

  Zoom (translate in the Z pane)    Two-finger rest (move fingers up and down) 

  Rotate in the Z plane Hold Shift key down, One-finger press up or down. 

  Rotate around bond In New Build or Edit Build , press on a bond to select it. 

A red arrow indicates selected bond. Move the cursor 

over vertical strip on the left of the interface and then 

one-finger press and move the cursor up or down. 

 

  Two Button Pad 

 

  Rotate One-finger left-press and rotate 

  Translate One-finger right-press and translate 

  Zoom (translate in the Z pane)     Two-finger rest (move fingers up and down) 

  Rotate in the Z plane Hold Shift key down, one-finger left press (up or down) 

  Rotate around bond In New Build or Edit Build , left-press on a bond to select 

it. Ared arrow will indicate selected bond. Move the cursor 

over vertical strip on the left-hand side of the interface and 

then left-press and move the cursor up or down 

 

 

 

Touch-Screen Operations 

Tapping = clicking and double tapping = double clicking. Range and multiple selection 

have not yet been implemented. One finger motions on screen are equivalent to left 

button motions. Two finger motions are equivalent to right button motions. Pinching is 

equivalent to scroll wheel operations. 
 

Selecting Molecules 

While two or more molecules may be simultaneously displayed, only one molecule may 

be selected. Only the selected molecule has access to all capabilities. Molecule selection 

occurs by clicking on its structure model or on any of its associated graphical surfaces. 

Where the molecule belongs to a document with more than a single molecule, selection 

from among the different molecules may be made using the buttons or the scroll bar at 

the bottom left of the screen. Clicking  on step keys at the bottom left of the screen 

animates the display of molecules in the document, that is , steps through them 

sequentially. Animation speed is controlled from the Settings tab  (Preferencesé 

under Options menu; Chapter 25).
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Clicking on  stops the animation. If the spreadsheet associated with the document is open 

(Spreadsheet under the Display menu; Chapter 22), selection can also be made by clicking 

on the molecule label at the left of the spreadsheet. 

Two or more molecules from the same document may be displayed at once (although only 

one may be selected). Molecules are marked for display by checking the box immediately 

to the left of the molecule label in the spreadsheet. 

 

Stereo Displays 

Spartan supports red-cyan stereo. Red/blue glasses must be worn. To enter stereo mode, 

access the Preferences dialog, Options menu. The Settings tab contains an On/Off  selection 

for Stereo mode. Does not apply to the 2D sketcher. 

Changing Colors and Setting Preferences 

Colors and Preferences... under the Options menu (Spartanô26 menu, Macintosh) allows 

for changing default background and graphical object colors, and for setting (and resetting) 

program preference defaults, respectively; Chapter 25. Further control of color is available 

in the various Style dialogs accessible from Properties under the Display menu; Chapter 

22. 

 

Monitoring and Terminating Jobs 

The Monitor lists jobs that are either queued or executing on the local machine or on a 

remote server (Monitor ). Queued jobs may be started and executing jobs may be terminated. 

The current text output and molecular structure of executing jobs may be examined. The 

Monitor is accessible from the Options menu (Chapter 25). 
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Chapter 2 
Walking Through Spartan 

 

This chapter, in the form of a tutorial, introduces a number of basic operations in Spartan 

required for molecule manipulation, property query and spectra and graphics display. This 

chapter is requisite for new Spartan users. It shows how to: i) open molecules, ii) view 

different model styles and manipulate molecules on screen, iii) measure bond distances, 

angles and dihedral angles, iv) display energies, dipole moments, atomic charges and 

infrared, VCD, NMR and UV/visible spectra, and v) display graphical surfaces and property 

maps, and via the spreadsheet, display multiple molecules from the same document. Other 

spreadsheet operations are not illustrated, no molecules are sketched or built, and no 

quantum chemical calculations are performed.* The final example illustrates one of the 

neural networks incorporated in Spartanô26.  

1. Start Spartan. Click (left mouse button) on File from the menu bar that appears at 

the top of Spartanôs main window. Click on Open... from the File menu that appears. 

Alternatively, click on the  icon at the top of the screen. A file browser appears. 

 

Move to the Tutorials directory** and open Walking Through Spartan (File menu Open 

Walking Through Spartan). 

 

 

 
 

*  The results of quantum chemical calculations in this chapter have been obtained using the 

ɤB97X-D/6-31G* density functional model. 

** For Windows, the Tutorials directory is found in Program Files/Wavefunction/Spartan26.  

It needs to be copied to another location available to the user (we recommend Documents or Desktop)  

prior to opening it in Spartan. 

For Macintosh, this is located at the top of the Spartan26 disc image. It needs to be copied to another 

location available to the user (we recommend Documents or Desktop). 

For Linux , the Tutorials directory is found in the install directory. Copy the Tutorials 

directory to a location that allows write permission, typically the userôs home directory. 

Tap on Walking Through Spartan and tap on Open (or 

double tap on Walking Through Spartan). Note that click 

(left mouse button) and tap (one finger) are equivalent as are 

double click and double tap. We shall only indicate click/double 

click throughout the text that follows. 
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A single file containing ethane, acetic acid dimer, propene, ammonia, hydrogen peroxide, 

acetic acid, water, cyclohexanone, camphor (RR), epicamphor (SS), camphor, 3-

benzoylaniline, ethylene, benzene, aniline, cyclohexanone, and two copies of the natural 

product camalexin (3-(1,3-thiazol-2-yl)-1H-indole) will be opened. A ball-and-spoke model 

for the first molecule (ethane) will be displayed, and its name appears at the bottom right of 

the screen. The appearance of the name indicates that the molecule is included in the Spartan 

Spectra and Properties Database (SSPD). 

2. Practice rotating (move the mouse while holding down the left button) and translating 

(move the mouse while holding down the right button). Use the scroll wheel to zoom 

in and out, alternately move the mouse (up or down) while holding down both the 

right-mouse button and the Shift key. 
 

 

Click on Model from the menu bar. 

 

 
 

                                Wire Ball-and-Wire Tube Ball-and-Spoke 

 
 
 

To rotate, move one finger across the screen. To translate, 

move two fingers across the screen. To zoom out, pinch two 

fingers together. To zoom in, move two fingers apart. 
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One after another, select Wire , Ball and Wire, Tube and finally Ball and Spoke from the 

Model menu. All four models for ethane show essentially the same information. The wire 

model looks the most like a conventional line formula. It uses color to distinguish different 

atoms, and one, two and three lines between atoms to indicate single, double and triple 

bonds, respectively. 

The ball-and-wire model is identical to the wire model, except that atom positions are 

represented by small colored spheres, making it easy to identify atom locations. The tube 

model is identical to the wire model, except that bonds are represented by solid cylinders. 

The tube model is better than the wire model in conveying three-dimensional shape. The 

ball-and-spoke model is a variation on the tube model; atom positions are represented by 

colored spheres, making it easy to see atom locations. 

Select Space Filling from the Model menu. 
 

 

Space-Filling 
 

The space-filling model is different from the other model styles in that bonds are not shown. 

Rather, each atom is displayed as a colored sphere that represents its approximate relative 

size. The space-filling model provides a measure of a moleculeôs size. While lines between 

atoms are not drawn, the existence (or absence) of bonds can be inferred from the extent to 

which spheres on neighboring atoms overlap. If two spheres substantially overlap, then the 

atoms are almost certainly bonded, and conversely, if two spheres barely overlap, then the 

atoms are not bonded. Intermediate overlaps suggest weak bonding, for example, hydrogen 

bonding. 

3. Click once on the right arrow key      at the bottom left of the screen. This will move 

to the next molecule in the document, acetic acid dimer. Its name will appear at the 

bottom of the screen. use the backward       or forward      step keys to get to acetic 

acid dimer in the document. From the space-filling model, look for overlap between 

the (OH) hydrogen on one acetic acid molecule and the (carbonyl) oxygen on the other. 

Return to a ball-and-spoke model. Click on the Model menu and select Hydrogen 

Bonds. 

 
Ball-and-Spoke model for acetic acid dimer with hydrogen bonds displayed 
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The two hydrogen bonds, that are responsible for the pose or orientation of the most 

energetically favorable dimer complex, will be drawn. 

4. Distances, angles, and dihedral angles can easily be measured with Spartan using 

Measure Distance, Measure Angle, and Measure Dihedral, respectively, from the 

Geometry menu. 

 

a) Measure Distance: This measures the distance between two atoms. Click once 

on Ʒto move to the next molecule, propene. Click on the Geometry menu and 

select Measure Distance (or click on the  icon if it appears at the top of the 

screen). Click on a bond or on two atoms (the atoms do not need to be bonded). 

The distance (in Ångstroms) will be displayed at the bottom of the screen. Repeat 

the process for different bonds or pairs of atoms. When you are finished, select 

View from the Build menu (or click on the  icon at the top of the screen). 

 

b) Measure Angle: This measures the angle around a central atom. Click once on 

Ʒto move to the next molecule, ammonia. Click on the Geometry menu and 

select Measure Angle (or click on the  icon if it appears at the top of the 

screen). Click first on H, then on N, then on another H. Alternatively, click on 

two NH bonds. The HNH angle (in degrees) will be displayed at the bottom of 

the screen. Click on  when you are finished. 

 

 

c)   Measure Dihedral: This measures the angle formed by two intersecting planes, 
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one containing the first three atoms selected and the other containing the last 

three atoms selected. Click once on Ʒto move to the next molecule, hydrogen 

peroxide. Click on the Geometry menu and select Measure Dihedral (or click 

on the  icon if it appears at the top of the screen) and then click in turn on the 

four atoms (HOOH) that make up hydrogen peroxide. The HOOH dihedral angle 

will be displayed at the bottom of the screen. Click on  when you are finished. 

5. Energies, dipole moments and atomic charges (among other calculated properties) are 

available from Properties under the Display menu. 

 

 

a) Energy: Click once on Ʒto move to the next molecule, acetic acid. Click on the 

Display menu and select Properties (or click on  icon if it appears at the top of 

the screen). The Molecule Properties dialog appears. It is divided into six parts 

designated by tabs. Molecule provides the energy and other information relating to 

the isolated molecule, QSAR provides quantities that may be used as QSAR 

descriptors, and Thermodynamics provides the entropy, enthalpy, Gibbs energy, 

zero-point energy and heat capacity. ȹHf (298.15) provides heat of formation data 

from NIST (if available) and the SSPD (if available) from the T1 model, and an 

estimated ȹHf from DFT: ɤB97X-V/6-311+G(2df,2p)//ɤB97X-D/6-31G*, NMR 

relates calculated and experimental NMR chemical shifts and Utilities introduces 

standard atom labels, resets model and atom colors as well as conformational 

degrees of freedom to standard values, fixes bond typing, changes absolute 

configuration adds missing hydrogens and adjusts X-H bond lengths. Note that the 

last three of these require that calculations need to be repeated. Make certain that the 

Molecule tab is selected. 
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This provides the energy* for acetic acid in atomic units (Energy in au). 

b) Dipole Moment: The magnitude of the dipole moment (Dipole Moment in Debye) 

is also provided in the Molecule Properties dialog. A large dipole moment indicates 

large separation of charge. You can attach the dipole moment vector,    where the + 

side refers to the positive end of the dipole, to the model on the screen, by checking 

the box to the left of Display Dipole Vector to the right of Dipole Moment. 
 

 

 

 
 
 

* The calculated energy depends on a number of factors including computational model, basis set (where 

applicable) and environment. For a discussion, see Activities menu Topics: Total Energies and 

Thermodynamic and Kinetic Data. 

The vector will not be displayed if the dipole moment is zero. The 

dipole moment will not be reported if the molecule is charged 

because in this case it depends on the location and orientation of 

the molecule in space. 
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c) Atomic Charges: To display the charge on an atom, click on it with the Properties 

dialog displayed. Atom Properties replaces the currently displayed Properties 

dialog. 
 

 

Three different atomic charges, Electrostatic, Mulliken and Natural , are given in 

units of electrons. A positive charge indicates a deficiency of electrons on an atom 

and a negative charge, an excess of electrons. Repeat for other atoms. Confirm that 

the positively-charged atom(s) lie at the positive end of the dipole moment vector. 

When you are finished, close the dialog by clicking on       at the top. 
 

 

6. Infrared Spectra: Molecules vibrate (stretch, bend, twist) even if they are cooled to 

absolute zero. This is the basis of infrared (and Raman) spectroscopy, where absorption 

of energy occurs when the frequency of a particular molecular motion matches the 

frequency of the light. Infrared spectroscopy is important for identifying molecules as 

different functional groups vibrate at noticeably different and characteristic 

frequencies. 

 

The three sets of atomic charges for acetic acid are different, 

sometimes markedly so. Note that the charge on an atom in a 

molecule cannot be uniquely defined, let alone measured. While 

the nuclear charge is equal to the atomic number, it is not possible 

to say how many electrons ñbelongò to a particular nucleus. 

The different calculated charges correspond to different ways of 

counting the number of electrons associated with an atom. 
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Click once on Ʒto move to the next molecule in the document, water. To animate a 

vibration, select Spectra from the Display menu (or click on  if it appears at the top 

of the screen). This leads to an empty spectra pane at the bottom of the screen. 

 

Click on  at the top left of the pane and select  from the available spectra. 
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The calculated IR spectrum of water from 4000 - 500 cm-1 appears in the pane. 

An upward and downward triangle server as a probe indicator, allowing for further 

inspection of the plot. 

There are three lines, one of moderate intensity around 3728 cm-1, one very weak around 

3608 cm-1 and one very strong around 1624 cm-1. In turn, click on each of these peaks. In 

response, the molecular model will vibrate. The line of moderate intensity corresponds to 

an asymmetric OH stretching motion, the very weak line corresponds to a symmetric OH 

stretching motion and the strong line corresponds to the HOH bend. 

To translate the plot inside the pane, position the cursor over the spectrum and move the 

mouse left or right while holding down the right button. To expand or contract the scale 

of the IR plot from its default range, position the cursor over the spectrum and use the 

scroll wheel on your mouse (or alternatively move the mouse while holding down both 

the right button and Shift key). To reset the spectra plot to the original values, click on 

 in the bar at the top of the spectra pane. To increase (or decrease) the size of the plot, 

you first need to undock it by clicking on  at the upper right. You can then size it as 

you would any other window. To redock the plot, click again on . 

To see a complete listing of frequencies and intensities, click on      (Tables) at the left 

of the spectra pane. 
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Click on each entry in the table to highlight the frequency in the spectrum and animate the 

vibration. Click on        to dismiss the table and click on       to remove the spectrum. 
 

 

Click once on Ʒto move to cyclohexanone, the next molecule in the list. The spectra pane 

is still on screen but should be empty. (If it is not on screen, select Spectra from the Display 

menu or click on     if it appears at the top of the screen to restore.) Click on       in the bar 

at the top of the spectra pane and on the                  . The calculated infrared spectrum of 

cyclohexanone appears. 
 

 
The calculations actually provide a list of frequencies and an associated list of intensities 

(some of which may be zero or very close to zero). The spectrum that is displayed uses these 

data but has been broadened (to account for finite temperature) and scaled (to account for 

the fact that the underlying energy function is assumed to be quadratic as well as for 

limitations of different models). The same broadening parameter (temperature) is applied to 

all molecules and all levels of calculation. The same scaling parameter is used for all 

molecules, but it depends on the theoretical model. 

The largest peak appears at 1759 cm-1 and corresponds to a CO stretch. The fact that the line 

is both intense and isolated from other features in the spectrum makes it a very useful 

indicator of carbonyl functionality. Click on this peak and examine the ñvibratingò model 

for cyclohexanone on screen above the spectrum. 

Click again on  and this time select . The experimental IR spectrum (from the 

freely available NIST database) is superimposed on top of the calculated spectrum. 

 

Changing the size of the spectrum dialog as well as translating 

and altering the visible scale are quite simple with touch 

screen operations. To resize the spectrum, position one finger 

inside the menu bar at the top of the spectra pane and move up or 

down. To translate the scale, move two fingers over the spectrum. 

To alter the scale, pinch two fingers over the spectrum. 



59  

 

Note that the two spectra are similar but not perfectly matched. 

When you are done, select  from the bar at the top of the spectra pane. 

7. VCD Spectra: VCD spectra are often used to distinguish between enantiomers (that is, 

establish absolute configuration). Along with NMR for structure and diastereomer 

confirmation, VCD is highly useful in establishing proper stereochemistry. 

Click once on      to move to the next molecule in the document, camphor (RR). With 

the spectra pane on screen, click on     in the bar at the top of the spectra pane, click on 

the VCD tab  and select . The calculated VCD and IR spectra for camphor (with 

RR chirality at bridging carbons). Click again on       to advance to the next list member, 

epicamphor (SS). Note the sign (direction) of the SS enantiomerôs spectra are inverted 

(from the RR epimer). Future updates will include import of experimental VCD spectra 

for overlaid comparisons. Click on  to close out of the opened spectra. 

8. NMR Spectra: Along with mass spectrometry, NMR spectroscopy is the most 

powerful tool available with which to assign molecular structure. Many (but not all) 

nuclei exhibit NMR spectra, but proton and 13C are by far the most important. 

Click once on      to move to the next molecule in the document, camphor. With the 

spectra pane on screen, click on    in the bar at the top of the spectra pane, click on the 

NMR tab  and select                 . The calculated 13C NMR spectrum appears.  

 

 
 

This comprises nine lines, in the range of 150 to 0 ppm (there is a tenth line 

corresponding to the carbonyl carbon at 216 ppm). You can zoom out to see this line 

by using the scroll wheel on your mouse. More instructive is to zoom in on the range 

from 60 to 0 ppm to get a better look at the other lines. 

Click on one of the probe triangles to select the probe and move the mouse while 

holding down the left button over the spectrum. When you come to a line, the chemical 

shift will appear at the top of the spectrum and the atom (or atoms) responsible for this 

line will be highlighted on the model displayed above the spectrum. 
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Again, click on       in the bar at the top of the spectra pane and select               .  

The experimental 13C spectrum obtained from the freely available NMRShiftDB 

collection will be superimposed on top of the calculated spectrum. 

 

 
 

You will see that the overall agreement between calculated and experimental 13C 

spectra is quite good. As with infrared spectra (see preceding discussion of 

cyclohexanone), the data resulting from the quantum chemical calculations has been 

empirically corrected. 

Click again on  and select . An ñidealizedò proton spectrum where three-

bond HH coupling constants are set to zero appears. 
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Spectra manipulations are as before and the hydrogens responsible for selected lines 

are highlighted in the model. No experimental spectrum is available, but the quality of 

the match would be expected to be similar to that previously observed with comparison 

of 13C spectra. 

Click again on  and select  from the palette. The spectrum that appears is 

more complicated and much closer to what would be observed experimentally. In this 

example, HH coupling constants have not been calculated from quantum mechanics, 

but they have been estimated based on local environment. 

 
 

Zoom in on specific lines (scroll wheel) to see the detailed splitting patterns. For 

example, the two protons at C3 are both split by the proton at C4. The doublet at 2.36 

ppm shows a much larger splitting than the doublet at 1.85 ppm (you need to zoom in 

considerably to see that this is a doublet). This reflects the fact that the proton 

responsible for the line at 2.36 ppm makes a dihedral angle of 43° with the proton at 

C4, whereas the proton responsible for the line at 1.85 ppm makes a dihedral angle of 

80°. 

Finally, note that you can switch among the three calculated NMR spectra (as well as 

the experimental 13C spectrum) for camphor by clicking on the associated button in the 

bar above the spectra pane. When you are done, remove all three spectra. Click on  

three times in succession to remove the spectra. 

9. UV/visible Spectra: Absorption of light in the visible or ultraviolet range of the 

electromagnetic spectrum leads to electronic excitation from the ground-state to 

excited-states and (in the case of absorption in the visible), is responsible for a 

moleculeôs color. UV/visible spectroscopy not only offers a ñfingerprintò but is also an 

important screen to identify molecules that may be damaged by exposure to light. 

 

Click once on Ʒ to move to the next molecule, 3-benzoylaniline. The spectra pane 

should still be on screen. Click on  and select  . No empirical corrections 

have been applied to the calculated spectrum that appears. 
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Click again on  and select the UV/vis tab and click on . The experimental 

UV/ visible spectrum from the freely available NIST database will be drawn on top of 

the calculated spectrum. 

 

The two spectra are visually similar at least qualitatively. However, calculated and 

experimental UV/visible spectra are likely to be sufficiently different that the theory 

will not often be able to account for the ñcolorò of the molecule. Where the theory is 

likely to be more successful is in anticipating changes in color resulting from subtle 

changes in structure. Click on        when you are done. Also, remove the spectra pane 

either by clicking on     at the top right or by selecting Spectra from the Display menu 

or by clicking on          at the top of the screen. 

10. Spartan permits display, manipulation and query of a number of important graphical 

quantities resulting from quantum chemical calculations. Most important are the 

electron density or simply density as it is commonly referred to (that reveals how much 

space a molecule actually takes up), the bond density (that reveals chemical bonds), 

and key molecular orbitals (that provide insight into both bonding and chemical 

reactivity). In addition, the electrostatic potential map, an overlay of the electrostatic 

potential (the attraction or repulsion of a positive charge for a molecule) on the electron 

density, is valuable for describing overall molecular charge distribution as well as 

anticipating sites of electrophilic addition. Another indicator of electrophilic addition is 

provided by the local ionization potential map, an overlay of the energy of electron 

removal (ionization) on the electron density. Finally, an indicator of nucleophilic 

addition is provided by the |LUMO| map, an overlay of the absolute value of the lowest-

unoccupied molecular orbital (the LUMO) on the electron density. 
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a) Click once on      to move to the next molecule in the list, ethylene. Click on the 

Display menu and select Orbital Energies (or click  if it appears at the top of the 

screen). An orbital energy diagram for ethylene will appear at the left of the screen. 

This provides the energies of all six occupied valence molecular orbitals and the first 

ten unoccupied molecular orbitals. 

 

 

Note: Right-clicking on the MO diagram and choosing Properties from the resulting 

contextual menu provides access to display of up to the first 10 occupied and 

unoccupied orbitals. Orbitals outside this range can be requested individually from the 

Surfaces dialog (Setup and Display menu). 

 

Click on the energy level in the diagram labeled HOMO. In a second, the familiar ˊ 

bond in ethylene will appear. Note that the graphic has ñblue and redò regions. These 

correspond to positive and negative values of the orbital (the absolute sign is arbitrary). 

Examine the other occupied orbitals (by clicking on their respective energy levels in the 

diagram) as well as the lowest-unoccupied molecular orbital (the LUMO). Note that 

you can move from one level to the next by moving the mouse up or down while holding 

down and then releasing the left button. You can also use the up and down arrow keys 

on your keyboard. Click on view         when you are done. 

 

                                

b) Click once on Ʒto move to the next molecule in the list, benzene. Click on the 

Display menu and select Surfaces from the palette (or click on  if it appears at the 

top of the screen). The Surfaces dialog appears. 

ñSwipeò one finger up or down over the orbital energy 

diagram to move to the next higher or lower energy level. 
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Select electrostatic potential map inside the Surfaces dialog (check the box to the left 

of the name). An electrostatic potential map for benzene will appear.* Click on the map. 

The Style menu will appear at the bottom right of the screen. Select Transparent from 

this menu. This makes the map transparent and allows you to see the molecular skeleton 

underneath. Go back to a Solid display (Style menu) in order to clearly see color 

differences. The default color scheme follows the coloring in a rainbow: 

red ïü orange ïü yellow ïü green ïü blue 

By convention, red indicates a negative potential (the benzene p system) attraction to a 

positive charge while blue indicates a positive potential (the s system) or repulsion by 

a positive charge. An alternative scheme with only three colors (red, white and blue) 

may be selected. Click on the Display menu and select Properties (or click on  if it 

appears at the top of the screen) and click on the surface. 

 

* Discrete displays are the default. You can change the default to continuous displays by turning off the Bands 

checkbox in the Molecule tab of the Preferences dialog (Preferences... under the Options menu; Chapter 

25). 
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c) Click once on Ʒto move to the next molecule in the list, aniline, and select local 

ionization potential map inside the Surfaces dialog. By convention, red regions on a 

local ionization potential map indicate areas from which electron removal (ionization) 

is relatively easy, meaning that they are subject to electrophilic attack. These are easily 

distinguished from regions where ionization is relatively difficult (by convention, 

colored blue). Note that the ortho and para ring carbons are redder than the meta 

carbons, consistent with the known directing ability of the amino substituent. 

d) Click once on Ʒto move to the next molecule in the list, cyclohexenone, and check 

LUMO inside the Surfaces dialog. The resulting graphic portrays the lowest-energy 

empty molecular orbital (the LUMO) of cyclohexenone. This orbital is delocalized onto 

several atoms, and it is difficult to tell where exactly a pair of electrons (a nucleophile) 

will attack the molecule. 

A clearer portrayal is provided by a LUMO map that displays the (absolute) value of 

the LUMO on the electron density surface. By convention, the color blue is used to 

represent maximum value of the LUMO and the color red, minimum value. First, 

remove the LUMO from your structure (uncheck LUMO in the Surfaces dialog) and 

then turn on the LUMO map (check |LUMO|map in the dialog). Note that there are two 

blue regions, one directly over the carbonyl carbon and the other over the b carbon. 

This is entirely consistent with known chemistry. Enones may either undergo carbonyl 

addition or conjugate (Michael) addition. 

 

 

 

 

 

11. New in Spartanô26 is class of models that generally fall under the heading of machine 

learning models (colloquially, throughout the manual, these are referred to as neural 
network routines, or more simply neural nets). Click once more on Ʒ to move to the 

next model camalexin dft (the full SSPD identifies this as 3-(1,3-thiazol-2-yl)-1H-
indole. This example includes the results of geometry optimization and NMR chemical 

shifts from ɤB97X-D/6-31G* density functional calculations. The model display has 

been simplified to omit hydrogens, and the molecule is rendered in the tube display 
with calculated chemical shift labels turned on for 4 specific carbon centers.  

Click once more on Ʒ to move to the next model camalexin est dft nn. This molecule 

is a copy of the previous and also has available NMR data from ɤB97X-D/6-31G* 
density functional calculations, the difference in this case is that equilibrium geometry 

was determined by a neural network routine, rather than quantum mechanics. Move the 
step keys back and forth to compare chemical shift results. 
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From the Display menu, select the Spreadsheet. Spartanôs internal spreadsheet is 
useful for data organization, analysis, linear regression, and customized functions 

including multi-molecule display. Resize the spreadsheet so that you can see the bottom 
two entries. Click inside the check box to left of both camalexin dft and camalexin est 

dft nn. This will turn on display of both molecules. You can manipulate both samples 
independently (selection is made by clicking on the molecule you wish to select). Note, 

it may be desirable to Couple multiple moleculeôs positions, such that movements are 
applied to multiple molecules. This is achieved by toggling the Coupled (on or off as 

needed). Position both copies so that the chemical shifts are visible for comparison. 

How well did the neural network routine perform in comparison to the density 
functional sample? 

12. When you are finished, close the document by selecting Close from the File menu or 
alternatively by clicking on the  icon at the top of the screen. 
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Section III 
Introductory Tutorials 
 

The first step in performing a molecular mechanics or quantum chemical calculation 

typically involves specifying molecular geometry. Spartan offers four ways to do this: 

building in 3D, sketching in 2D, accessing a database and accessing a variety of coordinate 

formats from the File menu. See Chapter 16 for a list of supported file types. 

To build molecules in 3D, Spartan provides a palette of common atomic fragments, menus 

of common functional groups and rings, access to the clipboard and tools for making and 

breaking bonds and for deleting atoms or groups of atoms. The 3D building paradigm is 

quite general and covers not only organic molecules discussed in chapters which make up 

this section, but also inorganic and organometallic molecules, as well as polypeptides and 

polynucleotides. Tutorials illustrating the essential features and capabilities of Spartanôs 3D 

builder for organic molecules are provided in Chapter 3. 

Building in 3D may feel unfamiliar or uncomfortable for many chemists, who, after all, have 

been taught to draw molecules in 2D on paper or on a whiteboard. The advent of tablet 

computers and touch- screen PCôs makes ñon-screenò 2D drawing an attractive alternative 

to 3D building. Spartan provides a simple but highly functional 2D sketcher directed 

primarily (but not restricted) to organic molecules. Simple inorganic and organometallic 

molecules may also be sketched. Common atoms, functional groups and rings are all 

contained in a single palette. Conversion to 3D structure is automatic, but requires explicit 

specification of cation, anion, or radical centers (in order to add the proper number of 

hydrogens to the sketch) as well as designation of stereochemistry. While sketch capability 

is designed for touch screen devices (and is modeled after the iSpartan app for iOS devices), 

it is fully functional using a mouse and keyboard or a touch pad. Tutorials illustrating the 

essential features and capabilities of Spartanôs 2D sketcher are provided in Chapter 4. 

Properties relating to geometry, for example, bond lengths and angles, are discussed in these 

two chapters and a few simple examples are provided. The intention is to touch on only the 

most commonly-used features, leaving discussion of more advanced functions to tutorials 

in later chapters. 

The tutorials in the remaining chapters in this section may be completed starting from either 

the 2D sketcher or 3D builder whichever is more comfortable for the user. Tutorials in 

Chapter 5 illustrate the range of molecular properties and spectra available from quantum 

chemical calculations, while those in Chapter 6 illustrate a variety of common graphical 

models that can be displayed. No calculations are actually required for these tutorials. 

Rather, results are taken from the Spartan Spectra and Properties Database (SSPD) and 

correspond to calculations using either the wB97X-D/6-31G* density functional method. 
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The first tutorials that actually requires quantum chemical calculations are provided in 

Chapter 7. 

Completing the full set of tutorials in this section will take a few hours and make only a 

modest demand on computer time (for examples in the last section). This will not make you 

an ñexpertò but will expose you to enough that you are comfortable navigating Spartan. 

ñAdvancedò tutorials, in the next section, build on this foundation and introduce a wider 

range of the programôs features and capabilities. 
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Chapter 3 
Building Organic Molecules in 3D 

 

The tutorials in this chapter introduce and illustrate tools to build 3D molecular structures. 

These include atomic fragments, functional groups and rings contained in the organic model 

kit together with tools for making and breaking bonds, deleting atoms and refining structure. 

 

Organic Model Kit  

Click on      (New) to bring up the 3D model kit. The organic model kit contains a selection 

of atomic fragments corresponding to elements commonly found in organic molecules. The 

kit may be scrolled if your display is too small to display it.*  

 

 
 
 

* Additionally, you can save space by removing the icons at the bottom of the model kit. Uncheck Show Toolbar 

from the Miscellaneous tab of the Preferences dialog (Options menu; Chapter 25). 
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Different hybridization states are provided for some elements (from left to right and then 

top to bottom): 

 

C(sp3) N(sp3) P(sp3) H 

C(sp2) N(sp2) O(sp3) F 

C(sp) N(sp) O(sp2) Cl 

C(aromatic) N(aromatic) S(sp3) Br  

Si(sp3) N(planar) S(sp2) I  

A fragment is chosen by clicking on its icon, which is then displayed in a box at the top of 

the model kit. The name of the fragment is displayed in the selection bar underneath, for 

example, . Once selected, the fragment may be used to initiate building, 

to add alongside of an existing structure or bond onto an existing structure. To initiate 

building, double click anywhere on screen.* To add alongside of an existing structure, double 

click in a blank area on screen. To bond to an existing structure, click on a free valence (not 

an atom). (Free valences are colored yellow on the selected molecule.) Bond type in the 

case of atomic fragments with multiple bond types, for example, sp2 carbon, depends on the 

nature of the free valence selected. 

Clicking on the Groups button near the bottom of the 

model kit changes the focus from fragments to groups, 

one of which will be shown in the box at the top of the 

model kit and named in the selection bar directly 

underneath. Clicking on the selection bar brings up a 

menu of available groups. 

Once selected from the menu, a group may be used to 

initiate building, to add alongside of an existing structure 

on screen, or to add to an existing structure. 
 

 

 

 

 

 

 

 

 

 

 
 

*  For users of much earlier versions of Spartan that have grown accustomed to (or new users who prefer) a 

single-click motion to initiate building, this preference can be set from the Options menu > Preferences dialog 

> Settings tab, by deselecting the Double-Click Start check box and clicking the OK button. The choice to 

move to a double-click start for 3D building was made to maintain consistency with the behavior of the 2D 

sketch builder. 
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Clicking on the Rings button near the bottom of the 

model kit changes the focus to rings, one of which will 

be shown in the box at the top of the model kit and 

named in the selection bar underneath. Clicking on the 

selection bar brings up a menu of available rings. 

Once selected from the menu, a ring may be used to 

initiate building, to add alongside of an existing 

structure on screen, or to add to an existing structure. 

Ring-merging is available (that is clicking on a bond to 

merge rather than attaching via single-bond. 

 

Note that only hydrocarbon rings are available. Heteroatoms may be substituted for carbons, 

for example, substituting an oxygen for one of the carbons in cyclohexane leading to 

tetrahydropyran. With cyclohexane on screen, click on sp3 oxygen            in the model kit 

and then double click on one of the cyclohexane carbons. 

The amide and carboxylic acid/ester groups and the cyclohexane, cycloheptane, 

naphthalene, phenanthrene, indene and fluorene rings have more than one unique free 

valence. The free valence that is to be used is marked with a gold Å (in the icon shown in the 

box at the top of the model kit). The marked position circulates among the possible positions 

with repeated clicking on the icon. Selection of an axial or equatorial free valence in 

cyclohexane and cycloheptane is indicated by the label ax or eq appearing alongside the 

icon. 

 

Acrylonitrile  

 

1. To bring up the organic model kit, click (left button) on the File menu and select 

(click on) New. Alternatively, click on    if it appears at the top of the screen.* 

Click on trigonal planar sp2 hybridized carbon               from the fragment library. 

 

 

 

* Icons are fully customizable from the Options menu > Preferences dialog > Icons tab. So whether or not a 

particular icon is displayed is at the discretion of the user. 
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A model of the fragment appears at the top of the model kit. Bring the cursor anywhere on 

screen and double click (left button). Rotate the carbon fragment (drag the mouse while 

holding down the left button) so that you can clearly see both the double free valence (=) 

and the two single free valences (ï). 

2. sp2 carbon is still selected. Click on the double free valence. The two fragments 

are connected by a double bond, leaving you with ethylene, meaning that ethylene 

is in the Spartan Spectra and Properties Database (SSPD). The name ethylene 

will appear at the bottom right of the screen. If you make a mistake and click 

instead on the single free valence, select Undo from the Edit menu (or click on 

 if it appears at the top of the screen). You can also start over by selecting 

Clear from the Edit menu (or click on  if it appears at the top of the screen). 

3. Click on the Groups button at the bottom of the model kit, click on the selection 

bar at the top of the model kit, and select Cyano from the groups available from 

the menu. Click on any of the four single free valences on ethylene (they are 

equivalent). This bonds the cyano group to ethylene, leaving you with 

acrylonitrile. Its name will appear at the bottom right of the screen. 

4. Click on  at the bottom of the model kit. (You can also select Minimize from 

the Build menu or click on  if the icon appears in the toolbar at the top of the 

screen.) The molecular mechanics energy (36.2 kJ/mol) and symmetry point 

group (Cs) are provided at the bottom right of the screen. 

5. Select View from the Build menu (or click on the  icon in the toolbar). The 

model kit disappears, leaving only a ball-and- spoke model of acrylonitrile on 
screen. The name appears at the bottom of the screen as acrylonitrile is also in the 
SSPD. 

 

 

 

 

 

ball-and-spoke model 
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This model can be rotated, translated and zoomed by using the mouse in conjunction with 

keyboard functions. To rotate the model, drag the mouse while holding down the left button; 

to rotate in the plane of the screen also hold down the Shift key. To translate the model, 

drag the mouse with the right button depressed. To zoom the model, use the center mouse 

wheel (scroll wheel) if available, or hold down the Shift key in addition to the right button 

while dragging the mouse up (zoom in) or down (zoom out). 
 

 

6. Close acrylonitrile (Close from the File menu or click on the  icon in the 

toolbar). 

Cyclohexanone 

 

1. Click on the File menu and select New Build from the palette or click on      at 

the top of the screen. Click on the Rings button near the bottom of the model kit, 

click on the selection bar and choose Cyclohexane from the menu of rings. 

Double-click anywhere on screen. 

2. Select sp2 carbon          from the model kit. Double click on  any carbon atom (not 

a free valence). The sp3 hybridized center will be replaced by an sp2 hybridized 

carbon. 

 

Rotate the molecule by moving one finger over the screen. 

Rotate the molecule in the plane of the screen by twisting 

two fingers. Translate by moving two fingers. Zoom by pinching 

two fingers. 

Fragment replacement is subject both to the usual valence rules 

and to the availability of free valences. For example, replacement 

of sp3 carbon by sp2 carbon requires that at least two free valences 

are available. 
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Select sp2 oxygen          from the model kit. Click on the double free valence on the sp2 

carbon. You have made cyclohexanone. Click on  at the bottom of the model kit to 

produce a structure with Cs symmetry. Click on . The name cyclohexanone appears at 

the bottom of the screen as the molecule is in SSPD. 

3. Close cyclohexanone. 

 

Limonene 

 

 

1. Select New from the File menu (or click on the     icon in the toolbar) to bring 

up the model kit. Click on the Rings button near the bottom of the model kit, 

click on the selection bar and choose Cyclohexane from the menu of rings. 

Double-click anywhere on screen. 

2. Click on the Groups button near the bottom of the model kit, click on the 

selection bar and choose the Alkenyl group. Click on the equatorial free valence 

on C4 (see figure above for numbering). You have made vinylcyclohexane. 

3. Click on the Make Bond icon ( ) at the bottom of the model kit. One after 

another click on the axial free valence on C1 and then the axial free valence on 

C2. You have made 4-ethenylcyclohex-1-ene. 

4. Select sp3 carbon               from the model kit and one after another click on the 

free valence on C1 and on the free valence of the vinylic carbon  attached to the 

ring. You have made limonene. The name will appear at the bottom of the screen 

as limonene is in SSPD. Click on  at the bottom of the model kit to give a 

refined geometry and finally click on ( ). 

5.   Close limonene. 
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Nicotine 

 

1. Select New from the File menu    . Click on the Rings button in the model kit. 

Click on selection bar at the top of the model kit and choose Benzene. Double-

click anywhere on screen. 

2. Click on the selection bar and choose Cyclopentane. Click on one of the free 

valences on benzene. You have made phenylcyclopentane. 

3. Click on the sp2 nitrogen in the model kit              and double click on the 

appropriate (meta) carbon (not a free valence) in the benzene ring. You have made 

3-cyclopentylpyridine. 

4. Click on sp3 nitrogen in the model kit                  and double click on the appropriate 

carbon in the cyclopentyl ring. You have made nornicotine. 

5. Click on sp3 carbon in the model kit               and click on the free valence on the 

nitrogen in the pyrrolidine ring. You have made nicotine. Click on  at the 

bottom of the model kit to clean up your structure. The name nicotine will appear 

at the bottom of the screen as the molecule is in SSPD. 

6. Select R/S Chirality from the Model menu ( ). The R/S chirality will be 

displayed. The S isomer is the naturally occurring isomer of nicotine. If you have 

built the R isomer and wish to invert the chiral center, hold down the Ctrl key on 

your keyboard and double-click on the chiral center. 

7. Close nicotine. 
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Coumarin 

 
 

1. Select New from the File menu     . Click on the Rings button in the model 

kit. Click on the selection bar at the top of the model kit and choose Benzene. 

Double-click anywhere on screen. 

2. Click on the Groups button, click on the selection bar and choose Alkenyl . 

Click on one of the free valences of benzene to make styrene. 

3. Click on the selection bar and choose Carboxylic Acid/Ester. A yellow dot 

should mark the free valence on carbon in the group shown in the window at 

the top of the model kit. If instead it marks the free valence on oxygen, click 

inside the window to move it. Click on the free valence on the methylene end 

of the vinyl group that is cis to benzene to make cis-cinnamic acid. 

4. It may be necessary to rotate around the bond marked A and B marked below 

to properly position the molecule for bonding. 

 

In turn, click on bonds A and B. A red arrow will curl around the bond and an 

icon  will appear at the top of a narrow shaded area at the far left of the 

screen. Click inside this area and move the mouse up and down. Position the 

bond such that the OH bond is near the phenyl ring as shown below. 
 

Move one finger up and down inside the area at the far left of 

the screen to rotate about the selected bond. 
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When you can clearly see the two free valences, click on  at the bottom of the 

model kit and, one after another, click on the two free valences. You have made 

coumarin, its name will appear at the bottom of the screen. 

 

5. Close coumarin. 
 

Spartan is able to fuse rings in 3D. This makes building molecules like 

coumarin much easier. To build coumarin using the fused-ring approach, 

select Benzene from the Rings menu double-click to insert benzene on 

screen. Select Cyclohexane from the Rings menu, double-click on one 

of the CC bonds in benzene to form benzocyclohexane. Choose sp3 

oxygen and double-click to replace C1 by oxygen (see numbering on 

previous page). Choose sp2 carbon and double-click on C2. Choose sp
2 

oxygen and add this to the double-bond on the sp2 carbon. Click 

on Make Bond (  ) and click on the open axial valences the sp3 ring 

carbons C3 and C4 to complete coumarin. 

Note, however, that fusing two rings with both bonds involving sp3-sp3 

hybridized centers, for example, two cyclohexane rings, can lead to one 

of two different results, in the case of two cyclohexane rings, either cis or 

trans-decalin. In this case, it may be necessary to invert the chirality of 

one of the resulting ring-fused carbons. This is accomplished by holding 

down on the Control (Ctrl) key (Command on Mac), positioning the 

cursor over the carbon and double clicking. 
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Chapter 4 
Sketching Organic Molecules in 2D 

 

The tutorials in this chapter introduce and illustrate tools to sketch organic molecules in 2D 

and then to convert them into realistic 3D structures. 

 

Not only are 2D sketches (ñdrawingsò) more familiar to most chemists than 3D structures, 

they are typically easier to produce especially for complex molecules that may incorporate 

fused rings or require stereochemistry to be defined. The advent of touch-screen computers 

makes the argument for sketching as an alternative to building even more compelling. 

Molecules that require several minutes to build in 3D can be drawn in seconds. The key is 

automatic and reliable conversion from 2D drawings to 3D structures and from 3D structures 

to 2D drawings. 

 

Sketch Palette 

The sketch palette contains tools for making and manipulating 2D drawings, including tools 

for adding cues to designate stereochemistry.* 

 

 

These include atoms that are most commonly found in organic molecules (H, B, C, N, O, F, 

Si, P, S, Cl, Br and I), the phenyl, cyclohexyl and cyclopentyl rings and the carbonyl, 

acid/ester and amide functional groups. The button immediately below H and B atoms 

allows for entering additional elements, functional groups, and ligands. The palette also 

contains stereochemical markers and charge/ radical markers. Complete details are found in 

Chapter 20. 

 
 

 

 

* A row of icons appears immediately above the sketch palette. These are intended to add arrows to designate 

reaction transition states and to append experimental NMR chemical shifts and observed HH and CH couplings 

to the sketch palette 
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Sketching a Molecule 

To start a sketch, first select (click on) an atom, group, ring or wildcard icon in the palette 

and then double click in the white portion of the screen (the drawing area). To draw a bond, 

first click on an atom, group, ring or wildcard icon in the palette to designate what is at the 

end of the bond, then position the cursor over the atom in the drawing area where you want 

the bond to start, move the cursor while holding down the left button (ñdragò the cursor) to 

the place in the drawing area where you want the bond to end and release the button. Multiple 

bonds are made by dragging over existing bonds.* 
 

 

 
 

 
 

Manipulating a Sketch 

To translate the sketch, move the mouse over the screen while holding down the right button. 

To rotate the sketch (in the plane of the screen), move the mouse up and down while holding 

down both the left button and Shift key. Use the scroll wheel to resize the sketch. 
 
 
 

 

 

*  With Spartanô26, and alternative way of drawing multiple bonds is simply to double click on a single bond. 

Double clicking (on a double bond) draws a triple bond and double clicking on a triple bond reverts to a single 

bond. The one exception is double clicking on a bond when a ring is selected in the palette as this signifies ring 

fusing. 

To make a bond touch the screen where you want it to start, move 

one finger to where you want it to end and lift. Replace position by 

touch, drag by move and release by lift in the diagram above. 
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N,N-Dimethylaniline 

                                                                   N 
 
 
 
 
 
 
 
 

1. Select New from the File menu (or click on     at the top of the screen) to 

bring up the sketch pad. Click on  in the palette and double click on screen. 

2. Click on  in the palette. Position the cursor over the ñtopò carbon on the 

benzene ring, drag it up and release. You have drawn aniline. 

3. Click on  in the palette. Position the cursor over the nitrogen, drag it up 

and to the left and release.  is still selected. Again position the cursor over 

the nitrogen, drag it up and to the right and release. 

4. Click on    in the palette to clean up your drawing and click on  to 

produce a 3D structure. The name N,N-dimethylaniline will appear at the 
bottom of the screen as the molecule is in SSPD. 

5. Close N,N-dimethylaniline. 
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trans-Stilbene 

 

 

1. Select New from the File menu     to bring up the sketch pad. Click on  in the 

palette. Position the cursor on the screen, drag it to the right and release. Position 
the cursor on one end of the line (CC bond) that you have just drawn, drag it to 
the other end and release. You have drawn ethylene. 

2. Click on . Position the cursor over the left end of the double bond, drag it 

down and to the left and release. You have drawn styrene. 

 

 

3.  is still selected. Position the cursor over the right end of the double bond, 

drag it up and to the right and release. You are done. 

4. Click on    to clean up your drawing. Click on  to convert it to a 3D structure. 

The name trans-stilbene will appear at the bottom of the screen as the molecule 
is in SSPD. 

5. Close trans-stilbene. 
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Indigo 

 

 

1. Select New Sketch from the File menu     . Click on  and double click on screen. 

2.  is still selected. Position the cursor over C2 (see numbering in diagram above), 

drag it to the right and release it. Your sketch should appear as below. 

 

3. Select  from the palette. Position the cursor above C3, drag it away from the ring 

and release. Again position the cursor above C3, drag it along the CO bond to the 

oxygen and release it. Alternatively, double click on the CO bond that you have just 

made to turn it into a double bond. Repeat for C3'. You are left with a drawing. 

                                                                                                                                                                 

4.       Select  from the palette and one after another double click on C1 and C1'. 

   

5. Select  from the palette. Position the cursor above C2, drag it to C2' and release. 

Alternatively, double click on the C2-C2ô bond. 

6. Select  from the palette and double click on the bond connecting C3a and C7a.
* 

Repeat for C3a' and C7a'. 

7. Click on    to clean up your drawing and click on  to turn it into a 3D structure. 

The name indigo will appear at the bottom of the screen as the molecule is in SSPD. 
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8. Close indigo. 

 

3-Cyano-4-methylcyclohexenyl Radical 

 

 

This tutorial shows you how to use a wildcard to specify a functional group and how to 

designate a radical site. 

1. Select New from the File menu     . Click on  in the palette and double click 

on screen. 

2. Click on  in the palette. Position the cursor over C4 (see diagram above for 

numbering), drag it up and to the right and release. You have drawn 
methylcyclohexane. 

3.  is still selected. Position the cursor over C1, drag to C2 and release. 

Alternatively double click on the C1-C2 bond. You have drawn 4-

methylcyclohexene. 

4. Double-click on the wildcard icon that is located immediately below H and B in 

the palette. Click on the Groups tab and click on CN. CN now appears as the 

wildcard icon. Position the cursor over C3 and drag it away from the ring and 

release. You have drawn 3-cyano-4-methylcyclohexene. 

5. One of the following icons will appear in the palette directly below the sulfur 

icon.  If it is not the radical marker, click to adjust:                  

 

 

6. With the radical marker selected, double-click to modify center. 

7. Click on   to clean up your drawing and click on  to make a 3D structure. 

8. Close 3-cyano-4-methylcyclohexenyl radical. 

 

*  This is the exception referred to earlier regarding double clicking on a bond to change it 

from single to double (or double to triple). 

Androsterone 
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The steroid androsterone is typical example of a molecule that is difficult to build (3D) but 

quite easy to sketch (2D). 

1. Select New from the File menu     to bring up the sketch pad. Click on  and double 

click on screen. Cyclohexane is still selected. Double click on the C5-C10 bond (see 
diagram above). 

 

 

2. Cyclohexane is still selected. Double click on the C8-C9 bond. 

 

 

3. Click on  and double click on the C13-C14 bond. You have now drawn the complete 

steroid skeleton. 
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4. It is necessary to explicitly specify hydrogens at C5, C8, C9 and C14 in order to 

incorporate the necessary stereochemical cues (up and down ñwedgesò) in your 

drawing. Click on , position the cursor over C5, drag away from the ring and 

release. Repeat for C8, C9 and C14. 

5. Click on , position the cursor over C10, drag up and release it. Repeat for C13. 

6. Click on . Position the cursor over C3, drag down and to the left and release. 

7.  is still selected. Position the cursor over C17, drag up and to the right and release. 

Convert the single (CO) bond at C17 to a double bond. Again position the cursor over 

C17, drag along the bond to oxygen and release. Alternatively, double click on the CO 

single bond to turn it into a double bond. Your structure should now look as follows. 

8. Click on . Position the cursor over C10, drag along the bond to the methyl group 

that you drew in step 5 and release. Repeat for C13. Position the cursor over C8, drag 

along the CH bond that you drew in step 4 and release. Up wedges will appear for all 

three centers. 

9. Click on . Position the cursor over C3, drag along the CO bond that you made in 

step 6 and release. Position the cursor over C5, drag along the CH bond that you made 

in step 4 and release. Repeat for the CH bonds at C9 and C14. Down wedges will appear 

for all four centers. 

 

 

Spartanô26 offers an alternative way to specify stereochemistry. Replace 

steps 4-6 and 8-9 by steps A-D. 

A.Click on   in the sketch palette. Click on       , note    remains 

selected, position the cursor over C8, drag up and release. 

B.Click on  .   remains selected. One after the other, position 

the cursor over C5, C8, and C14, drag down and release. 

C.Click on   and then on    . One after the other, position the cursor 

over C10, and C13, drag down and release. 

D.Click on   and then on    . Position the cursor over C3, drag 

down and to the left and release. 
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10. Click on    to clean up your drawing. Click on . The name androsterone should 

appear at the bottom right of the screen as the molecule is in SSPD. If it does not, you 

have made an error somewhere. Select Edit Sketch from the Build menu or click on 

 if it appears at the top of the screen to return to the sketch pad. 

11. Androsterone incorporates seven chiral centers. To view the R/S assignment, click on 

the R/S Chirality entry in the Model menu . R/S labels will appear next to each 

of the chiral centers. 

12. Close androsterone. 
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Chapter 5 
Spectra and Properties of 

Organic Molecules from SSPD 
 

The tutorials in this and the two chapters that follow involve the molecules that you built or 

sketched in the preceding two chapters. The emphasis shifts from providing input structures, 

to analyzing the results of quantum chemical calculations (in this and the following chapter) 

to actually doing calculations (in the final chapter in this section). 

 

The Spartan Spectra and Properties Database (SSPD) provides atomic and molecular 

properties and IR, thermodynamic properties, and NMR spectra for >300,000 molecules, 

calculated using the ɤB97X-D/6-31G* density functional model. In addition, the collection 

contains more than 2,000 transition-metal organometallics and organolanthanides.  

 
13C Spectrum of Limonene 

1. Build limonene     , minimize       and exit the builder       . Alternatively, sketch 

limonene         and exit the sketcher        . 

2. Click on the name limonene at the bottom of the screen. Make sure that wB97X-D/6-

31G* is selected from the dialog that appears and click on Replace. Properties and 

spectra for limonene are now available. 

3. Select Spectra from the Display menu or click on  at the top of the screen. Click 

on  at the top of the spectra pane, exposing a tabbed dialog with available calculated 

spectra (in red) and (possibly) available experimental spectra (in blue). 
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4. Select  from the NMR tab. The calculated 13C NMR spectrum appears in the 

spectra pane. There are ten lines corresponding to ten unique carbons in limonene. Up 

and down triangles demark a moveable cursor. Click on either (or on the dotted line 

connecting them) to select and with the left mouse button (or your finger), move 

horizontally over the spectrum. When you intersect an NMR resonance, it will be 

highlighted in the spectrum, the value of the chemical shift indicated, and the carbon 

(or carbons) in the structure responsible will be highlighted in the structure model (on 

the main screen).  

5. Again, click on        at the top of the spectra pane, but this time, select                . The 

experimental 13C spectrum of limonene will be superimposed on top of the calculated 

spectrum.* Visual comparison will give you an idea of the quality you can expect from 

NMR calculations. To get an even better idea, shift the range of the scale (initially 

from 150 to 0 ppm), move the cursor over the spectrum and zoom in with the center 

mouse wheel. Return to the original setting by clicking on         in the bar at the top of 

the screen 
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Move one finger over the spectrum to select a line. Move two 

fingers over the spectrum to shift the range of the scale and 

pinch two fingers to zoom in and out. 

 
 

 

 

 

 

6. Close limonene. 
 

Proton Spectrum of Indigo 

 

1. Build indigo     , minimize        and exit the builder       .   

Alternatively, sketch indigo       and exit the sketcher       . 

2. Click on the name indigo at the bottom of the screen. Click on Replace. Properties and 

spectra for indigo are now available. If the name does not appear, then you have made 

an error. In this case, re-enter either the builder by selecting Edit Build from the Build 

menu , or the sketch pad by selecting Edit Sketch from the Build menu  and 

correct your model. 

 

3. The calculated proton NMR spectrum of indigo can be displayed in two ways. The 

simpler ñidealizedò presentation assumes that three-bond HH coupling constants are 

zero. Select Spectra from the Display menu  to bring up the spectra pane and click 

on  in the bar at the top to show available calculated spectra (in red) and possibly 

available experimental spectra (in blue). Select  from the palette. The 

spectrum that results shows only lines corresponding to the five unique hydrogens. To 

see a ñfamiliarò proton spectrum, click again on , but this time select . 

The same four lines appear, but all are split (as in an experimental proton spectrum). 

The lines at 6.72 and7.88 ppm are doublets due to C7 and C4, respectively (and split 

by C6 and C5, respectively). The lines centering at 6.89 and 7.44 are quartets (doublet 

of doublets), due to C5 and C6, respectively (and split by C4 and C6 and C5 and C7, 

respectively). 

4. Close indigo. 
 

 

 

 

 

 

 

 

 

 

*  The experimental spectrum comes from the NMRShiftDB. Requires on-line access, source subject to 

availability. 
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Infrared Spectrum of trans-Stilbene 

 

1. Build trans-stilbene     , minimize  and exit the builder . Alternatively, sketch 

trans-stilbene       and exit the sketcher . 

2. Click on the name trans-stilbene at the bottom of the screen and then on Replace. 

3. Select Spectra from the Display menu . Click on      in the bar at the top of the 

spectra pane and select                  . The calculated IR spectrum of trans-stilbene 
appears in the spectra pane.  

4. As with NMR spectra, up and down triangles demark a moveable cursor. Select and 

move it horizontally over the spectrum. You will see that as you intersect a line in the 

spectrum, it will turn yellow and the value of the frequency will appear at the bottom. 

In addition, the molecular model ñvibratesò to reflect the motion that the molecule 

undergoes. Examine the motions of one or more lines of moderate intensity in the 

vicinity of 1500 cm-1 (at 1446, 1494 and 1609 cm-1). You might find it useful to 

expand the scale (use the scroll wheel) or to shift it (move the mouse horizontally 

over the spectrum while holding down the left button). You can return to the original 

settings by clicking on          in the bar at the top of the pane. 

5. Click on      from the bar at the top of the spectra pane and then            .The 

experimental IR spectrum of trans-stilbene obtained from the freely-available NIST 

database will be superimposed onto the calculated spectrum. You will need to be 

online. Note that the two spectra are similar although the experimental spectrum 

exhibits a number of (small) lines not found in the calculated spectrum. 
 

6. Close trans-stilbene. 

To see lists of the 3N-6 calculated IR frequencies as well as the (Ò 

3N-6) frequencies assigned to the experimental spectrum together 

with intensities relative to their respective most intense frequency, 

click on   at the left of the spectra dialog. Checking individual 

lines (in the calculated IR) moves the cursor on the spectrum and 

animates the vibrational motion. 
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Chapter 6 
Graphical Models for Organic 

Molecules from the Spartan Spectra 

and Properties Database 
 

The tutorials in this chapter illustrate two of the most commonly-used graphical models, the 

electrostatic potential map for elucidating molecular charge distributions, and the local 

ionization potential and LUMO maps for anticipating electrophilic and nucleophilic 

reactivity, respectively. 

 

Entries in the Spartan Spectra and Properties Database (SSPD) not only include the 

molecular structure, energy, properties and spectra, but also the wave function. This allows 

graphical models to be requested and displayed ñon-the-flyò. You will use the SSPD entries 

obtained from the ɤB97X-D/6-31G* model, rather than calculated results for the required 

data to complete this chapter. 

Electrostatic Potential Map for Nicotine 
 

 
1. Build nicotine (File menu > New), minimize the structure (Build menu), and return to 3D 

view. Alternately, sketch nicotine from the 2D view and return to 3D. 
 

2. Click on the name nicotine at the bottom right of the interface. Click on Replace. The 

previous structure will be replaced with the entry from the SSPD (including the wave 

function). 
 

Note: If you see the name 3-[(2R)-1-methylpyrrolidin-2-yl]pyridine, instead, go ahead and 

click replace (you will note in the SSPD preview, next to the model, you also see the word 

[Enantiomer]. This indicates that you have built 3-[(2R)-1-methylpyrrolidin-2-yl]pyridine, 

but what exists in the SSPD is this moleculeôs enantiomer, replacing will also result in access 

to precalculated data for nicotine. 
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3. Select Surfaces from the Display menu or click on  if it appears at the top of the 

screen. Click on Add (at the bottom of the Surfaces dialog that results) and select 

electrostatic potential map from the menu. This requests an electrostatic potential map (an 

electron density surface onto which the value of the electrostatic potential is color mapped). 

The line electrostatic potential map appears at the top of the dialog. 

The graphics calculation will run automatically following your request.* When it completes 

in a few seconds, check the box to the left of electrostatic potential map in the Surfaces 

dialog. The surface itself corresponds to the electron density and provides a measure of the 

overall size and shape of nicotine. The colors indicate values of the electrostatic potential 

on this surface.  

By convention, colors toward red correspond to negative potential (stabilizing interaction 

between the molecule and a positive charge), while colors toward blue correspond to 

positive potential. The two nitrogen atoms show the largest negative potential (red). You 

will see that the nitrogen in the pyridine ring is more negative than the nitrogen in the 

pyrrolidine ring. 

4. Quantify your observation. Select Properties from the Display menu or click on  if it 

appears at the top of the screen and click anywhere on the electrostatic potential map to bring 

up the Surface Properties dialog. 

 

 
 
 

 
 

 

* If they do not complete automatically, check the box to the left of Auto-Gen Graphics under the Miscellaneous 

section in the Settings tab in the Preferences dialog from the Options menu (Chapter 25)é 

 



Chapter 6 93  

Check the box to the left of Display Legend towards the bottom right of the dialog to display 

the property range on screen. To translate the legend, click on the legend to select, then hold 

down the right mouse button and move the mouse. The legend is useful when making 

qualitative comparisons of property values. Turn the map such that you can clearly see the 

pyridine nitrogen and click on the area that is most red. An arrow marks the point on the 

surface, and the value of the potential is shown to the right of the legend. Do the same for 

the pyrrolidine nitrogen. 
 

 

5. Nicotine is relatively small and it is easy to associate regions on the map with the 

underlying molecular skeleton. This becomes more difficult with increasing molecular size. 

Change the presentation from the Style menu located inside the Surface Properties dialog 

or at the bottom right of the screen. Select Transparent or Mesh. You now can ñsee 

throughò the map to the underlying molecular structure. 

6. Close nicotine and any open dialogs. 

 
  

Tap on the legend to select. Move two fingers to move it 

around the screen. Pinch two fingers to make the legend 

smaller or larger. 
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Local Ionization Potential Map for N,N-Dimethylaniline 
 

 

 
 

1. Build or sketch N,N-dimethylaniline and click on . 

2. Click on N,N-dimethylaniline at the bottom of the screen. Click on Replace. Your 

structure will be replaced by that in SSPD. 

3. Select Surfaces from the Display menu . Click on Add at the bottom of the 

Surfaces dialog that results and select local ionization potential map from the menu. 

This requests a map showing the energy required to remove an electron (the ñionization 

potentialò) as a function of its location on the electron density surface. Calculation will 

only take a few seconds. When completed, check the box to the left of local ionization 

potential map in the Surfaces dialog. The color convention is the same as for the 

electrostatic potential map, although the scale is completely different. Local ionization 

potentials are always positive. The default scale (5 to 15 eV) can be changed to highlight 

the differences. Select Properties from the Display menu  and click on the local 

ionization potential map. Change ñ5ò at the left below Property Range to ñ10ò and 
close the dialog. Colors toward red correspond to small ionization potentials (greatest 

electrophilic reactivity) and colors toward blue correspond to large ionization 

potentials. Note that the red regions on the map are over the ortho and para ring 

positions. This is exactly what is experimentally observed. 

4. Close N,N-dimethylaniline and any open dialogs. 
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LUMO Map for Androsterone  

 

 

1. Sketch androsterone 
      

and exit the sketcher . 

2. Click on the name androsterone at the bottom right of the screen. If the (correct) name 

is not provided, then you have made a mistake. In this case, re-enter the builder by 

selecting Edit Sketch from the Build menu , and make any necessary changes. 

Click on Replace to replace your structure by that in the SSPD. 

3. Select Orbital Energies from the Display menu or click on  if it appears at the 

top of the screen. An orbital energy diagram will appear at the left of the screen. To 

examine the molecular orbital corresponding to a line in the diagram, click on the line. 

You will see that the LUMO is a ˊ* orbital localized on the carbonyl group, although 

it is not at all clear whether it is more or less concentrated on the face away from the 

two methyl groups. This subtle distinction might be important, for it would be 

expected that nucleophilic addition would occur from the face on which the LUMO 

is more concentrated. A |LUMO| map provides a much clearer picture. 

4. Select Surfaces from the Display menu . Click on Add and select |LUMO| map 

from the menu. The graphics calculation will require only a few seconds. When 

completed, check the box to the left of |LUMO| map inside the Surfaces dialog. The 

largest (absolute) values of the LUMO are colored blue. Rotate to examine both the 

faces (with and without the two methyl groups). From the |LUMO| map you can 

clearly see that the LUMO is more concentrated on the face away from the methyl 

groups. 
 

 
5. Close androsterone and any open dialogs.

In this example, the LUMO corresponds to the expected ́* orbital 

primarily localized on the carbonyl bond. This may not always be 

the case, and it may be necessary to look at higher-energy unoccupied 

molecular orbitals, LUMO-1, LUMO-2, etc. Spartan allows any 

orbital to be superimposed on the electron density surface. 
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Chapter 7 
Spectra, Properties and  

Graphical Models from Quantum  

Chemical Calculations 
 

The tutorials in this chapter provide the earliest and simplest examples of specifying and 

performing quantum chemical calculations. As in the previous two chapters, they refer to 

molecules examined in Chapters 3 and 4. Calculations are performed utilizing the wB97X-

D/6- 31G* model, and time estimates are based on this model using a quad-core desktop 

machine (3 GHz Intel I7 processor, 16 GB RAM, 800 GB solid state drive) running in 

parallel under Windows 10 Pro. Alternate computational models can be used in place of 

wB97X-D/6-31G*. Completion times will vary accordingly. 

 

Acrylonitrile  
 

 
We return to acrylonitrile for the first tutorial that actually involves 

quantum chemical calculations. 

1. Build or sketch acrylonitrile. 

2. Select Calculations... from the Setup menu or click on  if it appears at the top of 

the screen and perform the following operations in the Calculations dialog that appears. 

5 min 
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5. Select Equilibrium Geometry from the top menu to the right of Calculate. This 

specifies optimization of equilibrium geometry. At Ground state in Gas will appear 

in the menus to the right of Equilibrium Geometry . 

6. Select Density Functional, wB97X-D and 6-31G* from the three bottom menus to 

the right of with . This specifies that the wB97X-D/6-31G* density functional model 

will be used for this calculation. 

7. Click on Submit at the bottom of the dialog. A file browser appears. 

 

 

Because the molecule is in SSPD (even though we will not use the data), the name 

acrylonitrile is presented in the box to the right of File name.  

 

Either use it or type in whatever name you like and then click on Save. You will be notified 

that the calculation has been submitted (is running). 
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Click on OK to remove the message from the screen. 

 

 

8. You will be notified when the calculation has completed. 

 

Click on OK to remove the message from the screen. Select Output from the Display menu 

or click on  if it appears at the top of the screen. Displayed initially is a brief summary 

(Summary tab, describing the task and providing the molecule name and molecular formula 

together with the total charge (if not neutral) and number of unpaired electrons (if not 0), 

the calculation model (method and basis set) and the energy. 

 

 
 

The summary may be all that you really want (or need) but more detailed information can 

be obtained by selecting Output from the menu at the top of the dialog. 

 

After a molecule has been submitted, and until the calculation has 

completed, you will not be permitted to modify any dialogs or 

other information associated with molecules in the document. 
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You can scan the output from the calculation by using the scroll bar at the right of the 

window or by clicking (left button) inside the output window and using the scroll wheel on 

your mouse. Information at the top of the dialog is similar to that reported in the summary, 

although additional details are provided. Eventually, a series of lines appear, under the 

heading Optimization. These tell the history of the optimization process. Each line (or Step) 

provides results for a particular geometry. Ideally, the energy will monotonically approach 

a minimum value for an optimized geometry. If the geometry was not optimized 

satisfactorily, an error message, such as: OPTIMIZATION has exceeded N steps, (or 

similar) will be displayed following the last optimization cycle. Optimization failure is not 

common, so if it occurs, check to see if you have correctly built the structure. 

Near the end of the output is the final total energy* (-170.76462 atomic units for acrylonitrile 

if you used the  ̟B97X-D/6-31G* model)** , and the computation time. Click on     at the 

top of the output dialog to close it. 

You may examine the total energy and dipole moment among other calculated properties 

without having to go through the output. Select Properties from the Display menu to bring 

up the Molecule Properties dialog (make certain that the Molecule tab and not the QSAR, 

Thermodynamics, ȹHf, NMR, Estimates or Utilities tab is selected). 

 

 

 

*  See Calculations... (Setup menu; Chapter 21) for a discussion of how total energy relates to heat of 

formation and strain energy. 

**    The number you actually get will likely differ in the last decimal place due to machine precision. 
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To see the dipole moment vector (indicating the sign and direction of the dipole moment), 

check the box to the left of Display Dipole Vector. Wire, ball-and-wire or tube models are 

best for this display. 

 

Uncheck the box to remove the dipole moment vector. 

Click on an atom. The (Molecule Properties) dialog will be replaced by the Atom 

Properties dialog. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Among other things, this provides three different sets of atomic charges: Electrostatic, 

Mulliken and Natural . To obtain the charge on another atom, simply click on it. Inspect all 

the atomic charges on acrylonitrile (by clicking on the appropriate atoms). When you are 

finished, click on        at the top of the Atom Properties dialog to close it. 
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Select Surfaces from the Display menu . Click on Add at the bottom of the Surfaces 

dialog that results and select electrostatic potential map from the menu. This requests an 

electrostatic potential map (an electron density surface on which the value of the electrostatic 

potential is mapped). The graphics calculation will run without needing to resubmit the job. 

When it completes in a few seconds, check the box to the left of electrostatic potential map 

in the Surfaces dialog. The surface itself corresponds to the electron density and provides a 

measure of the overall size and shape of acrylonitrile. The colors indicate values of the 

electrostatic potential on this surface; by convention, colors toward red correspond to 

negative potential (stabilizing interaction between the molecule and a positive charge), while 

colors toward blue correspond to positive potential. The nitrogen (the most electronegative 

atom) is red; the hydrogens (the most electropositive atoms) are blue. 

9. Close acrylonitrile and any open dialogs. 
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Cyclohexanone 

 

This tutorial offers another example of running quantum chemical calculation on a very 

simple molecule. It also provides an opportunity to further illustrate graphical models for 

elucidating the stereochemistry of organic reactions. 

1. Build or sketch cyclohexanone. 

2. Select Calculations... from the Setup menu . Specify Equilibrium Geometry , 

Ground and Gas from the top menus to the right of Calculate, and Density Functional, 

ɤB97X-D  and 6-31G* from the menus specifying computational model. Click on 

Submit and accept the name cyclohexanone. Wait until the calculation completes before 

proceeding to the next step. 

3. Cyclohexanone undergoes nucleophilic attack at the carbonyl carbon, and it is reasonable 

to expect that the moleculeôs lowest-unoccupied molecular orbital (the LUMO) will be 

localized here. To visualize the LUMO, bring up the Surfaces dialog (Surfaces from the 

Display menu or click on . Click on Add and select LUMO from the menu. Also 

request an electron density surface onto which the (absolute) value of the LUMO has 

been mapped in color (a so-called LUMO map). Click on Add and select |LUMO| map 

from the menu. The two graphics calculations will run automatically and will require only 

a few seconds. 

4. Check the box to the left of LUMO in the Surfaces dialog. You will see that the resulting 

graphic is a ˊ* orbital primarily localized on the carbonyl group, consistent with the fact 

that nucleophiles (electron pairs) add to the carbonyl carbon. See if you can tell which 

face of the carbonyl carbon the LUMO is more concentrated on. 

5. Uncheck the box to the left of LUMO in the Surfaces dialog (to turn off the display of 

the LUMO). Then check the box to the left of |LUMO| map to display the electron 

density surface onto which the (absolute) value of the LUMO has been mapped. By 

convention, colors toward red indicate small (absolute) values of the LUMO (near 

zero), while colors toward blue indicate large (absolute) values of the LUMO. We are 

looking for a ñblue spotò. Note that it is directly over the carbonyl carbon. This 

corresponds to the maximum value of the LUMO and is where nucleophilic attack will 

occur. 

6. You will see that the blue spot over the axial face of the carbonyl carbon is bigger (and 

bluer) than that over the equatorial face. This indicates preferential attack by 

nucleophiles onto the axial face. Quantify the difference by measuring the (absolute) 

5 min 
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value of the LUMO on the two faces. Select Properties from the Display menu  and 

click anywhere on the LUMO map surface to bring up the Surface Properties dialog. 

 

             
 

Check the box to the left of Display Legend to display the property range on screen. The 

legend is useful when making qualitative comparisons of property values. Turn the map such 

that you can clearly see the axial face of the carbonyl carbon and click on the area of 

maximum blue. The (absolute) value of the LUMO at the surface point you have selected is 

provided in the dialog to the right of Val. Note the value and then turn the map over such 

that you can see the equatorial face of the carbonyl carbon and click on the region of 

maximum blue on this face. You will find that they support your qualitative conclusions 

from viewing the image. 

7. Close cyclohexanone and any open dialogs. 
 

  

5 min 
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3-Cyano-4-methylcyclohexenyl Radical 

 

 

3-cyano-4-methylcyclohexene radical will be used to introduce graphical models associated 

with radicals (molecules with one unpaired electron). 

1. Build or sketch 3-cyano-4-methylcyclohexenyl radical. 

2. Select Calculations... from the Setup menu . Specify Equilibrium Geometry at 

Ground state in Gas from the top menu to the right of Calculate, Density Functional 

and wB97X-D and 6-31G* and from the menus specifying computational model. 

This molecule has one unpaired electron. Change Unpaired Electrons from 0 to 1. Click on 

Submit at the bottom of the Calculations dialog.* Name it 3-cyano-4-methylcyclohexenyl 

radical. (A name will not be provided as the radical is not in the SSPD.** ) Wait (a few 

minutes) for the calculation to complete before proceeding. 

3. Select Surfaces from the Display menu . Click on Add and select spin density 

from the menu. Click on Add and select spin density map from the menu. You have 

requested two different representations of spin distribution. The first presents spin 

density as a surface of constant value, while the second uses color to map the value of 

the spin density onto an electron density surface. Finally, request the singly-occupied 

molecular orbital. Click on Add one more time and select aHOMO (the highest-

occupied molecular orbital of a spin that is, the orbital that contains the unpaired 

electron) from the menu. 

4. The three graphics you requested will run without having to resubmit the job and will 

require only a few seconds to complete. When they are done, check the box to the left 

of spin density in the Surfaces dialog to display the spin density surface. Note that the 

spin density is delocalized over two of the ring carbons and onto the cyano group. 
 

 

 
 

*  Spartan checks that the structure and the number of electrons specified from Charge and 

Unpaired Electrons settings are compatible and if they are not will return an error message. 

**  With very few exceptions, SSPD contains only neutral closed-shell (paired-electron) 

molecules. 
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5. Remove the spin density surface (uncheck the box to the left of spin density in the 

Surfaces dialog) and then check the box to the left of spin density map to display a 

surface on which the spin density is mapped onto the electron density. Note that the 

areas of maximum spin (colored blue) closely match those where the surface is large 

in the previous image. 

6. Remove the spin density map (uncheck the box to the left of spin density map), and 

then check the box to the left of aHOMO (the molecular orbital which holds the 

unpaired electron). Aside from the colors (different signs of the orbital), note that this 

graphic is nearly identical to the previously-displayed image of the spin. 

7. Uncheck the box to the left of aHOMO. Click on More Surfaces... at the bottom of 

the (Surfaces) dialog, and select Slice from the Surfaces menu and spin density from 

the Properties menu. Click on OK . A new line Slice, spin density appears in the 

window at the top of the dialog.* Select it by checking the box at the left. A plane (a 

slice of spin density) surrounded by a frame appears in the middle of the model on 

screen. Click inside the frame to select. The frame will turn gold. Position the cursor 

outside the frame, then use the scroll wheel to zoom the plane. You can also translate 

and rotate the plane independently of the molecule using the usual mouse operations. 

Alternatively, you can move the molecule and plane together by first clicking on the 

molecule (the frame will now turn white) and then using the mouse. For all operations, 

be certain to keep the cursor positioned outside of the frame. Size and orient the slice 

as you wish. 
 

 

 

 

8. Close 3-cyano-4-methylcyclohexenyl radical and any open dialogs. 
 

*  You can change the display style from Contours to Solid or Transparent using the Style 

menu at the bottom right of the screen. This will appear only when the slice is selected. 
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Coumarin 

 

 

Coumarin illustrates the calculation of a UV/visible spectrum. 

1. Build or sketch coumarin. 

2. The name coumarin appears at the bottom of the screen. Click on it, make sure that 

wB97X-D/6-31G* is selected from the dialog that appears and click on Replace. 

3. Select Calculations... from the Setup menu . Select Energy from the top menu to the 

right of Calculate. (Density Functional, wB97X-D and 6-31G* should already be 

selected from three menus immediately below.) You already have the equilibrium 

structure from SSPD and only need to obtain the energy and wave function as the basis 

of a UV/visible spectrum calculation. Check the box to the left of UV/vis (to the right of 

Compute). Click on Submit. Accept the name coumarin. 

4. The calculation will take several minutes. While coumarin is relatively small, calculations 

on several low-lying excited states in addition to the ground state are required to produce 

a UV/visible spectrum. When completed, select Spectra from the Display menu     . 

Click on  inside the spectra pane and select               . The calculated UV/visible 

spectrum will appear in the spectra pane. 

 

5. Click again on  and this time select . The experimental UV/visible spectrum 

from the freely available NIST database will be superimposed onto the calculated 

spectrum. 

 

5 min 
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6. Close coumarin. 
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Section IV 
Advanced Tutorials 
 

The tutorials in the chapters in this section build upon and extend those in the previous 

section. Groups of Organic Molecules introduces spreadsheets, associated statistics, and 

plot capabilities. Spectra of Organic Molecules provides ñrealò examples of calculated IR 

and NMR Spectra. Inorganic and Organometallic Molecules illustrates applications to 

ñnon-organicò molecules, in particular, molecules incorporating transition metals. Organic 

Reactions describes and illustrates strategies for finding and verifying a reaction transition 

state. Medicinal Chemistry illustrates examples of interactions of small molecules (drugs) 

in biological systems. Flexible Molecules addresses issues involved in identifying the 

lowest-energy conformer of a flexible molecule and in establishing the relative energies of 

alternative (higher-energy) conformers, the latter being necessary to ñaverageò properties 

and spectra. Some of the tutorials in this section require significant computation time, in 

particular, those involving quantum chemical methods applied to flexible molecules. With 

this in mind, a number of tutorials have been provided in the last chapter ñDry Labsò. Using 

the Spartan Spectra and Properties Database to further illustrate a variety of important 

features without having to consume computer time (or your time waiting for the calculations 

to finish). 

Quantum chemical calculations utilize the wB97X-D/6-31G* model. Time estimates are 

given for completion of the tutorials based on this model using 24-core laptop (5.4 GHz Intel 

i9 processor, 32 GB RAM, 2 TB solid state drive) running in parallel under Windows 11. 

Other computational models can be used in place of wB97X-D/6-31G*. Completion times 

will vary accordingly. 

Icons are provided for all menu entries as they are requested. Icon displays may be 

customized according to user preference (Icons tab under Preferences in the Options menu; 

Chapter 25). 
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Chapter 8 
Groups of Organic Molecules 

 

The tutorials in this chapter introduce and illustrate a number of basic operations involved 

in processing groups of molecules, as well as the associated spreadsheet for organizing and 

fitting data and facilities for making plots. 

Computational investigations, like experimental investigations, are rarely restricted to a 

single molecule, but typically involve a series of related molecules. Here, it may be of 

interest to compare geometries, energies or other calculated properties, or to compare trends 

in calculated and measured properties. Spartan provides facilities for these purposes. In 

particular, it allows molecules to be grouped, either manually, or automatically as a result 

of a conformational search, from following a particular vibrational motion, or from a scan 

of one or more geometric variables. Once grouped, molecules may be aligned to make 

similarities or differences more apparent based either on their structure, chemical 

functionality or atom labels. Calculations may be performed either on individual molecules 

or, just as simply, on the complete group of molecules. On multi-core computers, several 

molecules can be run at once. The results of calculations on a group can be examined and 

analyzed individually or altogether to seek out trends. In particular, reaction and activation 

energies may be obtained and statistical measures, among them the DP4 measure, may be 

applied to calculated NMR spectra. 

Associated with a group of molecules (or an individual molecule) is a spreadsheet. This 

allows convenient access to virtually any calculated quantity that can be given a numerical 

value. Additionally, data may be entered manually into the spreadsheet or transferred from 

another application such as Excel. Data in the spreadsheet may be manipulated, linear 

regression analyses performed and plots displayed. Alternately, the data in a Spartan 

spreadsheet may be transferred to Excel (or other applications) for further analysis. An Excel 

worksheet can be 

stored inside a Spartan document if desired (see Embedded Data 

under the File menu; Chapter 16). 

The tutorials in this chapter introduce and illustrate a number of the basic group operations 

available in Spartan. These include building a group from scratch and processing groups 

resulting from both a conformational search and from systematically varying a torsion angle. 

Also provided is an example of fitting an experimental observable to one or more calculated 

properties by way of linear regression. Finally, Reactions dialog is illustrated both as it 

operates on molecules in a group and on molecules derived from substitution of grouped 

molecules. 
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Dienophiles in Diels-Alder Cycloadditions 

 

The most common Diels-Alder reactions involve electron-rich dienes and electron-deficient 

dienophiles. 

 

 
The rate of these reactions generally increases with increasing -̄donor ability of the diene 

substituent, and with increasing ̄ -acceptor ability of the dienophile substituent. This can be 

rationalized by noting that donor groups raise the energy of the highest-occupied molecular 

orbital (the HOMO) on the diene, while acceptor groups lower the energy of the lowest-

unoccupied molecular orbital (the LUMO) on the dienophile. Thus, the HOMO-LUMO gap 

is reduced, leading to increased interaction of diene and dienophile and enhanced reactivity. 

 

 
 

 

To test this hypothesis, you will examine whether or not experimental relative rates of Diels-

Alder cycloadditions involving cyclopentadiene and a variety of cyanoethylenes correlate 

with dienophile LUMO energies. 

20 mins 
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1. Build    and minimize  acrylonitrile, H2C=C(H)CN. Select View from the Build 

menu . Copy the structure to the clipboard. Either right click on the background 

and choose Copy from the resulting contextual menu or select Copy from the Edit 

menu . 

2. Select New Molecule (not New) from the File menu    . This allows for adding an 

additional molecule to the current document. The screen will be cleared and the model 

kit displayed. Click on Clipboard at the bottom of the model kit and click on screen. 

Acrylonitrile will appear. Click on Groups in the model kit, select Cyano and add to 

the appropriate free valence on acrylonitrile to make 1,1-dicyanoethylene. Click on 

. 

3. Repeat this procedure (Build New Molecule, followed by Clipboard , followed by 

Groups, followed by  four more times to build cis and trans-1,2-dicyanoethylene, 

tricyanoethylene and tetracyanoethylene. When you have built all six molecules, click 

on        . 

 

4. The molecules have been grouped together, that is, put into a single document, 

allowing calculated properties to be accessed via a spreadsheet. Select Spreadsheet 

from the Display menu. 

 
 

To select an individual molecule in the group, click on its label (M0001, ...) in the left-hand 

column, or use the ƹ and Ʒkeys at the bottom left of the screen. Left-click on the header 

cell (ñLabelò) to select the entire group, then right-click and select Rename Selected Using 

SSPD from the contextual menu that results. 

 

The 2D sketcher could be used in place of the 3D builder. Sketch 

acrylonitrile, right click on screen and select Copy from the menu 

that appears. Select Sketch New Molecule (not New Sketch) from 

the File menu, right click on screen and select Paste from the menu. 

Add a cyano group to make 1,1-dicyanoethylene. Repeat the 

sequence to make the remaining molecules and finally click on       . 
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This results in replacement of the default labels by proper names from the Spartan Spectra 

and Properties Database. 

 

 

5. Select Calculations... from the Setup menu  and specify Equilibrium Geometry 

at Ground State in Gas using the wB97X-D/6-31G* model Make certain that Global 

Calculations at the bottom of the dialog is checked to ensure that the settings will be 

applied to all the molecules in the list.  

6. Click on the Submit button at the bottom of the Calculations dialog. Name it Diels-

Alder dienophiles it will take several minutes for this calculation to complete. After it 

completes, enter the following experimental relative rates into the spreadsheet. 
 
 

Experimental relative rates for 

Diels-Alder cycloadditions of cyclopentadiene* 

 log10 log10 

dienophile (relative rate) dienophile (relative rate) 

 acrylonitrile 0 1,1-dicyanoethylene 4.64 

 cis-1,2-dicyanoethylene 1.94 trans-1,2-dicyanoethylene 1.89 

 tricyanoethylene 5.66 tetracyanoethylene 7.61 

* J. Sauer, H. Weist and A. Mielert, Chem. Ber., 97, 3183 (1964). 
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Double click inside the header cell for a blank column in the spreadsheet, type 

Log(rate)= and press the Enter key (return key on Mac). You need to press the Enter 

(return ) key following each entry (or use the  key). Sort by relative rate. Click on 

the column header Log(rate), and then click on Sort at the bottom of the spreadsheet. 

7. Click inside a header cell for a blank column and click on Add... at the bottom of the 

spreadsheet (alternatively, right click inside the header cell for a blank column in the 

spreadsheet, and select Add... from the contextual menu that results). Click on the E 

LUMO button under the Molecule tab. 

 

 
 

 

The spreadsheet, which contains both the calculated LUMO energies and experimental 

relative rates, has served its purpose. Remove it from the screen by clicking on       at 

the top). 

8. Select Plots... from the Display menu . This leads to an empty plot pane at the 

right of the screen. Click on  in the toolbar (top of the pane). Select Log(rate) 

from the list of items in the X Axis menu and E LUMO(eV) from the Y Axes* list. 

Then, click on Create. 

 

 

 

 

 

 

* The Y axis specification is plural ñAxesò as users can generate plots with multiple Y axes displayed. If more 

than one Y axis is specified, color is used to distinguish data points and plot lines. 
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9. By default, only data points are displayed. Click on  in the toolbar at the top of 

the pane. This leads to display of the Edit Plot dialog. Check the box next to Curve, 

click on the button to the left of Least Squares and click on Done to display a least 

squares fit of the reaction rates to LUMO energies. The least- squares line will be 

drawn. 

 

10. Close Diels-Alder dienophiles and any open dialogs. 
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Addition vs. Substitution 

 

Alkenes normally undergo addition reactions whereas aromatic compounds normally 

undergo substitution reactions. For example, bromine reacts with cyclohexene to give trans-

1,2-dibromocyclohexane (the addition product) not 1-bromocyclohexene, whereas it reacts 

with benzene to give bromobenzene (the substitution product) not trans- 5,6-dibromo-1,3-

cyclohexadiene. 
 

In this tutorial you will use results from the Spartan Spectra and Properties Database (SSPD) 

as accessed from Spartanôs reaction energy calculator to establish the preferred product for 

each reaction. Specifically, energies from the wB97X-V/6-311+G(2df,2p) density 

functional model stored in SSPD will be employed. No calculations are involved. 

1. One after another, build or sketch cyclohexene, trans-1,2- dibromocyclohexane, 1-

bromocyclohexene, benzene, trans- 5,6-dibromo-1,3-cyclohexadiene, 

bromobenzene, bromine (Br2) and hydrogen bromide (eight molecules in total). Put 

all in the same document. Use New      to or sketch for the first molecule and New 

Molecule      to build or sketch each successive molecule. 

2. Select Spreadsheet from the Display menu . Left click inside the header cell for 

the leftmost column, then right click and select Rename Selected Using SSPD in the 

menu that appears. Click on OK in the dialog that results. The molecules can now be 

referenced using chemical names. Close the spreadsheet. 

3. Select Reactions from the Display menu . 

no calculations 
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Choose SSPD Database from the menu to the right of Source and ǧE from the menu 

to the right of Calculate at the bottom of the dialog. Compute the energy for Br2 

addition to cyclohexene: select cyclohexene and bromine as Reactants and trans-

1,2- dibromocyclohexane (leave the second product selection at <none>) as 

Products. Repeat for the corresponding substitution energy (same reactants but the 

products are 1-bromocyclohexene and hydrogen bromide) and for both addition and 

substitution reactions of benzene (reactants are benzene and bromine and products 

are trans-5,6-dibromo-1-3-cyclohexadiene and <none> for addition and 

bromobenzene and hydrogen bromide for substitution). 

Are all reactions thermodynamically favorable (exothermic)? Identify any reactions 

that are not and provide a rationale as to why. Why is there a change in preferred 

reaction in moving from the alkene to the arene? 

 

 

4. Close the document and any open dialogs. 

You can, if you wish, also calculate ɲH and ɲG for these reactions. The first adds zero-

point energy and temperature corrections to Energy and the second also adds the 

entropy. In both cases, ɤB97X-D/6-31G* is used to furnish vibrational 

contributions. 
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Hydration of Carbonyl Compounds 

The hydration of carbonyl compounds has been extensively studied primarily because it 

serves as a model for a number of important reactions, nucleophilic addition to carbonyl 

compounds among them. In this tutorial, you will use Spartanôs linear regression analysis 

tool to correlate calculated properties of carbonyl compounds with measured equilibrium 

constants for their hydration. The molecules are all in SSPD so no calculations are needed. 

1. Build or sketch all the compounds listed in the next page for which experimental 
equilibrium constants are available. Build or sketch, start with New      from the File 

menu for the first molecule and New Molecule from the File menu      for each 
successive molecule.  

2. Click on the name of whichever molecule is selected at the bottom of the screen. 

Confirm that the wB97X-D/6-31G* model is selected and click on Replace in the 

dialog that results and then on All to replace all molecules with entries from the SSPD. 

3. Select Spreadsheet from the Display menu  to bring up the spreadsheet. Double 

click inside the header cell of an empty column, type Log(Keq) and press the Enter 

key (return key on Mac). Then enter the experimental equilibrium constants from the 

table below. 

no calculations 
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Experimental Keq for hydration of carbonyl compounds 

 log(keq/55.5)  log(keq/55.5) 

 PhCOCH3 -6.8 CF3COCH3 -0.2 

 CH3COCH3 -4.6 PhCOCF3 0.1 

 PhCHO -3.8 H2CO 1.6 

 t-BuCHO -2.4 CF3CHO 2.7 

 CH3CHO -1.7 CF3COCF3 4.3 

* J.P. Guthrie, Can. J. Chem., 53, 898 (1975); 56, 962 (1978). 

 

You need to press the Enter (return ) key following each data entry. Sort the list 

according to the value of Log(Keq). Click inside the header cell Log(Keq) and then 

click on Sort at the bottom of the spreadsheet. 
 

4. Select Properties from the Display menu, click the        icon to the left of E HOMO . 

5. Click on the oxygen atom for whatever compound is displayed. Click on    to the 

left of Electrostatic (under Charges) in the Atom Properties dialog (that has 

replaced the Molecule Properties dialog), to place oxygen charges into the 

spreadsheet. 

6. Click on Add... at the bottom of the spreadsheet, and then click on the Linear 

Regression tab at the top of the dialog that results. 
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Select Log(Keq) from the Fit menu and both EHOMO (eV) and Electrostatic 

(O1)* from the Using list. Click on Apply . A new row (Fit1) will be added at the 

bottom of the spreadsheet. Select Properties from the Display menu , click 

anywhere on the Fit1 row. The Regression Properties dialog appears. 
 

This provides information about the fit of Log(Keq) to the charge on oxygen, in 

particular, the value of R2. The closer to unity, the better the fit. 

7. Select Plots from the Display menu . Click on  in the bar at the top of the 

plots pane. Select Log(Keq) from the X Axis list and FitVals(Fit1) from the box 

below Y Axes and click on Add. 

8. To see the correlation (measured and fit rates), click on Edit  from the toolbar at 

the top of the pane. Check the Curve box and click the Least Squares button. 

Finally, click the Done button. 

9. Close the document and any open dialogs. 
 

 

 

 

 

*  Your numbering may differ as it depends on the order that atoms were introduced during building, but the 

reference is to the carbonyl oxygen. 
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Acidities of Carboxylic Acids 

Acid strength is among the most important molecular properties. It is readily available from 

calculation, either in terms of absolute deprotonation energy, or, more commonly, 

                                                                   AH                   Aï + H+ 

as the deprotonation energy relative to that of some standard acid (ARH). 
 

The energy calculations discussed so far apply strictly to gas-phase acidities* and likely do 

not reflect acidities in solution. This prompts a search for alternative descriptions. One 

possibility is the value of the electrostatic potential in the vicinity of the acidic hydrogen in 

the neutral acid. Electrostatic potential maps would certainly be expected to reveal gross 

trends in acidity, for example, the acidic hydrogen in a strong acid, such as nitric acid, should 

be more positive than that in a weak acid, such as acetic acid, which in turn should be more 

positive than that in a very weak acid, such as ethanol. 

 

                                Nitric acid acetic acid ethanol 

 
In this tutorial, you will use electrostatic potential maps to quantify changes in acid strength 

due to subtle variations in structure. You will use the Spartan Spectra and Properties 

Database (SSPD) to eliminate the need for quantum calculations. 

 

 

 

 

 

 

 
*  This is not to say that quantum chemical treatments of solvated molecules have not been developed or have 

not been implemented within Spartan, but rather that in our opinion are not reliable enough to provide 

quantitative data. 

no calculations 
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1. One after another, build or sketch trichloroacetic, dichloroacetic, chloroacetic, 

formic, benzoic, acetic and pivalic acids. Put all molecules into the same document. 

Use New       from the File menu for the first molecule and use New Molecule      or 

from the File menu for each successive molecule. Click on  when you are done. 

2. All of the molecules that you have built are available in SSPD. Click on the name of 

whichever molecule is selected at the bottom of the screen, make sure that wB97X-

D/6-31G* is selected from the menu in the dialog that results, click on Replace, and 

finally on All . Structures obtained from wB97X-D/6-31G* density functional 

calculations will replace those you have built. The wave function is also provided 

with the database entry. 

3. Select Spreadsheet from the Display menu . Expand it so that you can see all 

seven molecules, and that two data columns are available. Double click inside the 

header cell of the first available data column, type pKa and press the Enter key 

(return key on Mac). Enter the experimental pKaôs (given in the table below) into 

the appropriate cells under this column. You need to press the Enter (return ) key 

following each entry. 
 

 acid pKa acid pKa 

 trichloroacetic (Cl3CCO2H) 0.7 benzoic (C6H5CO2H) 4.19 

 dichloroacetic (Cl2CHCO2H) 1.48 acetic (CH3CO2H) 4.75 

 chloroacetic (ClCH2CO2H) 2.85 pivalic ((CH3)3CCO2H) 5.03 

 formic (HCO2H) 3.75   

Experimental data from: E.P. Sargeant and B. Dempsey, Ionization Constants of Organic Acids 

in Aqueous Solution, IUPAC no. 23, Permagon Press, 1979. 

4. To display all molecules at once, check the box to the left of the molecule name 

(Label column) in the spreadsheet for each entry. To manipulate the molecules 

independently of one another, click to deselect Coupled from the Model menu . 

Arrange the seven molecules on screen such that you can clearly see the acidic 

hydrogen on each. 
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5. Select Surfaces from the Display menu  and then click on Add and select 

electrostatic potential map. When the electrostatic potential map calculations 

complete (they will be marked ñcompletedò), check the box at the left of electrostatic 

potential map in the Surfaces dialog. Select Properties from the Display menu  

and click on the electrostatic potential map to display the Surface Properties dialog. 

Click on        (the Post icon) to the left of Max inside the Surface Properties dialog. 

The maximum value of the electrostatic potential (corresponding to the acidic 

proton) will be posted to the spreadsheet. Leave the dialog on screen. 

6. Plot experimental pKa vs. maximum in the electrostatic potential. Select Plots from 

the Display menu  and then select pKa under the X Axis menu and Property 

Max (Surface) from the Y Axes list. Click on Create. Click on  to edit the plot 

and check the box next to Curve. Choose the Least Squares option and click on 

Done. Does there appear to be a correlation between pKa and the maximum value of 

the electrostatic potential? 

7. Close the document and any open dialogs. 
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Positional Selectivity of Substituted Naphthalenes 

Thermochemical stabilities of positional isomers may depend on several factors, including 

a tendency to minimize unfavorable non- bonded intramolecular interactions (sterics) and 

to minimize overall dipole moment (electrostatics). Naphthalene offers a good example with 

only two different positions. 

 

                                                             X 
 

                                                                                       X 

 
 

 
1-substituted naphthalene 2-substituted naphthalene 

 

In this tutorial you will use wB97X-V/6-311+G(2df,2p) energies from the Spartan Spectra 

and Properties Database (SSPD) to establish differences in heats of formation between 1 and 

2-substituted naphthalenes. Instead of building a series of substituted naphthalenes, you will 

use Spartanôs substituent model kit to construct one ñmoleculeò marked for substitution on 

the 1-position and the other ñmoleculeò for substitution on the 2-position. No calculations 

are involved. 

1. One after another build methane, ammonia, water, hydrogen fluoride, hydrogen 

cyanide and formic acid. Put all in the same list (use New to enter the builder for the 

first molecule and New Molecule  for each successive molecule). Select 

spreadsheet from the Display menu , double click inside the leftmost cell for 

each molecule and replace the identifier (M0001, é) by proper functional group 

names (methyl, amino, hydroxy, fluoro, cyano and carboxylic acid). Put the 

contents on the clipboard. Click in the header cell to select all molecules, then right-

click and select Copy from the contextual menu that results. Alternatively, select 

Copy from the Edit menu . Close the document (it is not necessary to save the 

document). 

2. Select New from the File menu     and build naphthalene. 

no calculations 
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Then, select Substituent from the menu at the top of the model kit to bring up the 

substituent builder. 
 

Click on Cust. A near the middle of the model kit, then right click inside the box 

near the bottom and select Paste from the contextual menu that results. Alternatively, 

left click inside the box and select Paste from the Edit menu . Names of the six 

functional groups that you built in the previous step will appear in the box. As you 

click through the list, ball-and-wire models of their structures will appear in the small 

screen at the top of the model kit. Note that one of the hydrogens (white balls) for 

each is highlighted in gold. This hydrogen will be removed to make a free valence 

for attachment. The carboxylic acid group has two different hydrogens, one on 

carbon (leading to a carboxylic acid) and one on oxygen (leading to a formate). If 

the hydrogen on the carbon is not already highlighted, click on it and it will be 

highlighted. Click on the free valence on naphthalene that will lead to 1-substituted 

naphthalenes. The molecule on screen will now appear with a marker to indicate 

substitution at the 1-position. 
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3. Select New Molecule from the File menu      . Select Organic from the tab at the top 

of the model kit and again build naphthalene. Select Substituent from the menu to 

bring the substituent model kit. Make certain that Cust. A is selected (if not, click 

on it). Click on the free valence on naphthalene that will lead to 2-substituted 

naphthalenes. Click on  to remove the model kit. 

4. Select Spreadsheet from the Display menu . Double click inside the leftmost cell 

for the first molecule and replace the default identifier (M0001) with 1-substituted 

naphthalenes. Double click inside the corresponding cell for the second molecule 

and replace the default identifier by 2-substituted naphthalenes. 

5. Select Reactions from the Display menu . Choose SSPD Database from the 

menu to the right of Source and ɲE from the menu to the right of Calculate. This 

signifies that energies obtained from the wB97X-V/6-311+G(2df,2p) model 

associated with each of the entries in SSPD will be employed. Select 1-substituted 

naphthalenes as Reactants and 2-substituted naphthalenes as Products and click 

on Compute at the bottom of the dialog. Reactions will be written (and reaction 

energies computed) for all six substituents. The Boltzmann weights column 

provides a weighting of positional preferences. 

6. Close the document and any open dialogs. 
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Tautomers of Nucleotide Bases 

Protons bound to heteroatoms in heterocyclic compounds are likely to be very mobile in 

solution and, where two or more heteroatoms are present in a structure, different isomers 

(tautomers) may be in equilibrium. Consider the nucleotide base, like cytosine, but where a 

methyl group has replaced the sugar-phosphate backbone at the 1-position. 

 
  

 

The existence of a low-energy tautomer could have far-reaching consequences, given that 

the valence structure of cytosine is key to hydrogen bonding in DNA. In this tutorial, you 

will examine the possible tautomers of 1-methylcytosine for evidence of low-energy 

structures.* 

1. Build or sketch 1-methylcytosine, the SSPD identifies this as 4-amino-1-methyl-1,2-

dihydropyrimidin-2-one. 

2. Note that the word Tautomer appears at the bottom right of the screen, indicating 

that tautomers exist. Select Generate Tautomers from the Geometry menu . 

Step through the tautomers using the  and  keys that appear at the bottom right 

of the screen. To put the tautomers in a list, click on  at the bottom right of the 

screen and click on OK in the on-screen message ñGenerate a Tautomer Listò that 

results. 

3. Select Calculations... from the Setup menu  with the list of tautomers. (To avoid 

confusion, it is a good idea to close the molecule you used to get the tautomers.) 

Specify calculation of Equilibrium Geometry using the wB97X-D/6-31G* density 

functional model. Submit the job with the name cytosine tautomers. 
 

 
 

 

 

* Note, however, that were the energy of an alternative tautomer only 10 kJ/mol higher than that for the 

normal structure, this would translate into a relative abundance of only about 1% at room temperature. Thus, 

any alternative tautomers would need to be very close in energy to the lowest-energy tautomer to have 

noticeable effect. 

30 mins 
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4. After the calculations have completed (perhaps 10-15 minutes), select Spreadsheet 

from the Display menu . Click on the cell corresponding to the original structure 

for 1-methylcytosine. Click on Add at the bottom of the spreadsheet and then click 

on the Molecule List tab; under Energy from Molecule select rel.E and Boltzmann 

Weights from the available quantities and kJ/mol from the Relative Energy Units 

menu. Click on the background to release the dialog. Are either of the alternatives 

close in energy to the normal form of cytosine? 

5. If you find that one of the alternative tautomers is within 10 kJ/ mol of 1-

methylcytosine, perform wB97X-V/6-311+G*(2df,2p) energy calculations on this 

tautomer as well as 1-methylcytosine. These may require upwards of an hour of 

computer time. What does the X-V functional with the larger basis set report for 

relative energies? 

6. For a more realistic example, examine the RNA nucleotide, close any open files, and 

return to the New Build mode. Click on the Nucleotide tab in the Model Kit . Make 

sure that the check box next to Sequence is not selected. Click on C to select 

cytosine, and from the drop-down menu under this, select RNA. Double-click on 

screen to insert cytidine (cytosine riboside). Repeat the procedure of generating the 

tautomer list (Geometry menu, Generate Tautomers, and then click on  to 

Generate a Tautomer List.  

7. Submit the following calculation Energy with Est. Density Functional and wB97X-

V/6-311+G*(2df,2p). To the right of Start From specify Equilibrium Geometry 

using Est. Density Functional and wB97X-6-31G*. Submit the job. Revisit the 

spreadsheet and again, make relative energy comparisons. What do the neural 

network calculations suggest with regard to the Boltzmann distribution? 

8. Close any open documents and any remaining open dialogs. 
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Chapter 9 
Spectra of Organic Molecules 

 

The tutorials in this chapter illustrate applications involving the calculation of IR and also 

illustrate the use of calculated IR spectra to identify an experimental unknown. Additionally, 

calculation of proton and 13C NMR spectra are demonstrated. DP4 analysis is illustrated to 

identify which stereoisomer best fits an experimental 13C NMR spectrum. 

 

In addition to equilibrium geometries, conformations and conformational energy 

differences, reaction energies, as well as diverse molecular properties, calculations provide 

infrared and Raman spectra, NMR spectra and UV/visible spectra. IR and Raman spectra 

arise from the transitions between ground and excited vibrational states, NMR spectra from 

transitions between nuclear spin states and the UV/visible spectra from transitions between 

ground and excited electronic states. 

Chemists use spectra, in particular, NMR spectra to provide essential clues needed to assign 

the structure of an unknown molecule. That is, features in the spectrum may be used to 

support a proposed structure assignment, whereas their absence suggests that the assignment 

is likely to be incorrect. On the other hand, a calculated spectrum starts with a known 

structure. A high degree of similarity with a measured spectrum may be taken as evidence 

that the calculated molecule is the same (or at least very similar to) that for which the 

spectrum was measured. Lack of similarity suggests that the two molecules are not the same. 

The first two tutorials in this section deal with infrared structure and use the EDF2/6-31G* 

model. The first details the steps needed to calculate the infrared spectrum of methyl formate 

and to relate the spectrum to the underlying molecular structure, and the second illustrates 

use of the Spartan Infrared Database to identify a molecule based on its infrared spectrum.  

The remaining tutorials deal with NMR spectroscopy and use the wB97X-D/6-31G* model 

and (optionally) the SSPD database. The first of these details the steps involved in 

calculating and displaying a proton spectrum for 1-methylindole, and the second, the 13C 

spectrum of caulophyline, both of which are rigid molecules. The third considers the 13C 

NMR of cis-1,2-dimethylcyclohexane, a molecule that rapidly (relative to the time scale of 

the NMR experiment) moves between two equivalent conformers. Discussion of the NMR 

spectra of molecules with multiple degrees of conformational freedom and several 

accessible conformers is provided in a later chapter. The final tutorial examines the 

dependence of carbon chemical shifts on stereochemistry and illustrates the use of DP4 

analysis to decide which best fits the experimental NMR spectrum. 
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Infrared Spectrum of Methyl Formate 

 
In the harmonic approximation, the frequency at which a diatomic molecule vibrates is 

proportional to the square root of the ratio of the force constant (the second derivative of the 

energy with respect to change in bond length) and the reduced mass (the product of the 

masses of the two atoms divided by their sum). Frequency increases with increasing force 

constant or stiffness of the bond and decreases with increasing masses of the atoms involved 

in the bond. 

 
                                                 frequency a 

 

In order to generalize this expression to a polyatomic molecule, it is necessary to use a 

coordinate system that leads to a diagonal matrix of second energy derivatives (so-called 

normal coordinates). These differ from internal coordinates (depicting charges in specific 

bond lengths and angles), and for a polyatomic molecule will typically involve the motions 

of several (and likely all) atoms. 

The intensity of absorption of infrared radiation by a diatomic molecule is proportional to 

the change in the dipole moment with change in bond length. Since the dipole moment for 

a homonuclear diatomic molecule does not change with distance, this means that molecules 

such as N2 and O2 are transparent in the infrared. The intensity of each of the individual lines 

in an infrared spectrum of a polyatomic molecule follows from the change in dipole moment 

along the associated normal coordinate. Some of the normal coordinates may not lead to a 

change in dipole moment, for example, the symmetric stretch in carbon dioxide where both 

CO bonds are simultaneously moving, and infrared absorptions will not be observed. 
 

This tutorial illustrates the steps required to calculate and display an infrared spectrum and 

to compare it with an experimental spectrum. You will explore how the ease or difficulty of 

molecular motion (the value of the force constant) and changes in atomic masses affect 

frequency. 

1. Build or sketch methyl formate. Select Calculations... from the Setup menu , 

and specify an Equilibrium Geometry  calculation using the EDF2/6-31G* density 

functional model. Ground state, in Gas and Neutral Total Charge with 0 Unpaired 

Electrons. Check the IR check-box (to the right of Compute) and click the Submit 

button. Accept the name methyl formate. 
 

force constant 

reduced mass 

10 mins 



Chapter 9 130  

 
 

 

 

2. After the calculation has completed (less than a minute), select Spectra from the 

Display menu ( ). Click on the       in the toolbar at the top of the spectra pane 

and, from the IR tab select                from the palette of icons. The experimental IR 

spectrum of methyl formate is available in the freely available NIST database. Click 

on the  again and select  from the icon palette. Calculated (in red) and 

experimental (in blue) infrared spectra are now superimposed. 
 

 

3. Click on either the up or down triangles that define a cursor and slide the mouse 

while holding down the left button across the spectrum. Position it on the intense 

line in the (calculated) spectrum near å1774-1778 cm-1. Note that the molecular 

model (on screen above the spectra pane) vibrates. The motion corresponds to 

stretching of the CO double bond. Position it over the intense line near å1211 cm-1. 

This motion corresponds to a combination of stretching motions of the two CO single 

bonds. 

4. Select Save As from the File menu  to make a copy of methyl formate; name it 

methyl formate d3. Click on  to enter View mode. Select Properties from the 

Display menu  and click on one of the three hydrogen atoms on the methyl group 

to bring up the Atom Properties dialog. Change Mass Number from 1 to 2 

Deuterium. Repeat for the other two methyl group hydrogen atoms. Resubmit the 

calculation* (it will require only a few seconds) by selecting Submit from the Setup 

menu. 
 

 

*  Because force constants (second derivatives) do not depend on mass, the calculation is very 

simple and will require only a few seconds. 
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5. Compare the frequencies of the undeuterated and deuterated forms of methyl formate 

and identify which change the most and which change the least. To do this open the 

original methyl formate document and display the calculated IR spectra. To examine 

the calculated frequencies, click on the Tables icon . A table of frequencies and 

intensities is presented. Examine the frequencies associated with CH vibrations on 

the methyl group. Repeat the procedure examining frequencies associated with CD 

vibrations on the methyl group. You can move between the documents by clicking 

on the appropriate tab at the bottom of the screen. 

 

6. Close all documents and any open dialogs. 

 

 

Searching Spartanôs Infrared Spectral Database 

 

Pattern matching (ñfingerprintingò) a measured infrared spectrum to a collection of 

experimental spectra contained in a database is common practice and is appropriate for 

identifying molecules that have previously been characterized. However, NMR has replaced 

infrared spectroscopy as the method of choice for structure assignment of ñnewò (previously 

uncharacterized) molecules. Pattern matching to databases of calculated infrared spectra is 

not routine. One reason is that the results of calculations (a set of vibrational frequencies 

and intensities) do not look like experimental infrared spectra, at least, spectra obtained at 

normal temperatures. However, a fit of the calculated data to a Lorentzian function in which 

peak width at half height is treated as a parameter makes the two spectra visually quite 

similar, not at all surprising as this loosely corresponds to temperature. In fact, an infrared 

spectrum measured at low temperature comprises a series of sharp lines (rather than bands). 

Practical calculations assume that the frequency of an infrared absorption is proportional to 

the square root of the second derivative of the energy at a minimum in the potential surface 

for a particular vibrational coordinate, that is, to the curvature of the surface. The so-called 

quadratic approximation leads to a surface that is too steep, resulting in calculated 

frequencies that are larger than measured frequencies. For the most part, the error is 

systematic, with calculated frequencies being between 3% and 15% larger than measured 

frequencies, depending on the theoretical model. Hartree- Fock models show an error near 

the top of the range, while density functional and MP2 models show an error near the bottom 

of the range. Semi-empirical models do not show a consistent error pattern. Such a 

systematic error can be compensated for, at least in part, by incorporating a single linear 

scaling parameter into the fitting function. 

Spartan fits calculated infrared spectra to the measured infrared spectra using a Lorentzian 

function that incorporates two parameters, a non-linear parameter accounting for peak width 

and a linear scaling parameter. 

2 mins 
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This tutorial illustrates the way in which searches of the Spartan Infrared Database (SIRD) 

are setup and carried out and the results examined. SIRD is an additional access route to the 

molecules contained in the Spartan Spectra and Properties Database (SSPD) and derives 

from EDF2/6-31G* calculations. You may choose from a small selection of measured 

infrared spectra (or supply your own spectra as a .dx file). 

1. You need to have a Spartan document open in order to access SIRD. Select New 

from the File menu     , and then select Databases from the Search menu . Click 

on the SIRD tab to bring up the Spartan Infrared Database dialog. 

 

 
 

 

Click on Select Spectrum at the bottom right of the dialog. Navigate to the spectra 

of organic molecules subdirectory under the Tutorials directory.* 

Select one of the following files and click on Open. 
 

 

 

 
 
 

* For Windows, this directory is found in Program Files/Wavefunction/Spartan26. For security reasons, the 

program file directory is protected. Copy the folder to your desktop or to another location available to the user 

prior to opening it in Spartan. For Linux, this is found in the directory where Spartan was installed. For 

Macintosh, this is located at the top level on the Spartanô26 disc image. 

The experimental infrared spectrum of the selected molecule will appear in the 
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window at the top right of the dialog with the name underneath. Immediately to the 

left is a scroll box containing the most intense lines in the spectrum (obtained from 

a fit of the experimental spectrum to a Lorentzian function). 
 

 

 
 

 

2. Click on Filters at the bottom right to bring up the Search Filters dialog. 
 

 

This provides for substructure and formula filters as well as functional group filters. 

You can, if you wish, check an appropriate entry. For example, if you have selected 

chromone-3-carbonitrile as the ñunknownò, checking nitrile from among the 

Functional Group Filters would limit the search to molecules with nitrile 

functionality. Click on OK to exit the dialog. 
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3. Click on Search at the bottom of the (Spartan Infrared Database) dialog. The 

search may require a minute or two. When it has completed, scan the list of hits at 

the bottom of the dialog for the name of your query. It will be at or near the top of 

the list.* Click on the name. The calculated infrared spectrum (red) will be 

superimposed onto the fit of the experimental spectrum (blue) in the window at the 

top right of the dialog. 

4. Close all documents and any open dialogs. 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

* This will not always be the case. Errors inherent to the calculations as well as the absence of detail may result 

in better matches to ñincorrectò but closely related molecules. Of course, a query may also not be in the 

database, so it is possible to find only related molecules. 
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Proton NMR Spectrum of 1-Methylindole 

 

Proton NMR spectroscopy was the first tool available to chemists that allowed definitive 

assignment of the molecular structures of complex organic molecules. By the 1970ôs, it had 

largely replaced infrared spectroscopy and to a large extent chemical proofs of structure. 13C 

NMR is now more dominant, but proton NMR remains an essential tool in the chemistôs 

arsenal. 

An NMR spectrum follows from the fact that nuclei possess spins that can either align 

parallel or antiparallel to an applied magnetic field, giving rise to different nuclear spin 

states. The relative energy of these states (ȹE) depends on the nucleus and on the strength 

of the applied magnetic field, by way of a simple relationship: 

æE = gᴐB0 

g is the gyromagnetic ratio (a constant for a given type of nucleus), ᴐ is Planckôs constant 
divided by 2ˊ and B0 is the strength of the magnetic field at the nucleus. While the two 

nuclear spin states are normally in equilibrium, this equilibrium can be upset by applying a 

second magnetic field. The absorption of energy as a function of field strength (a resonance) 

between the states can then be detected. 

The key to the utility of the magnetic resonance experiment is that the energy at which a 

nucleus resonates depends on its location in the molecule and is measurably different for 

each (chemically) distinct nucleus. The reason is that the applied magnetic field is weakened 

by electrons around the nucleus. Nuclei that are well shielded by the electron cloud will feel 

a lesser magnetic field than those that are poorly shielded and will show a smaller energy 

splitting. The difference, given relative to a standard, is termed a chemical shift. By 

convention, both proton and 13C chemical shifts (treated later in this chapter) are reported 

relative to tetramethylsilane (TMS) as a standard. 

While each unique proton in a molecule gives rise to a single line (resonance) in the 

spectrum, the spins on nearby protons add or subtract to the external magnetic field. This 

leads to a splitting of lines; the splitting pattern depends on the number of neighboring 

protons and their geometry. In practice, only two-bond (    ) and three-bond ( ) 

interactions or coupling are important. Discounting splitting, the intensity of the lines is 

approximately proportional to the number of equivalent protons that contribute.* For 

example, the proton NMR spectrum of 1-methylindole would be expected to show seven 

lines, six with unit intensity corresponding to the protons on the indole ring and one line 

with three times the intensity corresponding to the three equivalent methyl group protons. 

 

 

*  More generally, the relative intensity of the sum of the lines corresponding to a proton that has been split is 

approximately proportional to the number of chemically equivalent protons. 

 

10 mins 
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In this tutorial, you will use the wB97X-D/6-31G* model to calculate the proton NMR 

spectrum of 1-methylindole and compare it with the experimental proton spectrum in the 

absence of three-bond HH coupling. 

1. Build or sketch 1-methylindole. Select Calculations... from the Setup menu . 

Specify calculation of equilibrium geometry using the wB97X-D/6-31G* density 

functional model. Check NMR to the right of Compute and click on Submit. Accept 

the name 1-methylindole. The calculation may require a couple minutes. 

2. When the calculation has completed (or after you have retrieved results from SSPD), 

select Spectra from the Display menu . Click on  in the bar at the top of the 

spectra pane and from the NMR  tab select  (proton NMR spectrum in 

which there is no HH coupling). 

 

Move the mouse while holding down the left button over the spectrum. When you 

intersect a line, a numerical value for the chemical shift appears at the top of the 

spectrum and the proton is highlighted in the structure model. 

3. Click again on  and this time select  (experimental proton NMR 

spectrum with HH coupling constants set to 0). The experimental spectrum will be 

retrieved from the freely available NMRShiftDB database* and displayed with the 

calculated spectrum. You will need to be online. 
 

 

 

 

 

* The NMRShiftDB is primarily a collection of 13C spectra, although some proton spectra including that for 

1-methylindole are available. 
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The comparison gives you an idea of the level of agreement that can be expected 

between calculated and experimental proton spectra. 

4. Click again on  and select  (calculated proton NMR spectrum). The 

calculated proton spectrum that now appears accounts for three-bond HH coupling. 

 

You can focus in on details by a combination of zooming the spectrum (scroll wheel) 

and shifting the displayed range (move the mouse while holding down the right 

button). You will see that lines due to protons at C2, C3, C4 and C7 are doublets, while 

those due to protons at C5 and C6 are quartets (doublet of doublets). 

5. Close 1-methylindole and any open dialogs. 
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13C NMR Spectrum of Cytisine 

 

There are several reasons why NMR spectroscopy, in particular, 13C NMR, is one of the 

most important routine analytical techniques available for characterizing organic molecules. 

The analysis is straightforward, can be carried out quickly requiring relatively small samples 

and is non-destructive. The resulting spectrum is quite simple, comprising but a single line 

for each and every unique carbon.* However, assigning 13C spectra is by no means trivial, 

even for seemingly simple molecules. The problem is that the positions of the lines in the 

spectrum (the chemical shifts) are very sensitive to the environment in which the carbons 

find themselves. Experiments exist to separate 13C resonances based on the number of 

attached hydrogens, however, where two or more carbons in a molecule reside in ñsimilar 

environmentsò, it may be very difficult to distinguish them. This is particularly problematic 

for quaternary carbons.  

This tutorial uses the alkaloid cytisine to illustrate the use of calculated 13C spectra to assist 

in assigning the measured spectrum of the molecule. 
 

 

 

 

 

1. Either build or sketch cytisine. Image on previous page. This can pose a challenge, 

if you end up NOT seeing the name cytisine appear in the lower right of the interface 

(upon completing your drawing/sketch), you can also build via InChI  string. From 

the New Build or Edit Build  mode, in the Organic tab of the Model Kit , click on 

the InChI  button. In the resulting dialog, you can paste the following string:  

InChI=1/C11H14N2O/c14-11-3-1-2-10-9-4-8(5-12-6-9)7-13(10)11/h1-3,8-9,12H,4-7H2/t8-,9+/m0/s1  

and then click OK . At the top of the Model Kit , a 3-D image of the molecule cytisine 

will appear. Double-click to insert this on screen. Select Calculations... from the 

Setup menu  and specify calculation of equilibrium geometry with the  ̟B97X-

D/6-31G* density functional model. Check NMR to the right of Compute and leave 

the NMR setting at Current Model . Click on Submit and accept the name cytisine. 

The job will require a number minutes to complete (å 5-10). 
 

 

*  CH coupling does split carbon resonances but is almost always eliminated by what is termed proton 

decoupling. 

20 mins 

NH 
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2. When the calculation is done (or after you have retrieved the molecule from SSPD), 

select Spectra from the Display menu . Click on         in the bar at the top of the 

spectra pane and select                (experimental 13C spectrum). The experimental 
13C spectrum is drawn. 

 

3. Use the calculated spectrum to associate the individual lines in the experimental 13C 

spectrum with specific carbons in the structure of cytisine. Click on  and this time 

select  (calculated 13C spectrum). The calculated spectrum (in red) will be 

superimposed on top of the experimental spectrum (in blue). This both gives an 

impression of the performance of the quantum chemical calculations and also allows 

you to assign the lines in the experimental spectrum to specific carbons. Click on one 

of the triangles that designate the cursor and move the mouse while holding down 

the left button over the spectrum. A ñhitò on a line will display the value of the 

chemical shift and will highlight the carbons responsible for this line in the structure 

model. 

 

  Optional 

4. Open the Spreadsheet and right-click on the entry (under the Label) column. Click 

on Rename Selected Molecule(s) Using SSPD. Again right-click, this time on the 

name cytisine and choose Replicate Selected Molecule(s) in New Document. This 

will create a new document, enter the Calculations dialog, and specify Energy using 

the ̟ B97X-D/6-31G* density functional model. To the right of Start from , select 

Equilibrium Geometry using Est. Density Functional B̟97X-D/6-31G*. Check the 

NMR to the right of Compute and change the NMR setting to Energy Model. This 

specifies determination of structure (Equilibrium Geometry) using one of the NN 

(neural network) models, followed by a subsequent Energy (single point energy) 

calculation using the quantum chemical B̟97X-D/6-31G* Density Functional 

model, and finally an NMR calculation will be performed based on the quantum 

chemical energy. Click on Submit and provide the name cytisineNN. The job will 

require less time to complete (perhaps 2-3 minutes). 

5. Compare NMR Shift results. From the original cytisine document, right-click on the 

carbonyl carbon and choose Properties from the resulting contextual menu. From 

the Atom Properties dialog, note the value of the reported Chem. Shift. Click on the 

tab at the bottom of the GUI next to your cytisineNN document. Repeat the 
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procedure above, how similar are the chemical shifts on the carbonyl carbon in the 

document where geometry was determined by the neural network (Est. Density 

Functional > ̟ B97X-D/6-31G* model)? Repeat the procedure on other centers. Are 

the shifts generally in good accord between the two calculations (bearing in mind 

one took 3-4 times longer than the other)? 

6. Close both cytisine and cytisineNN any open dialogs. 
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13C NMR Spectrum of cis-1,2-Dimethylcyclohexane 

At normal temperatures, the NMR spectrum of a conformationally- flexible molecule 

represents an average (Boltzmann-weighted average) of the NMR spectra of all accessible 

conformers. Only when the temperature is lowered will the spectrum reveal its 

conformational components. The molecule cis- 1,2-dimethylcyclohexane is a special case 

where the (two) conformers are actually the same (identical). 

 
The room temperature 13C NMR spectrum comprises only four lines at 34.9, 31.9, 24.2 and 

16.4 ppm relative to TMS, corresponding to an equal weighting of C1 and C2, C3 and C6, 

and C4 and C5 and the two methyl carbons, respectively. When the sample is cooled the 

spectrum reveal eight distinct lines. 

 

1. Either build or sketch cis-1,2-dimethylcyclohexane. Select Calculations... from the 

Setup menu  and specify calculation of equilibrium geometry with the wB97X-

D/ 6-31G* density functional model. Check NMR to the right of Compute and leave 

the NMR setting at Current Model . Click on Submit and accept the name cis-1,2-

dimethylcyclohexane. The calculation will take less than 10 minutes. 

2. When the calculation is done, select Spectra from the Display menu       , click on 

 in the bar at the top of the spectra pane and from the NMR  tab select        

(calculated 13C spectrum). There should be only four lines, the positions of which 

should correlate fairly well with what is observed experimentally at room temperature 

(within 1.5 - 2 ppm)*. Spartan has recognized that there are two equivalent structures 

and has calculated the average. 

3. Close cis-1,2-dimethylcyclohexane and any open dialogs. 

 

 
 

 

*  13C chemical shifts from wB97X-D/6-31G* calculations have been empirically corrected. 
 

 

10 mins 
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Stereochemical Assignments from 13C Spectra 

 

NMR spectroscopy, in particular 13C spectroscopy, is without doubt the method of choice to 

establish the three-dimensional structure of organic molecules. Only X-ray diffraction 

provides more definitive results, although the requirement of a crystalline sample often 

limits its application. It is now practical to routinely calculate the NMR spectra of moderate 

size (MW on the order of 500 amu) organic molecules. Accurate calculations provide a 

ñvirtual NMR spectrometerò offering organic chemists an entirely new paradigm for 

structure determination, that is direct comparison of a measured spectrum with calculated 

spectra for one or more chemically reasonable candidates. 

In this tutorial, you will first obtain 13C chemical shifts for endo and exo stereoisomers of 2-

methylnorbornane using the wB97X-D density functional model, then enter the 

experimental shifts for one of the two isomers and use the DP4 metric to decide which 

provides the better match. Note that isomers MUST be labeled identically in order to make 

meaningful comparisons. 

1. Sketch 2-methylnorbornane. Start with a six-member ring, draw a one-carbon bridge 

between two carbons, add ñupò stereochemical markers. Finally, add a carbon to the 2 

position. 

 
 

You need to add a stereochemical marker to distinguish between endo and exo 

stereoisomers, but before you do so, copy the sketch to the clipboard. Right click on 

screen and select Copy from the menu. Add the  marker to give the endo 

stereoisomer. Select Sketch New Molecule (not New Sketch) from the File menu, 

right click on screen and select Paste from the menu. Add the  marker to give the 

exo stereoisomer.  

 

Click on  to give 3D structures for both isomers. 
 

 

 

 

 

 

 

2. Bring up the spreadsheet, left-click on the Label cell to select all molecules, then right-

10 minutes 
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Experimental 13C NMR Data 

click and choose Rename Selected Using SSPD. Specify calculation of equilibrium 

geometry using the ɤB97X-D/6-31G* density functional model and check the NMR 

box. Make sure Global Calculations is checked and submit the job. The job (two 

molecules) will require a few minutes to complete. 

3. When the calculations are completed, select the first molecule. Add experimental shifts 

(from the table below). This can be accomplished from either the Expt. Data menu, 

or by bringing up the Properties dialog and one after the other clicking on the 

individual carbons and then on the Edit drop down menu to the right of Expt Chem 

Shift: . The number pad is used to enter the experimental shift values given in the table 

below: 

 

 

 

C1 42.2 C5 30.6 

C2 34.6 C6 22.4 

C3 40.7 C7 38.9 

C4 38.2 CH3 17.4 

 

 

4. Click on  to revert the Atom Properties dialog to the Molecular Properties 

dialog. Click on the NMR tab (in the Molecule Properties dialog). Make sure the 

Experimental Data From is set to whichever molecule you have entered in 

experimental shifts from and click the Apply Globally  button. Click on  to the left 

of DP4 in the dialog. Bring up the spreadsheet to see the DP4 score for the two 

stereoisomers. The scale is a percentage from 0 to 100 with the larger numbers 

corresponding to better fits. (You can also examine DP4 scores from the Properties 

dialog if you flip between the stereoisomers). 

5. The DP4 calculation is dependent on availability of both experimental shifts and 

calculated shifts. The specification of Experimental Data From determines where 

this data comes from. In general, it is easiest to specify a single isomer as the source. 

The <current molecule> selection should be reserved for cases where the 

experimental data is input into an initial structure, but additional (stereo)isomers are 

subsequently generated from the initial structure as well (Geometry menu Chapter 

19). In this case, the experimental shifts are included for each isomer generated from 

the Generate Isomers tool in the Geometry menu. Because the endo and exo structure 

were built ñmanuallyò; we took the additional step of using the clipboard to ensure 

consistent atom labeling. This is not necessary when stereoisomers are generated from 

Spartanôs Generate Isomers tool. 

6. Close the document and any open dialogs. 
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Chapter 10 
Inorganic and Organometallic 

Molecules 
 

This chapter illustrates applications to inorganic and organometallic molecules constructed 

using the inorganic builder in Spartanôs model kit. 

Organic molecules typically comprise only a relatively few elements and obey conventional 

valence rules. The geometry about individual atoms is ñtetrahedralò (sp3), ñtrigonal planarò 

(sp2) or ñlinearò (sp). As such they are easily constructed using the organic model kit. On 

the other hand, construction of many inorganic and organometallic compounds in particular 

those involving transition metals may require the enhanced flexibility provided by the 

inorganic builder. 

Transition-metal inorganic and organometallic compounds may also require different 

quantum chemical methods from those that have proven to be satisfactory for organic 

molecules. While there are a large number of experimental structures, almost entirely from 

X-ray diffraction, accurate experimental thermochemical data on molecules incorporating 

transition metals is virtually non-existent making assessment of the various models 

problematic. 

The PM3 and PM6 semi-empirical models have been explicitly parameterized for most 

transition metals and generally (but not always) provide a reasonable account of geometries. 

However, they would not be expected to properly account for reaction energies as they 

generally perform poorly for reactions involving molecules without metals.* Hartree-Fock 

and MP2 models are known to produce poor geometries where transition metals are involved 

and cannot be recommended.* On the other hand, DFT models appear to be quite successful 

for calculation of geometries of molecules incorporating both transition metals and 

lanthanides (although their performance for energy comparisons remains to be clarified). 

 

 
 
 

*  It should be noted that experimental thermochemical data for inorganic molecule especially for those 

incorporating transition metals is far less common (and likely less reliable) than that for organic molecules. 

The poor performance of MP2 is likely a result of its dependence on a Hartree-Fock wave function. 
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Sulfur Tetrafluoride 

 

 

Sulfur tetrafluoride cannot be constructed using Spartanôs organic builder. This is because 

sulfur is not in its normal bent dicoordinate geometry, but rather in a trigonal bipyramid 

geometry with one of the equatorial positions vacant. However, the molecule can easily be 

made using the inorganic builder. 

 

1. Bring up the inorganic builder by clicking on     and then clicking on the Inorganic 

tab at the top of the model kit. 
 

 

 

1 min 
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The inorganic builder comprises an atom bar (clicking on this brings up the Periodic Table*) 

followed by a selection of atomic hybrids. Buttons access menus of groups, rings and 

ligands, additional libraries (More) and the clipboard. Finally, a selection of bond types is 

provided at the bottom of the model kit. 

2. Click on the atom bar to bring up the Periodic Table. 
 

Select (click on) S in the Periodic Table and the five coordinate trigonal bipyramid 

structure  from the list of atomic hybrids. Double click on screen. A trigonal 

bipyramid sulfur will appear at the top of the model kit. 

3. Again, click on the atom bar, select F in the Periodic Table and the one-coordinate 

entry  from the list of atomic hybrids. Alternatively switch to the organic builder 

(click on the Organic tab) and select  icon. One after another, click on both axial 

free valences of sulfur, and two of the three equatorial free valences. 

4. It is necessary to delete the remaining free valence (on an equatorial position); 

otherwise it will become a hydrogen. Click on  and then click on the remaining 

equatorial free valence. 

5. Click on . Click on . Select Calculations... from the Setup menu . Specify 

calculation of equilibrium geometry* using the wB97X-D/ 6-31G* density functional 
model and click on OK .  

 

 

 

 

*   Not all methods are available for all elements listed. Elements for which a specific method (selected in the 

Calculations dialog) are available will be highlighted following selection of a theoretical model or basis 

set from the Model menu that appears in the center of the Periodic Table. Note the availability of some 

heavier elements (>Kr) assumes use of the LANL2DZ basis set which Spartan will employ automatically 

when required. 

It should be noted that were an incorrect geometry specified at the outset, optimization would lead to the 

correct structure, as long as the starting geometry possessed no symmetry (C1 point group). Thus, square 

planar SF4 in D4h symmetry would remain square planar, while an ñalmostò square planar structure 

(distorted only slightly from D4h symmetry to C1 symmetry) would collapse to the proper structure upon 

geometry optimization. 
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6. Select Surfaces from the Setup menu, click on Add and select HOMO  from the 

menus the at results and click on OK . 

7. Submit the job. Accept the name sulfur tetrafluoride. When completed, select 

Properties from the Display menu  and click on an atom, for example, sulfur. 

Three different atomic charges will appear in the (Atom Properties) dialog 

(corresponding to different methods for establishing atomic charge). Of these, the 

procedure based on fitting the electrostatic potential is generally considered to be the 

best. Are the electrostatic charges consistent with covalent or ionic bonding? 

8. Check the box to the left of HOMO inside the Surfaces dialog. The HOMO is largely 

concentrated along the axial direction which lacks a fluorine, consistent with the 

notion that sulfur is surrounded by six electron pairs (five involved in SF bonds and 

one a ñlone pairò. 

9. Close sulfur tetrafluoride and any open dialogs. 
 

 

Benzene Chromium Tricarbonyl 
 

 

 
 

Comparison of electrostatic potential maps for benzene chromium tricarbonyl and free 

benzene will allow you to classify Cr(CO)3 as an electron-donor or an electron-acceptor 

substituent. 
 

1. Select New from the File menu      and click on the Inorganic tab at the top of the 

model kit. Click on the atom bar and select Cr from the Periodic Table. Select the 

four-coordinate tetrahedral structure  from the list of atomic hybrids. Double-

click anywhere on screen. 

  

no calculations 
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2. Click on Ligands in the model kit and select Benzene from the menu of available 

ligands. 
 

Click on one of the free valences on the four-coordinate chromium center. 

 

3. Select Carbon Monoxide from the Ligands menu and click on the remaining (three) 

free valences on chromium. Click on  to produce a refined structure. 
 

 

 

4. Select New Molecule from the File menu      . Click on Rings, select Benzene and 

click on the screen. Click on  and then on . The document now contains both 

benzene chromium tricarbonyl and benzene. 

5. Both benzene and benzene chromium tricarbonyl are available in the Spartan Spectra 

and Properties Database (SSPD). Click on the name of whichever molecule is selected 

at the bottom of the screen, make certain that  ɤB97X-D/6-31G* is selected and click 

on Replace. Click on All in the dialog that results. 

Benzene chromium tricarbonyl among many organometallics may 

easily be constructed using the 2D sketcher. Inside the sketch pad, 

double click on the wild card icon, select the Periodic Table tab 

and click on Cr. Double-click inside the sketch. Double-click a 

second time on the wild card icon (which will now read Cr), select 

the Ligands tab and click on benzene ligand. Draw a line upward 

from Cr. Double click on the wild card icon a third time (which 

will now display benzene ligand), select the Ligands tab and click 

on carbon monoxide ligand. Draw three lines down from Cr. Clean 

up the sketch    and click on    
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6. Select Surfaces from the Display menu . Click on Add and choose electrostatic 

potential map from the menu. Make certain that Global Surfaces is checked. Do not 
close the Surfaces dialog. 

7. You donôt need to submit, as graphics calculations will be performed ñon-the-flyò. 

When completed select Spreadsheet from the Display menu , and check the box 

to the left of the label for both entries. This allows both molecules to be displayed 

simultaneously on screen. By default, the motions of the two molecules are coupled. 
To uncouple their motions allowing the two molecules to be moved independently, 

select (turn off) Coupled from the Model menu. Orient each molecule so that you can 
clearly see the benzene face (exposed face in the case of the organometallic). 

8. Check electrostatic potential map in the Surfaces dialog. Compare electrostatic 

potential maps for both free and complexed benzene, with attention to the exposed 

benzene face.* Does the Cr(CO)3 group donate or withdraw electrons from the ring? 
Would you expect the aromatic ring in benzene chromium tricarbonyl to be more or 

less susceptible to electrophilic attack than free benzene? More or less susceptible to 
nucleophilic attack? 

9. Close all documents and any open dialogs. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

*  Electrostatic potential maps (as well as other maps) for molecules in a single Spartan document will be 

put onto the same (color) scale. This allows comparisons to be made among different members. 
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Indenyl Effect 

Substitution of one of the carbonyl ligands in cyclopentadienyl manganese tricarbonyl by 

another two-electron donor ligand may either proceed via an associative or dissociative 

mechanism. At first glance both mechanisms would seem to be unfavorable, the dissociative 

pathway because it involves a 16-electron intermediate and the associative pathway because 

it passes through a 20-electron intermediate. However, the associative mechanism may not 

be as bad as it first appears as it might be possible to reduce the coordination of the 

cyclopentadienyl ring from h5 to h3 giving rise to an 18-electron association intermediate. 

 
 

Such a possibility is supported by the observation that substitution of cyclopentadienyl by 

an indenyl ligand leads to increased association rates. The indenyl effect as it is known, is 

attributed to the possibility of enhanced aromaticity of h3 coordinated indenyl relative to h5 

indenyl. 
 

 

In this tutorial, you will use the PM3 model to calculate geometries for the reactants, 

intermediates and products for associative ligand exchange by trimethyl phosphine of 

cyclopentadienyl and indenyl manganese tricarbonyl complexes, and then the wB97X-D/6-

31G* model to calculate energies. 

20 mins 
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1. Build all eight molecules (the two reactant complexes, the two intermediates and the 

two product complexes as well as trimethyl phosphine and carbon monoxide) and 

put into a single Spartan document. Assume h5 coordination of cyclopentadienyl 

and indenyl ligands in reactants and products and h3 coordination for the two 

intermediates. h5 cyclopentadienyl is available from the Ligands menu, and h5 

indenyl is in the ligands document accessed by clicking on ( ) to the right of More. 

h3 cyclopentadienyl and h3 indenyl ligands are not available from menus and need 

to be built. To build h3 cyclopentadienyl, first complex an (h3) allyl ligand to 

manganese, move to the organic builder, add sp2 carbons (  ) to both inward 

pointing allyl free valences, click on Make Bond ( ) and then on the double free 

valences on the two fragments that you have just added. To build the h3 indenyl 

complex, start with the h3 cyclopentadienyl complex, select Benzene from the Rings 

menu (in the Organic builder) and double click on the ñdouble bondò in the allyl 

ligand. Make certain that you minimize the energy of each of the eight structures 

before proceeding to the next step. 

2. Select Calculations from the Setup menu and specify calculation of equilibrium 

geometry using the semi-empirical PM3 model. Make certain the Global 

Calculations at the bottom of the dialog is checked. Submit the job with the name 

indenyl effect. 

3. When completed (a few minutes at most), compare the structure of the two reactants 

(or products) with those of the corresponding intermediates. Verify that the 

cyclopentadienyl and indenyl ligands have shifted from h5 to h3 coordination. 

4. Reenter the Calculations dialog (Calculations under the Setup menu) and specify 

calculation of energy using the wB97X-D/ 6-31G* density functional model. 

Resubmit the job. The eight calculations will require several minutes to complete.* 
 

5. Use the reaction energy calculator (Reactions from the Display menu) to calculate 

the energy of ligand substitution in both complexes. Is trimethyl phosphine a ñbetterò 

or ñworseò ligand than carbon monoxide? Is the difference diminished or exaggerated 

in the indenyl complex relative to that in the cyclopentadienyl complex? Next 

calculate the energy of the two intermediates. Relative to reactants, which is more 

stable, trimethyl phosphine cyclopentadienyl manganese tricarbonyl or trimethyl 

phosphine indenyl manganese tricarbonyl? 

6. Close indenyl effect and any open dialogs. 
 

 

*  You could do the geometry and energy calculations in a single step. Inside the Calculations dialog, specify 

energy with the wB97X-D/6-31G* density functional model and set the menus to the right of Start From to 

Equilibrium Geometry , Semi-Empirical , and PM3. Of course, this does not allow you to examine the 

geometries before doing the density functional calculations. 
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Chapter 11 
Chemical Reactions 

 

This chapter outlines and illustrates strategies for locating and verifying transition states 

for reactions as well as exploring changes in product distributions as a function of 

substituents and reactant stereochemistry. 

The treatment of chemical reactions adds an entirely new dimension to the application of 

quantum chemical models. While unique valence structures may generally be written for 

most molecules and based on these structures, reasonable guesses at bond lengths and angles 

may be made, it is often difficult to designate appropriate valence structures for transition 

states, let alone specify detailed geometries. There is a complete absence of experimental 

data for the structures of transition states. However, transition-state geometries may be 

calculated. To aid in guessing starting geometries, Spartan provides both a small library of 

calculated transition-state structures for common reactions and a facility for automatically 

matching an entry in this library with the reaction at hand.* The Spartan Reaction Database 

(SRD) as the library is called, also can be searched by substructure to yield all available 

transition states of reactions related to the one of interest. 

Spartan also provides a procedure for driving user-defined coordinates. Aside from 

conformational analysis (see discussion in Chapter 12), the major application of this is to 

force reactions, thereby permitting identification of transition states. 

The tutorials in this chapter illustrate Spartanôs automatic procedure for guessing transition-

state geometries based on SRD. They also illustrate the use of vibrational analysis (infrared 

spectroscopy) to verify that a particular structure indeed corresponds to a transition state and 

to show the motion leading it to reactants and products. 

The first four tutorials examine simple organic reactions, while the fifth tutorial provides an 

example of a transition state calculation for an organometallic reaction. The sixth tutorial 

illustrates how a reaction may be driven through a transition state. This tutorial, along with 

the fourth tutorial, draw the connection between relative activation energies and kinetic 

product distributions. The last tutorial in this chapter illustrates how transition states may be 

extracted from the Spartan Reaction Database. 
 

 

 

*Where a reaction is unknown to Spartanôs library, a fallback technique which averages reactant and product 

geometries (similar to the so-called linear synchronous transit method) is invoked. 
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Ene Reaction of 1-Pentene 

 

 

 

 

The proposed mechanism of the ene reaction involves simultaneous transfer of a hydrogen 

atom and CC bond cleavage. In this tutorial, you will obtain the transition state for the ene 

reaction of 1-pentene from an HF/3-21G calculation, and examine the reaction coordinate 

for evidence of concerted motion. While the HF/3-21G model is a less rigorous model than 

many available in Spartan, it is certainly good enough to illustrate the steps involved in 

obtaining and verifying a transition state. 

 

1. Build 1-pentene in a conformation in which one of the terminal hydrogens on the 

ethyl group is poised to transfer to the terminal methylene group. To rotate about a 

(single) bond, first click on it to select (the bond will be encircled by a red arrow), 

and drag the mouse up or down in the area below  at the left of the screen. 

Alternatively, hold down the left button and Alt key (option key on Mac) and drag 

the mouse up and down. Click on . 

2. Select Guess Transition State from the Build menu ( ). Click on bond a in the 

figure on the following page and then click on bond b. A curved arrow from double 

bond a to single bond b will be drawn. Next, click on bond c and then on bond d. A 

second curved arrow from bonds c to d will be drawn. Finally, click on bond e and 

then, click on the (methyl) hydrogen to be transferred and on the terminal 

(methylene) carbon to receive this hydrogen. A third curved arrow from bond e to 

the center of a dotted line that has been drawn between the hydrogen and oxygen 

will appear. 

 

 

 

  

10 mins 
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If you make a mistake, you can remove an arrow by selecting Delete from the Build menu 

 and then clicking on the arrow. Alternatively, hold down the Delete key as you click 

on an arrow. Select  to continue. With all three arrows in place, click on  at the 

bottom right of the screen. Your structure will be replaced by a guess at the ene transition 

state. If the resulting structure is unreasonable, then you have probably made an error in 

the placement of the arrows. Select Undo from the Edit menu  to return to the model 

with the arrows and modify (if needed). 

 

 

 

   

 

Click on        to generate a transition state guess; return to . 

 

 

Undo is reserved for moving back from the transition-state 

structure (rather than from undoing reaction arrow placements). 

You could also have used the 2D sketcher to provide the guess to 

the ene transition-state. Enter the sketcher  and draw 1-pentene. 

2D sketches, do not include hydrogens and you need to draw a CH 

bond from the terminal sp3 carbon (C5). 

Click on in the icon bar above the sketch pane. Click on the 

CH bond and then on both H and the terminal sp2 carbon (C1). An 

arrow will be drawn. Click on the C1C2 bond and then on the C2C3 

bond. A second arrow will be drawn. Click on the C3C4 bond and 

then on the C4C5 bond giving the third and final arrow. 
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3. Select Calculations... from the Setup menu , and specify calculation of 

transition-state geometry using the HF/3-21G model. Select Transition State 

Geometry from the top menu immediately to the right of Calculate and choose 

Hartree-Fock and 3-21G from the two bottom menus. Finally, check IR to the right 

of Compute. This will allow you to confirm that you have found a structure that 

corresponds to a transition state, and that it smoothly connects reactant and product. 

Click on Submit and name it ene reaction 1-pentene. 

4. When the job completes, animate the motion of atoms along the reaction coordinate. 

Select Spectra from the Display menu , click on         in the bar at the top of the 

spectra pane and from the IR tab, click on            in the palette that results. 

Click on        (Tables) at the left of the spectra pane to bring up a table of frequencies 

and intensities. 

Click the top entry in the list. It corresponds to an imaginary frequency and will be 

designated with an i in front of the number. 
 

 

 

 

 

 

 

 

 

Is the vibrational motion consistent with an ene reaction of interest and not with some other 

process? 

Within the harmonic approximation, a vibrational frequency is 

proportional to the square root of the ratio of the force constant 

(reflecting the curvature of the potential surface along a particular 

coordinate) divided by a combination of the masses of atoms involved 

in motion along that coordinate. At a transition state (a maximum in the 

reaction coordinate), the curvature is negative. Since the mass term is 

positive the quantity inside the square root is negative and the frequency is 

an imaginary number. 
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5. Click on  (Make List) at the left of the spectra pane. Controls in the dialog that 

result allow for changing both the amplitude of vibration (Amp) and the number of 

steps that make up the motion (Steps). The default number of steps (11) is fine but 

change the default amplitude. Click inside the box to the right of Amp: and enter 0.3 

using the number pad that appears. Next, click on Make List at the bottom of the 

dialog. This will give rise to a group of 11 structures that follow the reaction 

coordinate down from the transition state (structure 6) both toward reactant and 

product. You are done with ene reaction 1-pentene, so close it. 

6. Click on the list document, select Calculations... from the Setup menu  and 

specify calculation of Energy using the HF/3-21G model (the same level of 

calculation used to obtain the transition state and calculate the frequencies). Make 

certain that Global Calculations is checked and click on OK . Select Surfaces from 

the Setup menu  and specify evaluation of a bond density surface. Click on More 

Surfaces..., select density (bond) for Surface and none for Property. Before you 

click on OK , make certain that Global Surfaces is checked. 

7. Submit the calculation*. Name it ene reaction 1-pentene sequence. Once the job has 

completed, enter the Surfaces dialog, check the box to the left of density and 

examine the surface that you have calculated. Step through the sequence of structures  

 and  keys at the bottom of the screen or animate the reaction . Note, in 

particular, the changes in bonding revealed by the bond density surface. 

8. Close ene reaction 1-pentene sequence and any open dialogs. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

*  In this example, you have requested graphical surfaces prior to submitting the calculation. 

You could also have requested them to be done ñon-the-flyò following the calculation. 
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SN2 Reaction of Bromide and Methyl Chloride 

The SN2 reaction passes through a transition state in which carbon is in a trigonal bipyramid 

geometry and the entering and leaving groups are colinear. In this tutorial, we will identify 

it as the ñtopò of a pathway leading smoothly from reactants to products, employing a semi-

empirical molecular orbital model in order to minimize calculation time. 
 

5 mins 
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1. Bring up the inorganic builder by selecting New from the File menu      and clicking 

on the Inorganic tab click on the atom bar, select C from the Periodic Table and the 

five-coordinate trigonal bipyramid  from the list of atomic hybrids and click on 

screen. Move to the organic builder (click on the Organic tab). Select Cl and click on 

one of the axial free valences. Select Br and click on the other axial free valence. 

2. Select Measure Distance from the Geometry menu  and then click on the C-Br 

bond. Click inside the box to the right of Length at the bottom right of the screen and 

enter 3.8 (3.8Å) using the number pad that appears. You have made a complex 

representing the reactant. 

3. Select Constrain Distance from the Geometry menu . Click on the CBr bond, and 

then click on     at the bottom right of the screen. The icon will change to      which 

indicates a constraint is to be applied to this distance. Check the box to the left of 

Profile at the bottom of right of the screen. This will result in two additional text boxes. 
 

 

Leave the value 3.8 (3.8Å) in the leftmost box alone but change the number in the box to 

the right of to, to 1.9 (1.9Å). Click inside the box and use the number pad. In the same way, 

change the number in the box to the right of Steps from 10 (the default) to 20. Twenty 

calculations with C-Br bond lengths constrained from 3.8Å (the starting point) to 1.9Å (the 

ending point) will be performed. The transition state should have a C-Br distance in between 

these values. Click on . 

4. Select Calculations... from the Setup menu , and select Energy Profile, Semi-

Empirical and AM1 from the appropriate menus to the right of Calculate in the dialog 

that results. Make sure to change Total Charge to Anion. 

5. Submit the job. Name it bromide+methyl chloride. When completed, it will give rise 

to a sequence of calculations placed in bromide+methyl chloride.Prof.M0001. You 

will be prompted as to whether you want to Open, Save, or Discard this file. Click on 

Open. You can close the first document bromide+methyl chloride. 

6. Align the molecules that make up the sequence. Click on  (Geometry menu), select 

Structure from the menu at the bottom right of the screen and, one after the other, 

click on the chlorine, the carbon and one of the hydrogens. Finally click the Align by 

button at the bottom right of the screen. Click on . Use the  and  keys at the 

bottom left of the screen to step through the reaction sequence. 

7. Select Spreadsheet from the Display menu . Click on Add.... Select E(kJ/mol) 

from among the quantities listed in the Molecule tab. Next, enter the (constrained) C-

Br distances and bromine charges in the spreadsheet. Select Constrain Distance from 

the Geometry menu      , click on the constraint marker in the model and click on         at 
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the bottom right of the screen. Click on . Select Properties from the Display menu 

to bring up a Properties dialog. Click on bromine and click on     to the left of 

Electrostatic under Charges in the Atom Properties dialog. Close the Atom 

Properties dialog. Close the spreadsheet. 

8. Select Plots from the Display menu ( ) to bring up the Plots dialog and click on      

     in the bar at the top of the dialog. Select   Constraint (Con1) (the distance at 

which the C-Br bond has been constrained) from the X Axis menu, and both E 

(kJ/mol) and Electrostatic (Br1) from the YAxes list in the dialog that results. Click 

on Create. By default, only the data points are displayed.  

Click on  in the bar at the top of the plots plane, select Point- to-Point and then 

click the down arrow to the right of the y-axis field and again, choose Point-to-Point, 

then click on Done. The visual quality of the plot can be improved by customizing the 

X-Axis Range, the left arrow icon at the top: 

can be used to move the plot into the 3D space (with the molecules), and the Properties 

dialog can be employed to enable further customization (click on the plot to select 

either Plot or Curve Properties. 

One plot gives the energy as the reaction proceeds and the other gives charge on 

bromine. Are the two related? Explain. It might make sense to reverse the X-Axis, and 

display instead from 4.0 to 1.7 Ångstroms (as this more closely resembles a reaction 

coordinate: 

 

9. Close all documents and any open dialogs. 
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Carbene Additions to Alkenes 

 

          
Singlet carbenes add to alkenes to yield cyclopropanes. A singlet carbene possesses both a 

high-energy occupied molecular orbital in the plane of the molecule, and a low-energy, out-

of-plane unoccupied molecular orbital, and the reaction presents an interesting dilemma. It 

is clearly more advantageous for the low-lying vacant orbital on  the carbene, and not the 

high-lying filled orbital, to interact with the olefin p system during its approach. 

 
 
However, this leads to a product with an incorrect geometry, suggesting that the carbene 

needs to twist by 90° during the course of reaction. 

 

         

In this tutorial, you will use the Hartree-Fock 3-21G model to obtain the transition state for 

addition of singlet difluorocarbene, CF2, to ethylene and then analyze the motion of the 

fragments. 

1. Build ethylene using the organic model kit. 

2. Select  from the model kit. Hold down the Insert key (option key on Mac) and 

then click anywhere on screen. Alternatively, double click on a blank area of the screen. 
Next, select  from the model kit and click on two of the free valences on the sp3 

carbon. Next, click on  and click on one of the remaining two free valences on the 

sp3 carbon.  

5 mins 
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Click on  and click on the remaining free valence. You are left with two fragments, 

ethylene and difluorocarbene. Orient the two as to be poised for reaction.* 
 

 

 

3. Select Guess Transition State from the Build menu ( ). Click on the carbon on the 

CF2 fragment and then click on the closer of the carbons on the ethylene fragment and 

finally click on the CF2 carbon again. A dotted line is drawn between the two carbons 

that are to be bonded along with an arrow from the CF2 carbon to the center of this 

line. 

                                                        
Click on the CC double bond and then click on the other ethylene carbon and on the 

CF2 carbon. A second dotted line and arrow will be drawn. 

                                                               
 

Click on  at the bottom right of the screen. Your structure will be replaced by a 

guess at the transition state. 
 

 

*  Proper orientation of the two fragments is not crucial in this case but is primarily to allow you to associate 

the arrows with the intended reaction. Proper orientation is, however, essential where different 

stereochemical outcomes are possible. 

Translations and rotations normally refer to the complete set of 

fragments, but if you click on a fragment (not on a free valence) 

to select it and then hold down the Ctrl key they will refer to an 

individual fragment. 
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4. Select Calculations... from the Setup menu , and request calculation of a 

Transition State Geometry using the HF/3-21G model. Check IR to the right of 

Compute and click on Submit. Name the job difluorocarbene+ethylene. 

5. When the job is complete, examine the geometry of the transition state. In light of the 

previous discussion, would you describe your structure as corresponding to an early or 

late transition state? Animate the vibration that corresponds to the reaction coordinate. 

Select Spectra from the Display menu . Click on the  in the bar at the top of 

the spectra pane and select  from the resulting palette of choices. The 

ñinfrared spectrumò calculated for the transition state appears. Click on  at the far 

left of the spectra pane. This brings up a table of calculated frequencies and infrared 

intensities. The frequency at the top of the list should be preceded by an ñiò designating 

it as imaginary. It corresponds to the reaction coordinate. Note the value of this 

frequency as well as that of the largest frequency. 

Click in the check box corresponding to this frequency. Does the animation show that 

the carbene reorients as it approaches the double bond? Turn the animation off by 

again clicking in the imaginary frequency box. Close the Spectra pane and click on 

. 

6. Select Properties from the Display menu  and, in turn, click on each of the four 

hydrogens in the transition state. Change the value in the Mass Number menu in the 

Atom Properties dialog (Properties under the Display menu) from 1 to 2 Deuterium. 

Resubmit the job. (No additional quantum chemical calculations are involved, but the 

vibrational analysis needs to be repeated.) When complete, examine the new set of 

vibrational frequencies, in particular, the imaginary frequency associated with the 

reaction coordinate. For comparison, examine the largest frequencies which 

corresponds to one combination of CH stretching motions. You will see that the value 

of the former has barely changed as hydrogen motions are not significantly involved 

in the addition reaction, whereas the latter has been markedly reduced. 

7. Close difluorocarbene+ethylene and any open dialogs. 
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Stereospecific Diels-Alder Reactions 

 

 
Diels-Alder cycloaddition of 5-substituted cyclopentadienes with acrylonitrile can lead to 

four stereo products, in which the substituent, X, at the 5 position is syn or anti to the 

dienophile, and the nitrile is endo or exo. Anti products are preferred when X is alkyl while 

syn products are favored when X is halogen or alkoxy. In general, endo adducts are 

kinetically favored over exo adducts (see following tutorial). 

In this tutorial, you will use HF/3-21G molecular orbital calculations to obtain both syn and 

anti endo and exo transition states for Diels- Alder cycloaddition of 5-fluorocyclopentadiene 

and acrylonitrile and then use wB97X-D/6-31G* calculations to estimate relative activation 

energies. We will use the stereoisomer generation tool first introduced in the previous 

release (Spartanô20) to simplify the steps. 

1. Build or sketch the substituted norbornene shown below (the product of endo 

addition of cyclopentadiene and acrylonitrile). Click on . 

 

 

 

 

 

2. Select Transition State from the Build menu . Click on bond a (see figure 

above) and then on bond b. A curved arrow will be drawn from a to b. Next, click 

on bond c and then on bond d; a second curved arrow from c to d be drawn. Finally, 

click on bond e and then on bond f, leading to a third curved arrow. The model on 

screen should now appear as follows: 

 

15 mins 
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3. Select Generate Isomers from the Geometry menu and click on the following two 

carbons: #1 the carbon atom bonded to the cyano group, and #2 the carbon atom 

bonded to fluorine (in the drawing below, these are labeled C5 and C7) , this is not 

necessarily the same numbering as your transition state)in the transition state structure 

(which will be marked as chiral centers). They will be identified with green circles: 

 

 

Click on Generate List to the right of Isomers at the bottom right of the screen, select 

New Document in the dialog that appears and click on OK . A list of the four 

stereoisomers will appear in a new document. 

4. For each entry in the new list file, visit the Build menu Guess Transition States entry. 

The arrows for the Diels-Alder reaction are available for each stereoisomer, as these 

were part of the model before the isomers were generated. One after the next, enter the 

Guess Transition State mode and click the Transition State icon from the lower 

right of the Spartan interface: 

 

  

5. Once you have performed the guess transition state procedure for each potential 

stereoisomer, Select Calculations from the Setup menu. Specify Energy at Ground 

state in Gas from the three top menus to the right of Calculate and with Density 

Functional, wB97X-D and 6-31G* from the three bottom menus. Select Transition 

State Geometry using Hartree-Fock and 3-21G from the three menus to the right of 

Start From . You have requested that transition state geometries for the four 

stereoisomers be calculated with the HF/3-21G model and following that energies 

calculated using the wB97X-D/6-31G* density functional model. Make certain that 

Global Calculations at the bottom of the dialog is checked and click on Submit. Name 

the job Diels-Alder stereochemistry. 

6. Once the calculations complete, select Spreadsheet from the Display menu. If the 

calculation returns with an error message related to maximum transition state cycles 

or running out of optimization cycles, you may need to resubmit the job to complete 

all 4 transition states. You can if you like replace the default labels (M0001, ...) by 
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proper identifiers (syn endo, syn exo, anti endo, anti  exo), to fit the stereoisomers. 

Click on Add at the bottom of the spreadsheet, and then on Energy (au) in the dialog 

that results. Identify the isomer with the lowest (most negative) energy and click on its 

label to select it. Again click on Add and then the Molecule List tab at the top of the 

dialog that results and finally click on ȹE (kJ/mol) under Energy from Molecule. 

What comments can you make on the relative stability of the transition states 

(kinetics)? 

7. Close all documents and any open dialogs. 

 

Ziegler-Natta Polymerization of Ethylene 

Ziegler-Natta polymerization involves a metallocene. This complexes an olefin, which in 

turn inserts into the metal-alkyl bond. 

 

 

                                             

 

In this tutorial, you will use the semi-empirical PM3 model to obtain a transition state for 

insertion of ethylene into Cp2ZrCH3
+ and, estimate the activation energy using the  ̟B97X-

D/6-31G* density functional model. 

 

1. Select New Build from the File menu  and then Inorganic from the menu at the 

top of the model kit. Click on the atom bar and select Zr from the Periodic Table. 

Select  from the list of hybrids (top right of the palette). 

Double-click on screen to insert the planar trigonal Zr  atom. Select Cyclopentadienyl 

from the Ligands menu and click on two (of the three) free valences on zirconium. 

2. Select Organic from the menu at the top of the model kit to move to the organic model 

kit. Select sp3 carbon           and click on the remaining free valence on zirconium. 

Select Alkenyl from the Groups menu, hold down the Insert key (option key on Mac) 

and click anywhere on screen -or- double-click in a blank area on screen. 

3. Orient the two fragments (Cp2ZrCH3 and ethylene) as shown below: 

 

 

 

(To move the fragments independently, hold down the Ctrl key and use the mouse 

while in the Edit Build mode.) 

30 mins 
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3 

4. Select Guess Transition State from the Build menu . Click on the ZrC (methyl) 

bond and one after another, click on the methyl carbon and on one of the ethylene 

carbons. Next, click on the ethylene double bond and, one after another, click on the 

other ethylene carbon and on zirconium. Click on  at the bottom right of the 

screen. In a few seconds, a guess at the transition state appears. 

5. Select Calculations... from the Setup menu . Specify a transition state geometry 

calculation using the PM3 semi- empirical model. Change Total Charge to Cation 

and check IR to the right of Compute. Click on Submit and name the job Cp2ZrMe 

cation + ethylene. 

6. When the job completes, select Spectra (Display) menu . Click on the        in the 

bar at the top of the spectra pane and, from the IR tab, select      .  

7. Calculated infrared spectrum for the transition state appears. Click on  at the far 

left of the spectra pane. This brings up a list of calculated frequencies and infrared 

intensities. The frequency value at the top of the list should be preceded by an ñiò, 

designating it as imaginary. Click on this frequency and examine the vibrational 

motion. 

8. Perform density functional energy calculations using PM3 geometries to obtain a 

better estimate for the energy barrier for ethylene insertion. Select Save As from the 

File menu  to make a copy of Cp2ZrMe cation+ethylene; name it Cp2ZrMe 

cation+ethylene density functional. Select Calculations... from the Setup menu 

 and specify calculation of energy using the ɤB97X-D/6-31G* density 

functional model. Spartan will automatically make use of a pseudopotential for Zr 

instead of the all-electron 6-31G* basis set. Remove the checkmark on IR (to the 

right of Compute). Total Charge should still be set to Cation. Click on Submit. 

9. While you are waiting for the energy calculation to complete, build both ethylene 

and Cp2ZrCH3
+ (name them ethylene density functional and Cp2ZrMe cation, 

respectively). For Cp2ZrCH+, start with three-coordinate trigonal Zr, and then add 

two cyclopentadienyl ligands and a tetrahedral carbon. For both, select 

Calculations... from the Setup menu , and specify calculation of Energy using 

the wB97X-D/6-31G* density functional model. Select Equilibrium Geometry , 

Semi-Empirical and PM3 from the three menus to the right of Start From to 

designate use of a PM3 geometry. For Cp2ZrMe cation density functional (only), 

set Total Charge to Cation. Make certain that Global Calculations at the bottom 

of the Calculations dialog is not checked. 

10. Submit both jobs. When they have completed, calculate an activation energy for the 

insertion reaction (subtract the sum of the energies of ethylene and Cp2ZrMe cation 

from the energy of the calculated transition state). If you copy the reactants to the 

same file as the transition state, you can use the Reactions tool from the Display 

menu, to calculate the activation energy. 
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10.  Close all documents and any open dialogs. 

 

Thermodynamic vs. Kinetic Control 

 

Chemical reactions may yield different products depending on the conditions under which 

they are carried out. High temperatures and long reaction times favor the most stable 

(thermodynamic) products, whereas low temperatures and short reaction times favor the 

most readily formed (kinetic) products. For example, the kinetic product in Diels-Alder 

cycloaddition of cyclopentadiene and maleic anhydride is the endo adduct. Whereas it seems 

likely that the less-crowded exo adduct is the thermodynamic product. 

Here you will first obtain pathways for reactions leading to both endo and exo adducts using 

the PM3 semi-empirical model and then follow these by wB97X-D/6-31G* energy 

calculations to get a better estimate of the difference in activation energies. 

 

 

1. Build or sketch the endo Diels-Alder adduct of cyclopentadiene and maleic anhydride. 

2. Select Constrain Distance from the Geometry menu     , and click on bond a in the 

figure from the previous page. Click on       at the bottom right of the screen (it will 

then turn to ). Check the box to the left of Profile in the middle of the screen. This 

will give rise to three additional check boxes. Change the value in the leftmost box to 

1.5Å by clicking inside the box and entering 1.5 using the number pad. In the same 

way, enter 2.7 (2.7Å) and 13 (13 steps) into the boxes to the right of to and Steps, 

respectively. You have specified that bond a will be constrained first to 1.5Å, then to 

1.6Å, then to 1.7Å, etc. and finally to 2.7Å. Click on .  

3. Repeat the process for bond b. When you are done, both bonds a and b will be 

constrained from 1.5Å to 2.7Å in 13 equal steps. Click on . 

4. Select Calculations... from the Setup menu  and select Energy Profile from the 

top menu to the right of Calculate, and Semi-Empirical and PM3 from the two 

bottom menus in the dialog that results. Click on Submit at the bottom of the dialog. 

Name it cyclopentadiene + maleic anhydride endo. 

15 mins 
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5. When completed, Spartan will prompt you that an auxiliary file has been created; 

chose to Open the file. The new document contains the 13 calculations corresponding 

to the 13 steps in the energy profile. 

6. Select Spreadsheet from the Display menu , and click on Add... at the bottom of 

the spreadsheet. Select ȹE (kJ/mol) from among the entries in the Molecule List tab 

and click on the spreadsheet to release the Add menu. Next, click on Constrain 

Distance from the Geometry menu   and click on one of the two CC bonds varied 

in the energy profile. Click on     at the bottom right of the screen. Close the 

spreadsheet by again selecting it or clicking on  or by clicking on     at the top 

right. Click on . Select Plots from the Display menu  and click on  to bring 

up the Add Plots dialog. Select Constraint (Con1) from among the items in the X 

Axis menu and ȹE (kJ/ mol) from the Y Axes list and click on Create. By default, 

only the data points are displayed. Click on  in the bar at the top of the plots plane, 

select Point-to-Point in the resulting Edit Plot dialog and then click on Done. 

 

Identify both the reactant and transition state from the plot and estimate the activation 

energy for the cycloaddition reaction. 

7. Repeat steps 1 to 6 for the exo adduct. Compare the activation energy for exo addition 

to that for endo addition (above). What is the kinetic product? 

8. Open cyclopentadiene+maleic anhydride endo.Prof.M0001 . Make a copy . 

Name it cyclopentadiene +maleic anhydride endo DFT. Select Calculations from the 

Setup menu  and specify an energy calculation with the wB97X-D/ 6-31G* model 

in the dialog that results. Make sure that Global Calculations at the bottom of the 

dialog is checked. Click on Submit. When completed, perform the same spreadsheet 

and plot operations you did for the PM3 calculations. 
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9. Repeat the above procedure for the exo adduct and compare the two activation 

energies. What is the kinetic product? 

10.  Close all documents and any open dialogs. 

 

Activation Energies of Diels Alder Reactions 

 

In an earlier tutorial, Dienophiles in Diels-Alder Reactions (Chapter 8), you looked for a 

correlation between LUMO energies for a series of related dienophiles and relative rates of 

Diels-Alder cycloadditions involving cyclopentadiene. In this tutorial, you will compare 

calculated activation energies for this same set of reactions with the experimental rates. You 

will use the previous set dienophiles and obtain transition states from the Spartan Reaction 

Database (SRD). The only quantum chemical calculation that is required is for 

cyclopentadiene. 

 

1. Build or sketch cyclopentadiene. Select Append Molecule(s)... from the File menu, 

locate the file Diels-Alder dienophiles (from Chapter 8) and click on Open. If you 

have not yet completed this tutorial, you can find this file in the organic reactions 

folder inside the Tutorials* directory.  

2. Open the Spreadsheet from the Display menu . Click on the Label header cell and 

then right click and choose Rename Selected Using SSPD from the contextual menu 

that results. Close the Spreadsheet when finished.  

3. Select Calculations... from the Setup menu . Specify calculation of Equilibrium 

Geometry using the Hartree-Fock 3-21G model. Make sure the Global Calculations 

box is checked. Submit the job with the name Diels-Alder reactants. It will take a 

minute or so to complete. While the job is running, you can prepare an additional file 

with a set of transition states. 

4. Select New from the File menu    . Build cyclopentadiene, select Alkenyl from the 

Groups menu, hold down the Insert key (option key on Mac) and click on screen (or 

double click in a blank area on screen). Cyclopentadiene and ethylene will both appear 

on screen, although they will not be connected. Select Cyano from the Groups menu 

and click on one of the free valences on ethylene. Both cyclopentadiene and 

acrylonitrile will appear on screen. 
 
 

* For Windows, this directory is found in Program Files/Wavefunction/Spartan26. For security reasons, the 

program file directory is protected. Copy the folder to your desktop or to another location available to the user 

prior to opening it in Spartan. For Linux, this is found in the directory where Spartan was installed. For 

Macintosh, this is located at the top level on the Spartan26 disc image. 

1 min 
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5. Orient the two molecules such that they are poised for a Diels- Alder reaction leading 

to an endo product. 

 

 
 

        Select Reaction Query from the Search menu .* Click on the bond marked a in 

the above figure and then click on the two carbons that when connected will lead to 

the bond marked b. A dotted line will be drawn between these carbons and a curly 

arrow drawn from the center of bond a to the center of bond b. Next, click on bond c 

and then on bond d. A second arrow will be drawn. Finally, click on bond e and, 

click on the two carbons that when connected will lead to the bond marked f. A 

second dotted line and a third arrow will be drawn. 

6. Select Structure Query from the Search menu . Click on all three free valences 

on the acrylonitrile fragment. They will be replaced by orange cones, meaning that 

anything (including hydrogen) may be attached to these positions. 

7. Select Databases from the Search menu  and click on the SRD tab at the top of 

the dialog that results. This leads to the Spartan Reaction Database (SRD) dialog. 
 

 

 

 

 

 

*  Reaction Query is equivalent to Transition State for the purpose of defining curly arrows. 

It lacks the ability to automatically guess a transition state. 
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Before you begin the search, click on  to the right the Search button at the bottom 

of the dialog. This brings up the Search Options dialog. 
 

Check 3-21G under Method Filters and click on OK . Click on the Search button to 

search the Spartan Reaction Database for Diels-Alder transition states between 

cyclopentadiene and substituted acrylonitriles. 

8. When the search completes, a listing of hits appears at the right of the dialog. 

 
 

This should contain four Diels-Alder transition states for endo additions of 

cyclopentadiene and trans-1,2-dicyanoethylene, cis- 1,2-dicyanoethylene, 

tricyanoethylene and tetracyanoethylene. All need to be retrieved into a single 

document. Click on  to the right of the Retrieve button at the bottom of the dialog 

to bring up the Retrieve Options dialog. Make sure that New Document is selected 

in this dialog and click on OK . Hold down the Ctrl key, select (click on) all four Diels-

Alder transition states and click on Retrieve at the bottom of the dialog. A new 

(unnamed) document will be created. Close the file, but save it as Diels-Alder 

transition states. 
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9. As soon as the job Diels-Alder reactants completes, select Append Molecule(s)... 

from the File menu, navigate to Diels-Alder transition states and click on Open. 

10. Select Reactions from the Display menu . One after the other, calculate activation 

energies for the six Diels-Alder reactions. Use cyclopentadiene and one of the 

dienophiles for Reactants and the appropriate transition state for Transition States. 

Select Current Document under Source at the bottom of the dialog, and Activation  

Energy under Calculate, to enable display of the activation energy. Is the ordering of 

the calculated activation energies consistent with the experimental relative rates 

(available in the tutorial Diels-Alder dienophiles from Chapter 8)? 

11. Close all documents and any open dialogs. 
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Chapter 12 
Medicinal Chemistry 

 

This chapter illustrates applications of Spartan to areas of relevance to medicinal chemists. 

Medicinal chemistry is a diverse field; the common thread being its concerns with the 

design, properties and behavior of molecules that are important in biological systems. The 

tutorials in this chapter illustrate some of the roles that calculations might play. 

The first addresses simple models to estimate the rate at which molecules are transported 

between blood (hydrophilic media) and the tissue in the brain (hydrophobic media); this is 

not something that can be directly calculated, and instead we will rely first on the so-called 

polar surface area (PSA) and later refine this using electrostatic potential maps. 

The second and third tutorials use similarity analysis to identify ñnewò molecules (drugs) 

that are structurally or functionally similar to molecules with known drug action. In the 

second, involving the antihistamine terfenadine, similarity analysis is not carried out 

between molecules but between a molecule and an environment. In the third, similarity 

analysis is used to suggest compounds that ñlook likeò morphine and hence might exhibit 

similar analgesic action. 

The last tutorial accesses the RCSB Protein Data Bank (https://www.rcsb.org). While 

calculations on biopolymers (proteins and RNA/DNA strands) are limited to molecular 

mechanics models, quantum chemical calculations can be routinely applied to molecules 

bound to biopolymers. The focus is not the molecule itself, but rather the binding 

environment. This is turned into a so-called pharmacophore (a simplified representation of 

the environment); a search for other molecules that may also be consistent with this 

environment is illustrated. 

https://www.rcsb.org/
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Anticipating Blood-Brain Transport  

To be effective, a drug must be capable of transportation to its target. For orally administered 

drugs, this includes transfer through cell membranes in the intestine. In the case of most 

neural drugs, this also involves traversing the blood-brain barrier. In this tutorial, you will 

first examine how well the polar surface area (the area of space- filling model due to nitrogen 

and oxygen atoms together with any attached hydrogens) correlates with log (Cbrain/Cblood)
*. 

1. Open blood brain transport from the medicinal chemistry sub- directory (Tutorials 

directory).**  This comprises a list of drugs/ drug candidates for which experimental 

data relating to the ratio of concentrations in the brain and in the blood (Cbrain/Cblood) 

are available. These span a range of nearly 5 log units. 

2. Select Spreadsheet from the Display menu  and size the spreadsheet to show all 

compounds, several extra rows and three columns, in addition to the column of 

experimental data log(brain/blood) that is already displayed. Select Properties 

from the Display menu       and click on the QSAR tab in the dialog that results. 

Click on        (Post) to the left of PSA. Polar surface area values will fill one column 

in the spreadsheet. 

3. Click on the Add button at the bottom of the spreadsheet and select (click on) the 

Linear Regression tab at the top of the dialog that appears. Select log(brain/blood) 

from the Fit menu and click on PSA in the box under Using. Click on Apply . Select 

Properties from the Display menu  and then click on the cell labeled Fit1 at the 

bottom of the spreadsheet under the Label column. This brings up the Regression 

Properties dialog in which RMSD and R2 values are reported. The smaller RMSD 

and the closer to unity R2,the better the fit. Close the Regression Properties dialog. 
 

4. Make a plot of log(brain/blood) vs. the regression fit. Select Plots from the Display 

menu ( ). Click on  in the bar at the top of the plots pane to bring up the Plots 

dialog. Select log (brain/blood) from the X Axis menu, Fit Vals (Fit 1) from the Y 

Axes list and click on Create. Click on  and check the box to the left of Curve 

and the radio button next to Least Squares and finally the Done button. 
 

 

 

*  J. Kelder et al, Pharmaceutical Res., 16, 1514 (1999). All 19 named compounds considered in this paper 

have been included. 

**  For Windows, this directory is found in Program Files/Wavefunction/Spartan26. It must be copied to 

another location available to the user prior to opening it in Spartan. For Linux, this is found in the 

directory where Spartan was installed. For Macintosh, this is located at the top level of the Spartanô26 

disc image. 

no calculations 
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A least-squares line is drawn through the points. 

Next, you will consider an alternative definition of polar surface area based on 

electrostatic potential maps. 

5. Select Surfaces from the Display menu  and select electrostatic potential map in 

the dialog that results. An electrostatic potential map for the selected drug appears 

(maps for the remaining drugs may be seen by stepping through the list using the step 

buttons in the bottom left of the screen). The overall size and shape are that of the 

electron density and correspond roughly to a conventional space-filling model. The 

colors indicate the value of the electrostatic potential. Colors toward red designate 

areas of negative potential (where a positive charge is most likely to be attracted), 

while colors toward blue designate areas of positive potential (where a positive charge 

is least likely to be attracted). To see the molecular skeleton underneath the 

electrostatic potential map, change to a transparent or mesh display. Click on the map 

to select it and select Transparent or Mesh from the Style menu that appears at the 

bottom right of the screen. 

6. Select Properties from the Display menu . Click on the map. Click on the post  

button      to the left of P-Area the Surfaces Properties dialog that results. Polar 

areas, defined as the area for which the absolute value of the electrostatic potential is 

> 100 kJ/mol*, will be added to the spreadsheet. 

7. Click on the Add button at the bottom of the spreadsheet and click on the Linear 

Regression tab at the top of the dialog that results. Select log(brain/blood) from the 

Fit menu and click on Polar Area from the quantities in the box under Using. Click 

on Apply . Bring up the Regression Properties dialog by clicking on the cell labeled 

Fit2 under Label in the spreadsheet. Note that the R2 value is better (closer to unity) 

for this fit than for the previous fit (to PSA defined in the usual manner). Make a plot 

of log (brain/blood) vs. the new regression fit. Select Plots from the Display menu (

) and click on  in the bar at the top of the plots pane. Choose log (brain/blood) 

from the X-Axis menu and FitVals (Fit 2) from the Y Axes list and click on Create. 

Click on  and again specify Least Squares for the Curve in the Edit Plot dialog 
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and click Done. Which property provides better correlation with transport across the 

blood/brain barrier, PSA or polar area? 
 

8. Close blood brain transport and any open dialogs. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

*  This value may be changed in the Settings Preferences dialog (Preferences under the 

Options menu; Chapter 25). 
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Terfenadine. A Potassium Channel Blocker? 

Cardiovascular toxicity due to blocking of potassium ion channels is commonly screened 

early in the drug development process. One way this is done is to compare drug candidates 

to a pharmacophore deduced from 3D QSAR studies. This tutorial uses a published 

pharmacophore* to see whether the antihistamine, terfenadine should be considered a 

potential channel blocker. 

 

 
 

1. Open terfenadine similarity library from the medicinal chemistry sub-directory 

(Tutorials directory).**  This file contains the coordinates for a diverse selection of 

several hundred conformers of terfenadine (the actual number is reported in the 

Molecule Properties dialog) obtained from a similarity library calculation. It has 

been supplied in order to save computation time. Close terfenadine similarity 

library. 

2. Open potassium channel blocker pharmacophore from the medicinal chemistry 

sub-directory (Tutorials directory). This is a five-point pharmacophore comprising 

four aromatic hydrophobe centers (purple spheres) and one positive ionizable center 

(red sphere). 

 

 

 

 

 

 

*   S. Ekins et al, J. Pharmacology and Experimental Therapeutics, 301, 427 (2002). 

** For Windows, this directory is found in Program Files/Wavefunction/Spartan26. It needs to be copied to 

another location available to the user prior to opening it in Spartan. For Linux, this is found in the directory 

where Spartan was installed. For Macintosh, this is located at the top level of the Spartanô26 disc image. 

5 mins 
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3. Select Set Similarity Centers from the Geometry menu  and then select CFD 

from the menu at the bottom right of the screen next to Similarity by: . In turn, click 

on each of the (five) pharmacophore elements. In response, each will be surrounded 

by a violet circle indicating that it is to be used in the similarity analysis calculation. 

4. Select Calculations... from the Setup menu . Select Similarity Analysis from the 

top left menu to the right of Calculate inside the Calculations dialog. This leads to a 

new configuration of the Calculations dialog. 
 

Click on Add Library to bring up a file browser. Locate terfenadine similarity 

library in the medicinal chemistry sub- directory (Tutorials directory) and click on 

Open. This indicates that the library of terfenadine conformers will be searched for a 

match to the pharmacophore. Click on Submit. 

5. When the analysis has completed (a minute or so), select Similarities from the 

Display menu      to bring up the Similarities dialog, and change the Minimum 

Score to .6 or lower (to expose additional similarity matches). 
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Multiple hits will appear at the right of the dialog, together with a similarity score 

(limiting on 1.0 which means a perfect match). Click on the hit with the highest score. 

A composite graphic of terfenadine and the pharmacophore will appear in a window 

at the left of the dialog. You can manipulate the two (as a single object) in the usual 

way (you need to position the cursor inside the window). Note that the positive 

ionizable center is positioned above nitrogen, while the four aromatic hydrophobes 

are above phenyl rings and the tert-butyl group. 
 

 

6. You can retrieve a selected hit (without retrieving the pharmacophore), by clicking 

on the Retrieve button at the bottom left of the Similarities dialog. This can be used 

for further analysis. 

7. Close all open documents and dialogs. 

The scoring algorithm not only accounts for position but also for 

direction of any nitrogen or oxygen centers that overlap with (non- 

hydrophobe) pharmacophore elements. 
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Morphine. Structure vs. Pharmacophore 
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Three ñchemical aspectsò of morphine appear to be required in order for the molecule to act 

as an analgesic. These are: i) the nitrogen center (assumed to be protonated in the protein-

bound complex), ii) the aromatic ring and iii) the hydroxyl group attached to the aromatic 

ring. The loss of any of these results in significant reduction of activity. This knowledge 

may either be used directly to identify other likely analgesics based on structure, or indirectly 

to construct a simple 3-point pharmacophore that in turn may be employed to find 

compounds with potentially comparable analgesic activity. 

This tutorial comprises three parts. In the first part, you will identify molecules in the Spartan 

Spectra and Properties Database (SSPD) that incorporate the three required elements. In 

practice, you will look for molecules that incorporate a nitrogen center substituted by a 

methyl group and two other (sp3) carbons and a substituted phenol. You will then select a 

single hit and generate a conformer library for similarity analysis simply in order to save 

computer time. This is a superficial investigation. To be comprehensive, one would need to 

use several (or all) hits. 

1. Select New from the File menu      and bring up the organic model kit. Select Benzene 

from the Rings menu and double click anywhere on screen. Select sp3 oxygen   

and click on one of the free valences of benzene. You have made phenol. Select sp3 
nitrogen , double click on a blank region on screen to insert a non-bonded sp3 

nitrogen.  

Two molecules (phenol and ammonia) appear on screen. Click on sp3 carbon  

and click on all three free valences on the nitrogen. Phenol and trimethylamine now 

appear on screen. Click on . 

15 mins 
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2. Select Structure Query from the Search menu . Click on all five free valences 

on the carbons in the phenol fragment and on all three free valences on two of the 

three methyl groups and on one free valence for the remaining methyl group in the 

trimethylamine fragment. Orange cones will appear at all (twelve) selected positions. 

 

 

 

 

This defines a search in which anything can be ñgrownò from the selected positions 

(including hydrogen) but a hit must contain phenol and a nitrogen bonded to three 

sp3 carbon centers. 

3. Select Databases from the Search menu . Click on the SSPD tab in the dialog 

that results. Click on Search at the bottom of the SSPD dialog. 

4. To sort, click on Name at the top of the list inside in the scroll box at the right of the 

SSPD dialog. Locate and click on cephaeline.* 
 

 

 

 

 

 

 

 

 

 

*  The search above was done on the full å317,000 molecule SSPD. The smaller subset bundled with the 

Spartanô26 install will find significantly fewer ñhitsò. 
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Its structure will be displayed in the window at the left of the dialog. You can 

manipulate the model in the usual way by positioning the cursor inside this window. 

Click on  to the right of the Retrieve button at the bottom of the SSPD dialog to 

bring up the Retrieve Options dialog. Check New Document under Retrieve 

Options and click on OK . Finally, click on the Retrieve button. Dismiss the SSPD 

dialog either by again selecting Databases from the Search menu  or by clicking 

on        at the top right-hand corner of the SSPD dialog. 

Save the molecule you retrieved under the name cephaeline. Close the file used for 

the search (phenol and trimethylamine) without saving. 

5. For similarity library generation, it is advised to use a more restrictive 

conformational analysis routine. For this example, the molecule retrieved from the 

database has been set to do so. To confirm this, select Set Torsions from the 

Geometry menu . Your molecule should be augmented with three yellow 

cylinders (only). If this is not the case, select Preferences from the Options menu. 

In the Settings tab, switch the Conformer Rules to skeletal, and click OK . You will 

still be in the Set Torsions mode, in the lower right of the interface, click on the 

Reset button to apply the changes to your molecule. 

6. Select Calculations... from the Setup menu . Select Similarity Library from 

the top left menu to the right of Calculate. No further information is required. Click 

on Submit at the bottom of the dialog. Name it cephaeline library. You can continue 

with the tutorial while you are waiting for the job to complete. Note, however, that 

you need to close cephaeline library before it is used in Step 9. 

In the second part of this tutorial, you will specify the key structural components in 

morphine and perform a similarity analysis based on structure using the conformer 

library for cephaeline. 

7. You can either sketch morphine (much easier than building it in 3D) or to save time, 

open it: morphine from the medicinal chemistry sub-directory (Tutorials 

directory).* If you sketch it, click on  when you are done. The name should appear 

at the bottom of the screen as morphine is in SSPD. If it does not, you have made a 

mistake. 

 

8. Select Set Similarity Centers from the Geometry menu ( ) and select structure 

from the menu at the bottom right of the screen. Click on the eleven *ôed atoms in 

the figure below. These atom centers define the phenol and the primary amine 

discussed earlier. A violet circle will be drawn around each. If you accidentally select 

the wrong atom, click on the ñoffendingò circle to deselect it. 
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9. Select Calculations... from the Setup menu . Select Similarity Analysis from 

the top left menu to the right of Calculate inside the Calculations dialog. Click on 

Add Library to bring up a file browser, locate and select cephaeline library, and 

click on Open. Make certain that Structure is selected from the Use menu at the 

lower right of the dialog. You have requested that the library of cephaeline 

conformers be searched for a match to the key structural elements of morphine. Click 

on Submit. Supply the name morphine. 

10. The similarity analysis will require a few seconds. When it completes, select 

Similarities... from the Display menu . 

 

 
 

11. Hits appear in the box at the right of the dialog together with a score. Sort according 

to score (best on top) by clicking on Score at the top of the box. Select (click on) one 

of the best matches. A composite graphic consisting of morphine and the matching 

cephaeline conformer from the library will appear in a window at the left. You can 

manipulate the two structures (as a single object) in the usual way. 
 

 

*  For Windows, this directory is in Program Files/Wavefunction/Spartan26. Copy to  user-writable location. 

For Linux, this is found in the directory where Spartan was installed.  

For Macintosh, this is located at the top level of the Spartanô26 disc image. 
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Repeat the similarity analysis using CFDôs rather than structure. 

12. Select Set Similarity Centers from the Geometry menu , but this time select 

CFD from the menu at the bottom right of the screen. CFDôs will augment the 

morphine structure. 
 

 
13. Designate three of the CFDôs as similarity centers. Select (click on) the CFD over 

the phenolic oxygen. A violet circle will surround this center indicating that it is to 

be used in the similarity analysis. (If you accidentally select the wrong CFD, click 

on the circle and it will disappear.) Select (click on) the CFD at the middle of the 

phenol ring and the CFD at nitrogen. 

14. Select Calculations... from the Setup menu . This should already designate 

Similarity Analysis and the appropriate library (cephaeline). Change the entry in 

the Use menu to CFD. Click on Submit. 

15. When the analysis is complete, select Similarities... from the Display menu . 

One or more hits should appear in the box at the right of the dialog. Select a hit to 

get a composite graphic (CFD and structure from the library). You can easily see the 

extent to which the two are matched. 

16. Close any open documents and dialogs. 
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Gleevec. Making a Pharmacophore from PDB 
 

 

In this tutorial, you will start with a protein structure from the PDB in which the so-called 

protein kinase inhibitor, gleevec, is found*. Instead of abstracting the molecular structure of 

gleevec, you will abstract its ñbinding environmentò, that is, the locations from which 

gleevec interacts with the protein host in terms of hydrogen-bond or charge-charge 

interactions (non-steric contacts). This information, together with knowledge of either the 

steric requirements of the guest or the space occupied by the protein (excluded volumes), 

constitutes a structural pharmacophore, that is, a ñskeletonò into which other possible 

ñguestsò might be accommodated. 

You will then use a subset of the non-steric contacts together with excluded volume elements 

to see to what extent this pharmacophore fits another protein kinase inhibitor, flavopiridol. 
 

1. Select Access PDB Online from the File menu  to obtain the PDB file 1opj from 

the PDB or open 1opj from the medicinal chemistry sub-directory (tutorials 

directory)*. Select Extract Ligands from the File menu , click on the model for 

gleevec (it will be designated as Ligand STI 3 or 4) inside the protein structure 

(displayed as a set of transparent spheres similar to a space-filling model) to select 

it, and click on the Exact Ligands button at the lower right of the screen. Inside the 

Extract Ligands dialog, check both HBA/HBD and +/- Centers and Excluded 

Volume Centers. If any other items are selected, make certain to deselect them 

before you click on OK . 
 

 

 

 

 

*  B. Nager et. al., Cell, 112, 859 (2003): PDB identification 1opj. 

5 mins 
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2. You are finished with 1opj and may close it. Also, simplify the display of the 

extracted information by removing the excluded volume elements from view. Select 

Configure... from the Model menu  and click on the CFDs tab. Uncheck 

Excluded Volumes and click on Apply (this will hide the excluded volumes and 

leave the Configure dialog on screen). 

3. The model that now appears comprises five purple spheres representing non-steric 

contacts between gleevec and its protein host. Turn on labels. In the Configure 

dialog, click on the Labels tab, check CFD Labels and click on OK . 
 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 
*  For Windows, this directory is found in Program Files/Wavefunction/Spartan26. It must be copied to 

another location available to the user prior to opening it in Spartan. For Linux, this is found in the directory 

where Spartan was installed. For Macintosh, this is located at the top level of the Spartanô26 disc image. 
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These have been assigned based on the observation that each is within a predefined distance 

of (one or more) complementary groups from residues in the protein host. Because hydrogen 

positions are not assigned in the experimental X-ray structure it may not be possible to say 

whether a particular site on the guest is acting as a hydrogen-bond donor or acceptor. It may 

not even be possible to say whether a particular site is protonated or deprotonated (although 

pH may often dictate this). To be ñsafeò, all non-steric contacts have initially been given 

four CFD definitions: hydrogen-bond acceptor (HBA ), hydrogen-bond donor (HBD), 

positive ionizable (+) and negative ionizable (ï). Examination of the structure of gleevec 

suggests more focused assignments: 1 (HBA , +), 2 (HBA ), 3 (HBD), 4 (HBA ) and 5 (HBA ). 

(See previous figure for numbering.) 

4. You will use only three elements of this pharmacophore (together with the excluded 

volume elements) to assess whether or not flavopiridol is likely to fit into the same 

host environment as gleevec. Select Properties from the Display menu . Click 

on CFD1, remove the checks next to HBD and -Ionizable (leaving HBA and 

+Ionizable). Repeat the process, designating CFD3 as HBD only, and CFD5 as 

HBD only. Next, select Set Similarity Centers from the Geometry menu . 

Ensure that the CFD (not Structure) is selected in the lower right corner of the 

screen. Click CFDs 1, 3, and 5. A violet circle will appear on each, indicating that it 

is to be used in the similarity analysis calculation. Click on . 

Select Calculations... from the Setup menu  and then Similarity Analysis from the top 

left menu to the right of Calculate. Click on Add Library... and then locate and select 

flavopiridol in the medicinal chemistry sub-directory (Tutorials directory) and click on 

Open. Make certain that CFD is selected next to Use: in the lower right of the Calculations 

dialog. Click on Submit. Name the document flavopiridol fit to gleevec pharmacophore. 

5. When the similarity analysis has completed, select Similarities... from the Display 

menu . Sort the hits according to similarity score (click on Score at the top of the 

dialog). One after the other, click on the top scoring entries in the box to the right of 

the dialog and examine the fits in the window at the left. 

6. Close any open documents and dialogs.
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Chapter 13 
Flexible Molecules 

 

This chapter describes procedures available for calculations on flexible molecules. 

 

Up to this point, we have not paid much attention to the different conformers that molecules 

might adopt. Many of the molecules dealt with so far are rigid or dominated by a single 

conformer and, where they are not, we have chosen to downplay the importance of 

conformation. In fact, the vast majority of molecules are not rigid and knowing the ñrightò 

conformer or conformers can be important to properly describing molecular spectra and 

properties and overall chemical behavior. 

The five tutorials in this chapter illustrate a variety of approaches for dealing with flexible 

molecules. The first tutorial presents a molecule with only a single degree of 

(conformational) freedom. Here the focus is not only on identifying the ñbestò conformer, 

but also on rationalizing why it is the best. The second tutorial explores a molecule with two 

degrees of freedom. The focus here is on identifying all ñreasonableò conformers and 

comparing the ordering of energies for these conformers with different theoretical models. 

The third tutorial involves a molecule with several degrees of conformational freedom and 

hundreds of conformers. Its goal is simply to find the lowest- energy conformer using 

practical methodology. The last two tutorials have more of a chemical focus. The first of 

these asks a question about the ñpriceò that needs to be paid in order for a molecule to be 

properly oriented for an intramolecular reaction. The second asks a similar question, but this 

time with regard to a proper conformation for binding to a protein. 
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Internal Rotation in Dimethylperoxide 
 

Quantum chemical calculations may be called on to furnish data to parameterize empirical 

energy functions for use in molecular mechanics and/or molecular dynamics calculations. 

Perhaps most important are data relating to torsional motions where small changes torsional 

angles may lead to large changes in overall shape, as well as significant changes in molecular 

spectra and properties. 

Any function chosen to represent the energy of rotation about a single bond needs to reflect 

the inherent periodicity, that is, it must repeat itself in 360°. The most common choice is a 

truncated Fourier series. 

 
Etorsion (w) = ktorsion1 (1 - cos(w - weq)) + ktorsion2 (1 - cos2(w - weq)) 

+ ktorsion3 (1 - cos3(w - weq)) 
 

Here, weq is the ideal dihedral angle and ktorsion1, ktorsion2 and ktorsion3 are parameters. The first 

(one-fold) term accounts for the difference in energy between syn and anti conformers, the 

second (two-fold) term for the difference in energy between planar and perpendicular 

conformers, and the third (three-fold) term for the difference in energy between eclipsed and 

staggered conformers. 

In this tutorial, you will examine the energy for rotation about the oxygen-oxygen bond in 

dimethylperoxide, first using wB97X-D/6- 31G* density functional calculations to establish 

geometry and then using wB97X-V/6-311+G (2df,2p)[6-311G*]calculations to get a more 

accurate account. Both wB97X-D and wB97X-V functionals account for long-range 

dispersive interactions, the former by an empirical correction and the latter more properly 

by explicit calculation. The 6-311+G(2df,2p) basis set is much more flexible than 6-31G*, 

but the calculation can be simplified using the so-called dual-basis set approximation where 

convergence is first reached with the smaller 6-311G* basis set. You will fit your data to a 

truncated Fourier series. 

25 mins 
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1. Build dimethylperoxide. If the molecule is not already in an anti-conformation, 

select Measure Dihedral from the Geometry menu , click on COOC atoms in 

order, click inside the box to the right of Dihedral... and enter 180 (180°) using the 

number pad that appears. Do not minimize. 

2. Select Constrain Dihedral from the Geometry menu . Select the COOC torsion 

(click on COOC atoms in order), and then click on    at the bottom right of the 

screen. The icon will change to       indicating that a dihedral constraint is to be 

applied. 

3. Check the box to the left of Profile at the bottom right of the screen. This will result 

in two additional text boxes. 

 

Leave 180° in the original (leftmost) box alone but change the value in the box to the right 

of ñtoò to 0°. Click inside the box and enter 0 using the number pad. Steps should be 10. If 

it is not, click inside the box and enter 10 using the number pad. What you have specified is 

that the dihedral angle will be constrained first to 180°, then to 160°*, etc. and finally to 0°. 

Click on . 

4. Select Calculations... from the Setup menu  and specify Energy Profile from 

the top menu to the right of Calculate, and Density-Functional, wB97X-D and 6-

31G* from the three bottom menus. Click on Submit and accept the name 

dimethylperoxide. 

5. When the 10 calculations have completed (perhaps 5 minutes), they return in a new 

file named dimethylperoxide.Prof.M0001. A prompt will ask you if you want to 

open this auxiliary file. Click on Open. Align the conformers. Select Align from the 

Geometry menu , select Structure from the Align by menu at the bottom right 

of the screen and, one after the other, click on both oxygens and on one of the 

carbons. Then click on the Align by button at the bottom right of the screen. Select 

Spreadsheet from the Display menu , and enter both the energies relative to the 

180° conformer, and the COOC dihedral angles. First click on the label (M0001) for 

the top entry in the spreadsheet (the 180° conformer), then click on the header cell 

for the leftmost blank column, and finally, click on Add... at the bottom of the 

spreadsheet. Select ȹE (kJ/mol) from the quantities in the Molecule List tab (under 

Energy from Molecule) and click on the spreadsheet to release the dialog. Enter the 

dihedral angle constraints: select Constrain Dihedral (Geometry) menu , click 

on the constraint marker attached to dimethylperoxide and click on  at the bottom 

of the screen (to the right of the value of the dihedral angle). Click on . 
 

 

*  The difference between constraint values is given by: (final-initial)/(steps-1). 
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6. Select Plots from the Display menu . Click on  at the top of the (empty) 

plot pane and select Constraint(Con1) from the X Axis menu and ȹE (kJ/mol) 

from the Y Axes list and then click Create. 
 

To fit the points to a Fourier series, click on  at the top of the plot pane, select Fourier 

to the right of Curve in the resulting dialog and click on Done. 

 

 
 

7. To get a better account of the energy profile for rotation about the OO bond in 

dimethylperoxide, perform calculations with the wB97X-V/6-311+G (2df,2p)[6-

311G*] density functional model* (using the equilibrium geometries that you 

obtained from the wB97X-D/6-31G* model). First, make a copy of 

dimethylperoxide.Prof.spartan. Name it dimethylperoxide wB97X-V. Select 

Calculations... from the Setup menu  and specify calculation of energy using 

the wB97X-V/6-311+G(2df,2p) density functional model. Make certain that Global 

Calculations (at the bottom of the dialog) is checked to signify that energy 

calculations are to be performed on all conformers. Click on Submit. 



192  

8. Energy calculations for all ten conformers will require several minutes to complete. 

When they are done, draw a new energy plot and compare it to the energy plot 

produced earlier. 

9. For the sake of comparison, return to the dimethylperoxide.Prof.spartan file, save a 

copy as dimethylperoxide_Est_DFT. Select Calculations... from the Setup menu 

 and specify calculation of Energy using Est. Density Functional and wB97X-

V/6-311+G(2df,2p). Make sure Current Geometry is selected from the Start From  

pull down menu. Click on Submit. 

10. The neural network energy calculations for all ten conformers will require less than 

20 seconds to complete. When they are done, draw a new energy plot and compare 

it to the energy plot produced from the model used in step 7. How well does the 

neural network reproduce the QM values? 

11. Close all documents and dialogs. 
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Ethinamate 

                       NH2 

Ethinamate is a prescription drug previously used for the treatment of insomnia. It involves 

two degrees of conformational freedom, rotation of the single bond to the carbonate group 

(two unique arrangements) and inversion of the six-member ring (two unique chair 

conformers). 

1. Build or sketch ethinamate. Click on . Select Calculations... from the Setup 

menu  and request a Conformer Distribution with Density Functional, 

wB97X-V and the 6-311+G(2df,2p)[6-311G*] basis set using wB97X-D/6-31G* 

geometry(ies). This invokes a multistep recipe, starting from a systematic conformer 

search using MMFF molecular mechanics and proceeding through several 

immediate steps to gradually reduce the number of conformers for the final energy 

calculation (click on Details to explore the steps). Click on Submit and accept the 

name ethinamate. 

2. This multi-step calculation will require several minutes to complete. When it does, 

ethinamate will display the lowest-energy conformer but the  total energy, dipole 

moment and Mulliken atomic charges* will refer to a Boltzmann weighted average 

over all accessible conformers. A new Spartan document containing these 

conformers (ethinamate_Conf) has also been returned, choose to Open the auxiliary 

file. In the new document, enter the total energies into the spreadsheet. You will see 

that the total energy of the best conformer is in fact lower than that of the Boltzmann 

averaged value (found in ethinamate).**  

3. Close any open documents and dialogs. 

 
 

 

 

 

 

 

*   Natural charges are available only for the 6-311+G(2df,2p) basis sets. Electrostatic charges are too costly 

to calculate for molecules with large numbers of accessible conformers and are deliberately excluded. 

**   This may be surprising but is necessarily the case as the Boltzmann average, while dominated 

by the lowest-energy conformer, includes contributions from higher energy conformers. 

30 mins 
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Allyl Vinyl Ether  
 

 

The Equilibrium Conformer and Conformer Distribution selections under Calculations 

in the Setup menu directly access the MMFF molecular mechanics model and either the 

wB97X-V or B97M-V density functional models with the 6-311+G(2df,2p) [6-311G*] basis 

sets. They represent the extremes in terms of cost computation and are intended to be used 

in two situations with entirely different expectations. There are numerous models and 

combinations of models in between and the purpose of this tutorial is to explore one of them. 

Here we seek a semi-quantitative account of the energy required to go from the ñbestò 

conformer of a molecule to a conformer poised for chemical reaction. This is different than 

the expectation of the following tutorial which is to accurately account for the NMR 

spectrum of a flexible molecule. 

Allyl vinyl ether undergoes Claisen rearrangement, the mechanism presumes a chair 

arrangement of the reactant. 
 

ÿ 
 

 

 

Is this the lowest-energy conformer (global minimum) or is additional energy required to 

properly orient the molecule for reaction? To find out, you need to locate all the conformers 

of allyl vinyl ether, identify the best chair structure and evaluate its energy relative to that 

of the actual global minimum. You will first carry out a conformational search using the 

MMFF molecular mechanics model and then refine relative conformer energies using 

single-point wB97X-D/6-31G* density functional calculations based on 3-21G Hartree-

Fock equilibrium geometries. The results are not expected to be as good as those obtained 

from better geometry and especially better energy calculations, but they should be sufficient 

for the objective at hand. 

5 mins 
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1. Select New       from the File menu and either build  or sketch allyl vinyl ether. 

2. Select Calculations... from the Setup menu  and specify Conformer 

Distribution from the top menu to the right of Calculate and Molecular Mechanics 

and MMFF from the two bottom menus. Click on Submit and accept the name allyl 

vinyl ether. 

3. When completed, it will give rise to a series of low-energy conformers* placed in a 

new file allyl vinyl ether_Conf.**  A prompt will ask you if you want to open this 

file. Click on Open.***  Select Spreadsheet from the Display menu . Size the 

spreadsheet such that all rows (corresponding to different conformers) are visible at 

one time. Click on Add... at the bottom of the spreadsheet. Click on the Energy 

(kJ/mol) button from the Molecule tab (you may need to change the units) and click 

on the spreadsheet (or background) to remove the Add dialog. Energies for each of 

the different conformers will be added to the spreadsheet. Examine the lowest-

energy conformer (the top entry). Is it in a chair conformation suitable for Claisen 

rearrangement? If not, identify the lowest-energy conformer that is suitable. You can 

keep two or more conformers on screen at the same time by checking the boxes 

immediately to the left of the molecule labels (the leftmost column) in the 

spreadsheet. To get a clearer idea of structural similarities and differences, align the 

conformers. Select Align from the Geometry menu  and select Structure from 

the Align by menu at the bottom right of the screen. And at bottom left, a message: 
 

Click on oxygen and on the two carbons of the vinyl group bonded to oxygen to 

designate them as alignment centers. Each will be marked by a red circle. If you 

make a mistake, click on the circle and it will disappear. When you are done, click 

on the Align by button at the bottom right of the screen. Click on . 
 

 

 

 

 

 

 

 

 

 

*  By default, only conformers within 40 kJ/mol of the global minimum will be kept. This can be changed 

(see Conformations and Energy Profiles in the Spartanô26 Help menu). 

**  M0001 is the default label of the molecule you built. You can change it by altering the Labels field in the 

Molecule Properties dialog (Properties under the Display menu; Chapter 22). 

*** To avoid confusion, it is a good idea to close the original file allyl vinyl ether. 
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4. To obtain a better estimate of the energy required to twist allyl vinyl ether into a 

conformer suitable for Claisen rearrangement, perform wB97X-D/6-31G* energy 

calculations using 3-21G geometries. Select Save As from the File menu  to make 

a copy of allyl vinyl ether_Conf. Name it allyl vinyl ether density functional. Using 

the copy, delete all conformers except the global minimum and the lowest-energy 

conformer that appears to be most closely poised for Claisen rearrangement. Select 

each conformer to be discarded, and then select Delete Molecule from the File menu 

. Alternatively, click on the cell in the spreadsheet containing the label for the 

molecule to be deleted, and then click on Delete at the bottom of the spreadsheet. 

When you are done, the spreadsheet should contain only two entries. 

5. Select Calculations... from the Setup menu  and specify an Energy calculation 

and wB97X-D Density Functional method with the 6-31G* basis set. Also, specify 

Hartree-Fock and 3-21G from the Start from menu. Make certain that Global 

Calculations at the bottom of the dialog is checked to specify that the dialog settings 

apply to both conformers. Click on Submit. 

6. When completed, examine the conformer energies. Select Spreadsheet from the 

Display menu. Click on the Add button at the bottom of the spreadsheet and click 

on the ȹE (kJ/mol) button from the Molecule List tab. Click on the spreadsheet to 

release the Add dialog. What does this model report as the energy needed to go from 

the global minimum to a conformer poised to undergo Claisen rearrangement? 

7. Close all open documents and dialogs. 
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13C Chemical Shifts Depend on Conformation 

 

At normal temperatures, the time for nuclear spin relaxation is very long relative to time 

required for equilibration among conformers. This means that for each of the carbon 

chemical shifts in the NMR spectrum of a flexible molecule, 13C, will be a weighted average 

of the shifts NMR of the individual conformers,13Ci. 

13C = Ɇi ɤi
13Ci 

The weight, ɤi, is given by the Boltzmann equation, and depends on its energy, Ůi (relative 

to that of the lowest-energy conformer, Ů0) and on temperature, T. Summation is over all 

conformers (including the lowest-energy conformer), gi is the number of times that 

conformer i appears in the overall distribution and k is the Boltzmann constant. 

ɤi = gi exp - [Ůi - Ů0/kT]/Ɇj {exp - [Ůj - Ů0/kT]} 

In practice, conformers that are 10 kJ/mol or more above the lowest- energy conformer make 

a negligible contribution to the total (at room temperature). However, in order to actually 

know which conformers are important and to construct a proper Boltzmann average, it is 

necessary to examine all of them. 

In this tutorial, you will use the 2019 QM-NMR protocol, first introduced in the Spartanô18 

release to calculate the 13C NMR spectrum of limonene. This comprises two parts, the first 

a multi-step protocol starting from MMFF molecular mechanics and ending with a series of 

large basis set density functional calculations to obtain ñaccurateò Boltzmann weights, and 

the second a set of small basis set density functional calculations to obtain 13C chemical 

shifts. The two parts are then combined to produce a Boltzmann averaged 13C spectrum. 

1. Build or sketch limonene. 

 

 
 

2. Enter experimental 13C chemical shifts (shown above) either on the sketch or 3D 

model. Select Expt. Chem. Shifts [1H/13C] from the Expt. Data menu. Click in turn 

on each carbon, click inside the box that appears to its right, use the number pad to 

type in the chemical shift and click on Enter. 

2 hours 
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3. Select Calculations... from the Setup menu, NMR Spectrum (Density 

Functional)*, wB97X-D and (6-31G*)* from the top three menus to the right of 

Calculate and wB97X-V/6-311+G(2df,2p)[6-311G*] energy and wB97X-D/ 6-

31G* geometry from the bottom two menus. Click Submit. 

The calculation may require an hour or more.**  When completed, bring up the Properties 

dialog (Display menu) and click on the NMR tab. Statistics related to the fit between 

calculated and experimental 13C shifts are provided on the left at the center of the dialog that 

results, specifically RMS, Max Absolute and Mean Absolute errors. If the Boltzmann 

Average tab is checked, these correspond to a Boltzmann weighted average over 

conformers. If the Best Fit tab is checked, they instead correspond to the conformer which 

best fits measured values. You will see that both measures provide good concurrence 

between calculated and measured 13C chemical shifts. 

 

 
 

 

 

 

*  Pre-selected menu items cannot be altered. 

** If you don't want to wait, a version of the file is available from the spectra of organic molecules directory 

in the Tutorials folder. For Windows, see Program Files/Wavefunction/Spartan26/Tutorials. It must be 

copied to another location available to the user prior to opening it in Spartan. For Linux, the Tutorials is 

found in the directory where Spartan was installed. For Macintosh, Tutorials is located at the top level of 

the Spartanô26 disc image. 

Spartan provides two different ways to assess the fit between 

calculated and measured 13C chemical shifts. The first and clearly the 

more rigorous measure involves constructing a proper Boltzmann- 

weighted average. This requires accurate conformer energies and 

associated Boltzmann weights which in turn functionals that take 

proper account of long-range interactions such as the wB97X-V 

functional and large basis sets such as 6-311+G(2df,2p). While 

such an approach can be applied to medium-size organic molecules 

with moderate conformational flexibility, it can involve many hours 

of computer time. The second approach only requires that a set of 

ñgoodò conformers be identified, and from among these selects the 

conformer 13C chemical shifts for which best fit measured values. 

Lacking the need for accurate Boltzmann weights, it can rely on 

simpler functionals such as wB97X-D where long range 

interactions are dealt with empirically and smaller basis sets such 

as 6-31G*, and as a result, is an order of magnitude faster. 
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4. The returned structure corresponds to that with the lowest energy from the wB97X-

V/6-311+G(2df,2p)[6-311G*] model (the leading contributor in the Boltzmann 

average). A secondary file, limonene_Conf, has been created (but not opened). This 

contains NMR chemical shift calculations for all conformers. Choose to either 

Discard or Save the auxiliary file. In the parent file, go to Model menu Configureé 

in the Labels tab, under Atom, click the radio button next to (Calc-Expt.) Chem 

Shift. How well does the multi-step protocol (NMR Spectrum task) do at 

reproducing the experimental shifts for limonene? 

5. Close any open documents and dialogs. 
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Gleevec. Protein Bound vs. Free Conformer 

 

Gleevec (aka Glivec, Imatinib) is a protein kinase inhibitor used in anticancer therapy. It 

specifically targets a protein kinase coded for in the rogue gene bcr-abl. Several crystal 

structures with gleevec docked in protein kinases are available in the PDB. In this tutorial, 

you will examine one* to establish whether or not the conformation of gleevec in the protein 

is identical (or similar) to that of the free (gas- phase) molecule, and if not, what energy 

penalty is to be paid to adopt the protein-bound conformation. The next tutorial will return 

to this same structure and extract a pharmacophore (gleevecôs footprint). 

1. Retrieve a protein structure from the PDB. Select Access PDB Online... from the 

File menu . Type 1opj into the box to the right of PDB ID and click on Open. 

 

 

The protein will be represented by a ribbon model. Red sections correspond to parts of the 

chain that are a helices, while blue regions correspond to to parts that are ɓ sheets (the 

remaining regions are green). A Ramachandran plot (the ű phi and ɣ psi torsional angles 

connecting the individual amino acids) allows you to see the clustering of Ŭ helices and ɓ 

sheets. To display, select Ramachandran Plot from the Model menu . The colors of the 

dots in the resulting plot map one-to-one with the colors of the ribbon model. When you are 

done, click on        to remove the plot. 

 
 

 

*  B. Nager et al, Cell, 112, 859 (2003): PDB identification 1opj. 

** For Windows, this directory is found in Program Files/Wavefunction/Spartan26. It must be copied to 

another location available to the user prior to opening it in Spartan. For Linux, this is found in the directory 

where Spartan was installed. For Macintosh, this is located at the top level of the Spartanô26 disc image.

2 mins 

If you are not online, you may skip this step as the structure is 

available as 1opj in the medicinal chemistry sub-directory 

(tutorials directory).** 
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The protein returned from PDB incorporates two sets of bound molecules, depicted in the 

model as two sets of translucent spheres. Gleevec is the larger of the two incorporated 

molecules and is designated by its PDB HET code STI. 

2. Select Extract Ligands from the File menu 

. Select (click on) one of the gleevec 

molecules inside the protein structure and 

click on the Extract Ligands button at the 

bottom right of the screen. This leads to the 

Extract Ligands dialog. 

Check Ligand Structures under Include and Grow Hydrogens under Extraction Filters 

inside the dialog (if other options are selected, remove them) and click on OK . 

3. A ball-and-spoke model for gleevec will appear on screen. (You no longer need the 

protein; select and close it.) Put a copy of gleevec on the clipboard. With the 

molecule selected, choose Copy from the Edit menu or right click on the background 

and select Copy from the menu that appears. 

4. Select New Molecule (not New)  from the File  menu . Select Clipboard from 

the organic model kit and click anywhere on screen. Click on       . You now have 

two copies of gleevec in a single document. You can step between them using the 

step buttons at the bottom left of the screen. 

5. Select the first copy; select Calculations... from the Setup menu . Equilibrium 

Geometry from the top left menu to the right of Calculate and Molecular 

Mechanics and MMFF from the two bottom menus. The conformation will not be 

altered, but bond lengths and angles will be optimized. 
 

 

 

 

The colors on the ribbon display may be modified, by selecting 

Configure... from the Model menu ( ) and clicking on the 

Ribbons tab. Coloring By Residue will give each amino acid its 

own unique color. 

Structure optimization is necessary in order to establish the energy 

difference between protein-bound and free conformations of gleevec. 

The resolution of protein X-ray crystallography is not adequate to 

establish bond lengths and angles to chemical accuracy. 
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Remove the checkmark from Global Calculations at the bottom of the dialog to signify that 

your choice (geometry optimization) only applies to this copy of gleevec. Click on OK (not 

on Submit). 

6. You will use the second copy of gleevec as the starting point of a conformational 

search. First, we will adjust some of the default degrees of conformational freedom 

Spartan associates with the molecule (in order to reduce the computer time required 

for the conformational search). With the second copy, select Set Torsions from the 

Geometry menu . Your model will be augmented with yellow cylinders 

designating flexible bonds and yellow circles designating rings, respectively. 

Remove the markers (circles) on the piperazine ring by double clicking on each 

nitrogen atom in turn. The conformation of the piperazine ring will not change during 

the search. The model should now appear as below. 

 

7. Select Calculations... from the Setup menu . Select Equilibrium Conformer 

from the top left menu to the right of Calculate and (as before) Molecular 

Mechanics and MMFF from the two bottom menus. Click on Submit, and provide 

the name gleevec protein bound vs. free conformer. 

8. When the calculations have completed (perhaps minutes), select Spreadsheet from 

the Display menu . Click inside leftmost the cell for the second molecule (the one 

on which a conformational search was performed) then click inside the header cell 

for a blank data column. Click on Add at the bottom of the dialog and select ȹE 

(kJ/mol) from the Molecule List tab (under Energy from Molecule). The relative 

energy of the protein bound conformer is provided in the spreadsheet. Is it close to 

zero, meaning that the protein-bound conformer will be present in significant amount 

in a sample of free gleevec? Or is there an energy barrier, indicating a lower 

distribution? 

9. Close gleevec protein bound vs. free conformer and any open dialogs. 
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Linalool: Calculating the NMR Spectrum of a Flexible Molecule 

 

Spartan provides computational options for calculating proton and 13C spectra as well as 

2D COSY and HMBC spectra of flexible molecules. The more rigorous and more costly 

calculations involve construction of a proper Boltzmann-weighted average. In practice, 

calculation of accurate Boltzmann weights for all accessible conformers followed by 

calculation of chemical shifts and (optionally) coupling constants for each of the conformers. 

Obtaining the Boltzmann weights is the limiting step as it requires density functional models 

that account explicitly for long-range van der Waals or dispersive interactions coupled with 

large basis sets. Calculations of moderate size (MW in the range of 500 amu) with 100 or 

more conformers can easily consume many hours on present generation personal computers. 

In this tutorial, you will calculate 13C chemical shifts for the natural product linalool using 

two different procedures. The first will use MMFF to clean up structure (only) for a 

randomly built conformer and will then calculate equilibrium geometry and chemical shifts 

using ɤB97X-D/6-31G* (for that specific conformer). The second procedure will involve 

the multi-step protocol used for the NMR Spectrum task that includes MMFF, a neural 

network model, and multiple QM density functional calculations to provide a Boltzmann 

averaged set of chemical shifts. Results from both calculations will be compared to reported 

experimental shifts. 

1. Build or sketch linalool. Enter the 13C shifts (see figure below). Select Expt. Chem. 

Shifts from the Expt. Data menu, click on each chemically unique carbon, click on 

Edit to the right of Expt. Chem. Shifts at the bottom right of the screen, type in a 

chemical shift using the number pad and click on Enter. When you are done, click 

on      . 

 

2 hours 
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2. Open the Calculations dialog (Calculations from the Setup menu) and select 

Equilibrium Conformer  with Molecular Mechanics and MMFF . Click Submit. 

Name the document linalool_MMFF.spartan. When the job completes, return to the 

Calculations dialog. Specify an Equilibrium Geometry  with Density Functional 

ɤB97X-D and 6-31G*. Submit the job. 

3. When the job completes visit the Configureé entry in the Model menu. From the 

Label tab click the radio button next to (Calc. ï Expt.) Chem Shift. How well do 

the 13C shifts for the MMFF equilibrium conformer compare to experiment?  In 

general anything under 2 ppm is considered reasonably goodïcertainly anything 5 

ppm or larger is worth review and may indicate of potential error in assignment.  

4. Bring up the Molecule Properties dialog and click on the NMR tab. Make note of 

the Mean Absolute error. You can, if you like, post this (and the other error values) 

into the spreadsheet by clicking on the  button to the left of the value. In a random 

conformer, it is not surprising to see a mean absolute error of over 2 ppm.  

5. Right-click on the background and choose Copy. From the File menu choose New 

Build  and then right-click on screen and choose Paste. Open the Calculations dialog 

(Calculations from the Setup menu) and select NMR Spectrum (Density 

Functional), ɤB97X-D and (6-31G*) from the four top menus to the right of 

Calculate and ɤB97X-V/6-311+G(2df,2p)[6-311G*] and ɤB97X-D/6-31G* from 

the two bottom menus. For additional details on the full multi-step protocol, check 

the box next to Details. The specified calculation will take considerable 

computational time (1-2 hours). Click on Submit. 

6. The job will take a good deal of time to complete; you can loosely monitor the 

progress from the Options menu Monitor dialog. When the job completes, bring up 

the NMR properties dialog (Properties from the Display menu and click on NMR ). 

Make sure the Boltzmann Average tab at the center left of the dialog is selected. 

This will report how well the conformationally searched and Boltzmann Averaged 

calculated shifts fit the experimental data. Review RMS error, widely used with 

values less than or close to 2.0 ppm indicating a good match. 

7. The data reported can be configured to report either the conformer that best fits the 

experimental NMR data (Best Fit) or the proper Boltzmann-averaged chemical 

shifts (Boltzmann Average). Compare results from both the Best Fit tab and the 

Boltzmann Average tab.  In general errors these results are typical of the NMR 

Spectrum calculations on flexible organic molecules. Results from the Boltzmann 

Average tab should be similar to: 

RMS    1.8 ï 1.9  ppm 

Max Absolute  3.3 ï 3.5 ppm 

Mean Absolute  1.5 ï 1.7 ppm 

8. Close any Spartan documents and open dialogs. 
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Anethole: Boltzmann Averaging 13C Chemical Shifts 

 

The natural product anethole provides a very simple illustration of obtaining 13C chemical 

shifts as a Boltzmann-weighted average over different conformers. 
 

The molecule is small and there are only two conformers, so the task can be completed in a 

relatively short time (perhaps 15 minutes or so). 

1. Build or sketch anethole. Enter 13C experimental chemical shifts (provided in the 

drawing above). Select Expt. Chem. Shift from the Expt. Data menu and in turn 

click on each unique carbon*, click on Edit to the right of Expt. Chem. Shift at the 

bottom right of the screen, use the number pad to enter the value of the shift and click 

on Enter. 

2. From the Calculations dialog (Calculations from the Setup menu),  select  NMR  

Spectrum,  Density  Functional, wB97X-D and 6-31G* from the four top menus 

to the right of Calculate and wB97X-V/6-311+G(2df,2p)[6-311G*] energy and 

wB97X-D/6-31G* geometry from the two bottom menus. You have requested that 

Boltzmann weights be obtained in a multi-step procedure for the (two) conformers 

of anethole using the wB97X-V/6-311+G(2df,2p)[6-311G*]//wB97X-D/6-31G* 

model. And, following this, for chemical shifts of the conformers to be calculated 

with the empirically corrected wB97X-D/6-31G* density functional model, allowing 

the Boltzmann average to be obtained. Click on Submit at the bottom of the dialog. 
 

3. When completed (probably 10-20 minutes), bring up the NMR properties dialog 

(Properties under the Display menu and click on the NMR tab. Make sure that 

Boltzmann Average tab (not Best Fit) tab is selected. The reported error statistics 

indicate an excellent fit of calculated to experimental 13C shifts. 

4. Close any open Spartan documents and dialogs. 

 

 

*  Spartan detects identical atoms (in this example the two carbons ortho and the two carbons 

meta) to the methoxy group. You only need to enter experimental data for unique atoms. 

       30 minutes 
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Ambiguine H Isonitrile. DP4 Analysis to Assign Stereoisomer 

 

The structure assigned to the natural product ambiguine H is shown below. It contains four 

stereocenters, two of which designated R dictate the disposition of substituents attached to 

the incorporated trans-decalin bicyclic. 
 

 

In this tutorial, you will use the DP4 metric to confirm or refute the experimentally assigned 

stereochemistry about these two centers. This involves chemical shift calculations on the 

four distinct structures each of which is conformationally flexible.  

1. Build or sketch ambiguine H. To enter the experimental 13C chemical shifts, select 

Expt. Chem. Shift from the Expt. Data menu. Click on each carbon in turn, click 

on Edit to the right of Expt. Chem. Shift at the bottom right of the screen (or to the 

right of the atom center), use the number pad to type in a value and click on Enter. 

Note: acknowledging the tedium of hand-entering (there are 26 carbons), you can, 

if you prefer, simply start from the copy of ambiguine H isonitrile from the flexible 

molecules folder in the Tutorials  directory. 

2. Rotatable bonds should be properly marked, but it is a good idea to check. Select Set 

Torsions from the Geometry menu. The three bonds shown in the figure below 

should be marked (encircled with yellow cylinders). If any are not, double click on 

the bond to select. In the interest of reducing computational time, if any other bonds 

or ring atoms are selected, you may turn these off (double-click to deselect torsions, 

for atoms, click to select, and specify off for any twist boat or chair flip markers, 

when finished there should be a total of 3 bonds highlighted: 

  4+ hours 
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Make a list of the four stereoisomers. Select Generate Isomers from the Geometry menu. 

In turn, click on each of the two stereocenters bearing substituents. They will be encircled 

in green (see figure below). Click on Generate list to the right of Isomers at the bottom 

right of the screen. Select New Document from the dialog that appears and click on OK . 

The four isomers (including the RR stereoisomer that you started with) will be placed in a 

new Spartan document. Click on Save (File menu) and name it ambiguine H isomers. Itôs 

a good time to close the original document.  
 

 
 
3. Bring up the Calculations dialog (Calculations from the Setup menu) and select 

NMR Spectrum, (Density Functional), wB97X-D and 6-31G* from the four top 

menus to the right of Calculate and for the bottom 2 menus, to the right of using, 

Est. wB97X-V/6-311+G(2df,2p) and, the Est. wB97X-D/6-31G* geometry from 

the two bottom menus. You have requested a Boltzmann weighted NMR spectrum 

be calculated for each stereoisomer (which will require conformational searching for 

each isomer). Make certain that Global Calculations at the bottom of the dialog is 

checked before you click on Submit. 

4. With the previous release of Spartan, without access to the neural network models 

(the ñEst.ò models), this calculation would have required many hours (overnight) to 

complete. It involves calculations on dozens to hundreds of molecules, depending 

on whether or not the Set Torsion step was precisely followed. Spartan will consider 
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somewhere between 18 (with only 3 set torsion bonds) and 288 conformers (with 

additional ring atoms selected) for each of the 4 stereoisomers. When the job 

completes(total calculation may run 5 or more hours depending on your hardware), 

bring up the NMR properties dialog. Properties under the Display menu and click 

on the NMR tab). Step through the four isomers and identify the one with the highest 

DP4 score. Is this the one that has been assigned based on its NMR spectrum? Are 

any other isomers competitive? 

5. Close all open Spartan documents and dialogs. 
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Chapter 14  
ñDry Labsò Using the Spartan 

Spectra and Properties Database 
 

The tutorials in this chapter comprise examples where structures, energies, spectra and 

other properties can be extracted from the Spartan Spectra and Properties Database doing 

away with the need for new quantum chemical calculations. 

 

The Spartan Spectra and Properties Database (SSPD) is a collection of molecular structures, 

spectra and diverse properties initially available from multiple computational models. At 

present the collection has settled on a single density functional model (ɤB97X-D/6-31G*) 

for structure. Previously structures and frequencies were also available from the EDF2/6-

31G* model (these are both closer to experimental frequencies and are much faster than the 

ɤB97X-D/6-31G* model). Beginning with release of SSPD v.7, weôve included frequencies 

from the corresponding equilibrium structures run at (ɤB97X-D/6-31G*) ï only. This 

allows access to thermodynamic data that is dependent on the frequency calculation ï but 

hopefully alleviates confusion over the previous ñmixed-modelò data. With the release of 

Spartanô26 a single standard ɤB97X-D/6-31G* model data is used for all structures. At 

present, something on the order of  >317,000 molecules in the collection. 

Each SSPD entry includes a wide range of molecular properties including a selection of 

QSAR descriptors, NMR spectra, IR Spectra, and the wave function, allowing ñon-the-flyò 

generation of molecular orbitals, electron densities and other graphical surfaces as well as 

the electrostatic potential map and other property maps. In short, SSPD provides a rich 

source of diverse information for a large selection of molecules. 

The emphasis of SSPD on only on primarily one theoretical model (ɤB97X-D/6-31G*) is a 

deliberate attempt to turn attention away from the characteristics of a particular model (and 

the question ñwhich model is best?ò) and to focus on the chemistry at hand.  

While the choice of the new standard, the wB97X-D/6-31G* model, may be seen as a 

continued compromise between accuracy and practicality, in fact, wB97X-D/6-31G* 

provides high quality results for a variety of properties that can be accurately measured, 

including molecular geometry and NMR spectra. Further, both the T1 heat of formation and 

the wB97X-V/6-311+G(2df,2p) energy are included in the SSPD entry as a property. We 

believe that over the wide variety of molecules considered, T1 provides as reliable an 

indicator of ɲH 298 as the G3(MP2) recipe (which in turn is within measurable experimental 

error). 
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Collections such as the Spartan Spectra and Properties Database may be used to eliminate 

the need to perform calculations that have already been done. Taking this to the extreme, a 

database might serve as an exclusive source of information, doing away altogether with the 

need for quantum chemical calculations. From the instructional perspective (teaching about 

molecular models and molecular modeling) this allows use of more complex examples than 

might otherwise be practical due to time constraints. The tutorials in this chapter fall into 

this category and can be thought as the ultimate in molecular modeling ñdry labsò. 

To complete the tutorials in this chapter, SSPD needs to be available. Either the sample 

version installed with all copies of Spartan and which comprises å6,000 molecules or the 

full version which comprises >317,000 molecules which requires a separate download and 

installation. 

 

Reactivity of Silicon-Carbon Double Bonds 

 

With the exception of so-called phosphorous ylides, compounds incorporating a double 

bond between carbon and a second-row element are quite rare. Most curious perhaps is the 

absence of stable compounds incorporating a carbon-silicon double bond. This can be 

rationalized by using local ionization potential and LUMO maps to compare the reactivities 

of olefins and silaolefins. 

 

1. Build both 2,3-dimethyl-2-butene and tetramethylsilaethylene in the same document. 

Start the second molecule with Build New Molecule or Sketch New Molecule from 

the File menu instead of New Build or New Sketch. 
 

 

 

 

 

 

 

2. Both molecules are in SSPD. Click on the name of whichever molecule is selected 

at the bottom of the screen, note the ɤB97X-D/6-31G* model is referenced, click on 

the Replace button and then click on All . 

3. Select Surfaces from the Setup menu . First request a local ionization potential 

map. Click on Add and select local ionization potential map from the menu. Then 

request a LUMO map. Click on Add and select |LUMO|  map from the menu. 

Surface generation takes less than a second. 

4. Select Spreadsheet from the Display menu  and check the box at the far left for 

each entry in the spreadsheet. This allows simultaneous display of both molecules. 

The molecules should move independently, if mouse movement impacts both 

molecules, deselect the Coupled entry from the Model menu  to uncouple the 
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controls. Position the two molecules side by side on screen. Close the spreadsheet. 

5. Inside the Surfaces dialog, select local ionization potential map. From the Display 

menu, select Properties and click on one of the displayed surfaces. Towards the top 

of the Surface Properties dialog, you will see the Property Range displayed, click 

the button labeled Reset M/M (this resets to the minimum and maximum values 

calculated for the list, rather than the default window. Compare local ionization 

potential maps for the olefin and silaolefin. Recall that the redder the color, the lower 

the ionization potential and the more susceptible toward electrophilic attack.  Which 

molecule do you conclude is likely to be more reactive toward an electrophile? Turn 

off the local ionization and click on |LUMO| map to turn the LUMO maps on. Here, 

the bluer the color, the greater the concentration of the LUMO and the more 

susceptible toward nucleophilic attack. Which molecule do you conclude is likely to 

be more reactive toward a nucleophile? Why are molecules incorporating a silicon-

carbon double bond chemically problematic? 

6. Close all documents and any open dialogs. 

Isomeric C5H8 Dienes 

In addition to 2-methyl-1,3-butadiene, cis and trans-1,3-pentadiene (conjugated dienes) and 

1,4-pentadiene (a non-conjugated diene), there are three other dienes with the same formula: 

3-methyl-1,2- butadiene, 2,3-pentadiene, and 1,2-pentadiene. 
 

1. Build or sketch all seven C5H8 dienes (in a single document). Click on the name of 

whichever diene is selected at the bottom of the screen. Click on Replace and finally 

click on All from the dialog that results. This will substitute entries in SSPD for all 

seven C5H8 dienes. Select Spreadsheet from the Display menu  and expand the 

spreadsheet to see all seven dienes. Select Properties from the Display menu  

and make sure that the ȹHf(298.15) tab is selected. Click on the  buttons to the 

left of both Expt. Heat and T1 Heat in the Molecule Properties dialog. This enters 
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the experimental heat of formation (from the NIST database) as well as the value 

obtained from the T1 thermochemical recipe into the spreadsheet. The T1 heat of 

formation will generally provide a more accurate account of relative stability than 

available from the wB97X-D/ 6-31G* model itself. 

 

 
 

2. First verify that the T1 model correctly reproduces the ordering of experimental 

heats. Then use the T1 heats to answer the following questions: 

What is the difference in stability (heat) between the best of the three conjugated dienes and 

1,4-pentadiene? What is the approximate energy gain due to conjugation? What is the 

difference in stabilities between the best of the substituted allenes and the best of the 

conjugated dienes? 

3. There are several other C5H8 isomers in addition to the dienes discussed above, a 

number of which will be in SSPD (many more in the full version than in the sample 

set). Use any one of the seven dienes as a query. Select Databases from the Search 

menu       and click on the SSPD tab in the dialog that results. Click on  to the right 

of the Search button in the SSPD dialog and select Isomer under Search By in the 

Search Options menu that results. Click on the Search button. Select several (or all) 

of the non-diene isomers, by clicking on them in the list at the right of the dialog 

while holding down the Ctrl key. Click on  to the right of the Retrieve button, 

then click on Current Document in the dialog that results. Close the Databases 

window. Bring up the spreadsheet (Spreadsheet from the Display menu . Note 

that not all the experimental heats of formation are available, as the NIST database 

includes experimental heats of formation for a relatively small number (2-3 

thousand) of molecules. According to the T1 model, are any of the non-diene isomers 

more stable than the best diene? 

4. New in Spartanô26 for database entries that include frequencies, a heat of formation 

from ɤB97X-V/6-311+G(2pf,2p) starting from ɤB97X-D/6-31G* geometries. 

Return to the ȹHf(298.15) tab in the Molecule Properties dialog. Click on the  

buttons to the left of the remaining (DFT-derived) heat of formation. Are the same 

general trends observed? 

5. Close all documents and open dialogs. 

 

 

 

The T1 model is presently defined only for uncharged, closed-shell 

molecules comprising H, C, N, O, F, Si, P, S, Cl and Br only. T1 

heats of formation are not available for the other entries in the SSPD 

(but covers 98% of the total). 



 

Using Infrared Spectroscopy to Identify an Unknown Ethyl Benzoate Derivative 

 

Unlike NMR spectra (at least 13C spectra) infrared (IR) spectra are rich in detail. Some 

chemists would view this as a negative, in that the complexity of an infrared spectrum masks 

its connection with the three-dimensional molecular structure. Others might see complexity 

as a positive, providing a detailed pattern or fingerprint with which to identify a molecule. 

This reflects the different ways that chemists actually use NMR and infrared spectroscopy. 

NMR is most commonly employed to assign structures of new molecules whereas IR is most 

commonly used to identify previously characterized (known) molecules. 

Extensive databases of experimental infrared spectra exist, and sophisticated programs have 

been developed to search these databases for matches to unknown spectra. Spartan is able 

to search the public NIST database of experimental infrared spectra. Infrared spectra 

calculated from density functional models and adjusted to account for known systematic 

errors in frequencies and for finite temperature, generally closely match experimental 

spectra. This suggests that they might be used in lieu of experimental spectra to identify 

unknowns. This tutorial illustrates the point, attempting to identify which of a series of meta-

substituted ethyl benzoates contained in the Spartan Infrared Database (SIRD) best matches 

the infrared spectrum of an unknown molecule. 

 

 

1. Build or sketch ethyl benzoate. Select Structure Query from the Search menu  

and click on one of the free valences on the phenyl ring that is meta to the ester group. 

 

 
 

SIRD uses the infrared spectra contained in the Spartan Spectra and 

Properties Database (SSPD) that have been obtained using the ɤB97X-
D/6-31G* model, these replace the EDF2/6-31G* previously available in 

SSPD. The fact that there are two different tabs simply reflects the different 

search paradigms (spectra matching for SIRD vs. substructure matching 

for SSPD). 
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2. Select Databases from the Search menu  and click on the SIRD tab at the top of 

the dialog that results. Size the dialog to occupy the greater part of the screen. Click 

on Select Spectrum, move to the using SSPD subdirectory under the tutorials 

directory*, click on unknown ethyl benzoate and click Open. In a few seconds, the 

experimental infrared spectrum of the unknown will appear at the top right of the 

dialog. A list of the frequencies for all peaks may be found under Unknown: 

immediately to the left is the spectrum. This has been obtained by fitting the 

experimental spectrum to a Lorentzian function. You can obtain the frequency of a 

line in the spectrum using the yellow measurement bar. Position the cursor on top of 

the bar, hold the left button and move the mouse left or right until the bar is over the 

peak. 

3. You can carry out your search with nothing other than the unknown spectrum (see 

the optional part of this tutorial), or you can restrict it using structural or other 

information that you have. Assume that you know that the unknown is a meta-

substituted ethyl benzoate. Click on the Filters button and then click on Copy 

Current Molecule at the top left of the Search Filters dialog that results. Click on 

OK to exit the dialog. You have restricted the search to meta-substituted ethyl 

benzoates, that is, examine only molecules that contain this particular substructure 

(ethyl benzoate substituted in the meta position). Click on the Search button and 

wait for the search to complete. Hits resulting from the search appear at the bottom 

of the SIRD dialog, in numerical order starting from the best (lowest Score). 
 

As you click on each, the corresponding calculated infrared spectrum will be superimposed 

onto the experimental spectrum (of the unknown) at the top left of the display. Propose a 

structure for the unknown. 

4. Remove the substructure filter and repeat the search. Click on the Filters button, 

click on the Clear button at the top left of the Search Filters dialog and click on 

OK . Click on the Search button. Unlike searches of experimental databases where 

spectra are directly compared, each of the calculated spectra in the database are 

adjusted for frequency scale and peak width as it is compared to the unknown. 

Removing the substructure filter greatly increases the number of spectra that need to 

be examined. Does the meta substituted ethyl benzoate that came in at the top in the 

previous search, also come in at or very near the top in the full search? 
 

 

 
 

 

*  For Windows, this directory is found in Program Files/Wavefunction/Spartan26. It must be copied to 

another location available to the user prior to opening it in Spartan. For Linux, this is found in the directory 

where Spartan was installed. For Macintosh, this is located at the top level of the Spartanô26 disc image. 
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5. Close all documents and any open dialogs. 

 
Infrared Spectra of Short-Lived Molecules 

 

While infrared spectroscopy is by no means as formidable a tool as NMR for elucidating the 

structures of molecules, it does offer significant advantages which can make it the method 

of choice in some instances. It is more sensitive, meaning that it can be used to detect 

transient species, for example, molecules trapped in an inert matrix at very low temperature. 

On the practical side, an infrared spectrometer is inherently simpler (more robust) and can 

be put into a much smaller package than an NMR spectrometer. This means that the 

spectrometer can be brought to the sample rather than the other way around. Imagine, putting 

an NMR spectrometer on the Mars rover! One downside is that IR spectroscopy, unlike 

NMR, typically does not provide an unambiguous structure. However, a close match to a 

calculated spectrum may offer convincing evidence for the veracity of a particular structure 

(or a mismatch convincing evidence that a structure is incorrect). 

 

The infrared spectrum of an unknown C4H4 isomer shows strong absorptions at 854, 1608, 

2994 and 3080 cm-1. Possible structures include but-1-yne-3-ene, butatriene, 

cyclobutadiene, methylenecyclopropene and tetrahedrane. 

  

Be patient. A search of the full database will require significantly more 

computer time than the search of the å6,000 molecule sample database 

supplied with Spartan; it contains >50X as many molecules. 
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1. Build or sketch any one of these molecules. Select Databases from the Search menu 

, and click on the SSPD tab. Click on  to the right of the Search button, select 

Isomer under Search By: inside the Search Options dialog and click on OK . Click 

on the Search button. Structures for all C4H4 isomers will appear in a list at the right 

of the Databases dialog. Retrieve all of them to a new document. Click on  to the 

left of the Retrieve button, select New Document and click on OK . Click on each 

in turn while holding down the Ctrl key (or click on the first, hold down the Shift 

key and click on the last). With all 5 selected, click on the Retrieve button. Close the 

Databases dialog. 

2. Select Spectra from the Display menu         and click on  at the top of the resulting 

dialog. From the IR tab click on                (calculated IR spectrum). Move through 

the list to bring up the spectra for the other isomers. Which, if any, calculated infrared 

spectrum of the C4H4 isomers best fits the unknown infrared spectrum (with peaks 

at 854, 1608, 2994 and 3080 cm-1)? 

3. Close all documents and any open dialogs. 

 

 

Using 13C NMR to Distinguish Structural Isomers 

 

NMR spectroscopy, in particular 13C NMR spectroscopy, is arguably the single most 

important tool available to an organic chemist to establish molecular structure. Obtaining an 

NMR spectrum is straightforward and the spectrum itself is very simple, comprising but a 

single line for each unique carbon the molecule. Because a mass spectrum is normally also 

available, the molecular formula will be known, and assignment of the NMR supports 

deciding among possible isomers. Chemical evidence (how the molecule was made) can 

usually be counted on to eliminate some choices and to strengthen the case for others. Still, 

pinning an NMR spectrum to a particular molecule can be difficult and fraught with error. 

NMR assignment problems can be reduced but not altogether eliminated by requiring that 

both proton and 13C NMR spectra are consistent with a particular structure. This is routine 

practice. In principle, ambiguity can be eliminated by cross-correlating the results of the 13C 

NMR with those of proton NMR with an HMBC spectrum. 

The fact that NMR spectra for reasonable size organic molecules may now be routinely 

calculated in a few minutes to a few hours on a personal computer at a price of $1000 (or 

less) raises the possibility for another tool to assist with spectral assignments. Whether this 

becomes common practice ultimately depends on the ability of calculations to obtain NMR 

spectra that are sufficiently accurate to distinguish among the different isomers. 

In this tutorial you will first compare calculated and experimental 13C spectra of morphine. 

You will then examine calculated spectra for two isomers, norcodeine and hydromorphone. 

The objective is to provide you with an impression of the ability of the calculations to 
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reproduce a 13C spectrum for a known compound and more importantly, to challenge 

structure assignments based on NMR spectroscopy. 

1. Sketch morphine. Click on its name at the bottom of the screen and click on Replace. 

If the name fails to appear, then you have made a mistake. In this case, select Edit 

Sketch from the Build menu        and correct your sketch. 

 

 
 

2. Select Spectra from the Display menu      and click on  in the bar at the top of 

the plots pane. Select                from the palette. Click again on  and this time 

select                from the palette. Calculated and experimental 13C spectra are now 

superimposed. Focus your attention on the four ñmost isolatedò resonances, 

specifically those with calculated chemical shifts of 20.3 ppm, 59.7 ppm, 66.2 ppm 

and 95.2 ppm. 

3. Sketch norcodeine and hydromorphone and retrieve both molecules from SSPD. 

 

 

4. Select Spectra from the Display menu  and click on  and select  

from the palette. You only need to do this once if you put norcodeine and 

hydromorphine in the same document. Does either spectrum fit the experimental 13C 

for morphine (again focus on the four isolated lines)? 

5. Close all documents and any open dialogs. 
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Using 13C NMR Spectra to Distinguish Stereoisomers 

 

As mentioned in the previous tutorial, the combination of 1D and 2D NMR spectra is almost 

always able to provide unambiguous assignment of molecular structure, including 

assignment of stereochemistry. However, as noted, practical considerations (time on an 

expensive instrument) often make 2D experiments (in particular HMBC) the exception 

rather than the rule. Without the additional experiments, distinguishing stereoisomers based 

on their 13C NMR spectra may be difficult experimentally, simply because the alternatives 

are likely to be structurally very similar. For the same reason, it is likely to be an ideal case 

for calculations, as comparisons between molecules with similar structures should benefit 

from cancellation of errors. The bottom-line question is whether or not calculated 13C NMR 

spectra are good enough to be able to clearly distinguish between stereoisomers. This tutorial 

provides an illustration and a chance to assess. 

The hydroxyl CO bond in tibolone, shown below on the left, is gauche to the methyl group 

at C13 (the alkyne is anti), whereas it is anti (and the alkyne is gauche) in the stereoisomer 

shown on the right. You will use just three lines from the experimental 13C spectrum to see 

if the calculations support or refute its assignment as tibolone. 

 

1. Sketch both stereoisomers and put into the same document. Click on the name of 

whichever molecule is selected at the bottom of the screen, click on Replace in the 

dialog that results and click on All . NMR spectra for both molecules are now 

available. 

2. Focus on tibolone and Expt. Chem. Shifts [H/C] from the Expt. Data menu. One 

after the other, enter the experimental chemical shifts for the methyl group at C13 

(12.7 ppm) and for the internal and external alkyne carbons (88.9 and 74.8 ppm, 

respectively). 
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3.   Select Properties from the Display menu , and click on the NMR tab. Which 

isomer provides the better agreement in terms of both RMS, mean and maximum 
absolute error scores as well as the DP4 probability core? Do the calculations support 
or refute the experimental assignment, or are they ambiguous? 

4. Close the document and any open dialogs. 
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Chapter 15 
Using the Cambridge Structural 

Database 
 

The Cambridge Structural Database (CSD) is a well-organized and easily-accessible 

depository of well over 1 million experimental structures, almost entirely from X-ray 

crystallography. It is available on a yearly subscription basis, and when installed and 

licensed may be seamlessly accessed from Spartan. Searches may be carried out based on 

substructure (as with SSPD searches) as well as name, entry RefCode or author. The 

tutorials in this chapter are intended to illustrate the interface and more importantly provide 

a sample of the types of questions to which the database may be used in conjunction with 

computation. These tutorial require access to the CSD. See Appendix G for configuration 

instructions. 

 

Binding to Iron Tetracarbonyl  

An olefin bonded to iron tetracarbonyl may occupy either an equatorial or axial position. 

Search CSD and review the results to see if one is more common than the other. 

 

 

1. Build either axial or equatorial ethylene iron tetracarbonyl. The CSD search does not 

distinguish between the two. Select Structure Query  from the Search menu 

and click on all the four free valences on ethylene. Select Databases      from the 

Search menu and click on the CSD tab. Click on      to the right of the Search 

button, in the Search Options dialog that results, select Inorganics under Filters 

and Structure under Search By. Click on OK . Click on the Search button. More 

than 50 matches (hits) are returned and displayed at the right-hand side of the dialog. 

Click on each in turn to show the structure on the left-hand side. Does there appear 

to be a clear preference for equatorial or axial olefin binding? 
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2. Build the other conformer and put in the same document as the one that you used to 

query the CSD. Select Calculations  from the Setup menu and specify 

calculation of equilibrium geometry with the ɤB97X-D/6-31G* density functional 

model. Make sure that Global Calculations is checked. Submit the job. Execution 

will take several minutes. Which conformer is favored and by how much? Is your 

result consistent with what you found (or didn't find) in the CSD search? 

 

2-Quinolone 

It is generally presumed that energy barriers to interconversion among tautomers are very 

small and what is observed experimentally is a Boltzmann weighted average. 

 

1. Sketch or build the natural product 2-quinolone. 

 

Select Generate Tautomers from the Geometry menu and click on ( ) to the right of 

Tautomers (at the bottom right of the interface) and click the OK button. Spartan generates 

a new document containing both 2-quinolone and itôs tautomer 2-quinolinol. Do you note 

anything special about 2-quinolinol that might lead to it being the dominant tautomer, 

additional aromaticity, perhaps? 

2. Confirm that the OH proton in 2-quinolinol is pointed upward (toward the nitrogen). 

If it isnôt, enter the Edit Build mode from the Build menu and click on the bond 

between the ring carbon and OH. Next, position your mouse cursor over the vertical 

gray shaded section (a bond-rotation tool). Depress the left mouse and slide either 

up or down to rotate the OH group. 

3. Enter the Calculations dialog and specify an Equilibrium Geometry  calculation 

using the ɤB97X-D/6-31G* model, also check the NMR check box and make sure 

the Global Calculations box is selected. Click on Submit. Name the file tautomer 

review. 

4. It should only take a few to complete (perhaps 2-3). Which tautomer is lowest in 

energy? Compare the 13C results from calculation against the experimental values 

below. 
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Select Configure from the Model menu and from the Labels tab, select Calc. Chem Shift 

and click OK . It will be easier to compare if you turn off display of Hydrogens from the 

Model menu. You can turn on display of both tautomers from the Spreadsheet by checking 

the box to the left of the molecule Label. It may be necessary to turn off the Coupled feature 

in the Model menu, in order to manipulate the two molecules independently. Confirm which 

NMR results best match experiment.   

5. CSD use: If both tautomers exist independently, there should be experimental 

evidence in the form of x-ray crystal structures in the CSD.        With one of the two 

tautomers selected, click on Structure Query ( ) from the Search menu and then 

click on all free (open yellow) valences (this specifies a search for the specific 

tautomer as well as any analogues which maintain the same tautomer form). Select 

Databases ( ) from the Search menu and click on the CSD tab. Click on ( ) to 

the right of the Search button, make sure Organics is selected under Filters and 

Structure under Search By. Click on OK  to release the Search Options dialog. 

Click on the Search button. Review the number of hits. Repeat for the other 

tautomer. For which tautomer(s) do you find crystal structures? Which tautomer is 

more common in the crystallography literature? 

 

Tetrahedrane and Cyclobutadiene 

The C4H4 isomers, tetrahedrane and cyclobutadiene, are among the most unlikely of 

hydrocarbons. It is hard to imagine a molecule that is more strained than the former while 

the latter is the prototypical antiaromatic molecule. Use the CSD to see if derivatives have 

actually been characterized. 

 

1. Build cyclobutadiene. Select Structure Query ( ) from the Search menu and 

click on all open free valences. Select Databases       from the Search menu and 

click on the CSD tab. Click on       to the right of the Search button, select Organics 

under Filters and Structure under Search By and in the Search Options dialog that 

results and click on OK . Click on the Search button. 
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2. Repeat the process for tetrahedron. 

3. Identify the simplest system that is common to both cyclobutadiene and tetrahedrane, 

that is, one where the substituents are the same. Build the two molecules (or extract 

the two from the ñhitsò on CSD. Calculate equilibrium geometries for the two using 

the ɤB97X-D/6-31G* model.  

4. Select Calculations from the Setup menu and inside the dialog select Density 

Functional, ɤB97X-D and 6-31G* from the menus to the right of Calculate. 

Submit the job (two molecule). It will require several minutes to complete. Which 

molecule is more stable? 

5. Close any remaining open documents. 
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Section V 
Features and Functions 
 

This section describes the functions available under the menus incorporated into Spartanô26 

and is intended to serve as a general reference to the program. The coverage follows the 

order of the menus presented in Spartanôs user interface: File, Edit , Model, Geometry, 

Build , Setup, Display, Search, Data, Options, Activities and Help. The functions and 

usage of each of the menu entries is described. Entries under the File, Model, Geometry 

and Build menus deal primarily with the input and construction of both 2D drawings and 

3D structures and with their display and query. Entries under the Setup menu specify 

molecular mechanics or quantum chemical models as well as similarity analysis tools, 

designate what properties and spectra are to be obtained, request one or more graphical 

models and submit jobs for calculation in the background. Entries under the Display menu 

access calculated quantities including calculated spectra, under the Expt. Data menu - input 

of experimental IR/Raman, NMR (chemical shifts and observed HH and CH couplings) and 

UV/visible data is available, and the Search menu accesses databases of calculated 

information. Entries under the Options menu set program defaults and user preferences, 

designate paths to databases of calculated and experimental information, control job queues, 

designate available servers for remote calculation and control access to Spartan as a 

computational server. 

The chapters in this section provide only limited commentary about the performance and 

requirements of different computational methods and the utility of different graphical 

models. Additional information is provided under Topics accessed from the Activities menu 

and in A Guide to Molecular Mechanics and Quantum Chemical Calculations*, available 

as a PDF under the Help menu. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

*   This reference was written in 2003, and as such it does not include a full assessment or description of 

many of the newer computational features included in Spartanô26. In particular many functionals and 

basis sets are not covered. An updated version is in the works. 
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Chapter 16  
The File Menu 

 
 

 

Operations under the File menu access a 2D sketch pad, model kits to build, edit and 

substitute molecules in 3D, the file system to read and write both native and non-native files 

and the online PDB database of protein and macromolecular structures. They allow text 

and on-screen graphics to be printed and text and other files to be embedded into Spartan 

documents. 

 

 

New  

Brings up a model kit or sketch tools, depending on current viewing mode (2D or 3D) and 

clears the screen. Model kits are discussed in Chapter 20. 

 

New Molecule  

Brings up a model kit or sketch tools and clears the screen. New Molecule differs from New, 

in that the resulting molecule is appended to the end of the document associated with the 

molecule (or sketch) that is presently selected. 
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Delete Molecule  

Deletes the selected molecule(s) from a document. Deleting the last molecule leads to an 

empty document. 

 

Append Molecule(s)...  

Appends one or more documents onto the end of the document that contains the selected 

molecule. Append Molecule(s)... leads to a file browser from which one or more documents 

need to be selected.* 

 

Open...  

Opens a file that contains all information associated with a particular molecule or 

pharmacophore (or list of molecules and/or pharmacophores). In addition to native (.spartan) 

files (documents), the following are also supported to input: 2D drawings: CambridgeSoft 

(ChemDraw) CDX (.cdx), and MDL SDF (.sdf)*, SKC (.skc), and TGF (.tgf), files 

containing 3D structures: MacroModel (.mac), SYBYL Mol (.mol), SYBYL Mol2 (.mol2), 

and PDB (.pdb), crystallographic Information (.cif), and files containing 1D ñstringsò: 

SMILES (.smi) and InChi (.inchi). Finally IR, Raman, VCD, NMR and UV/visible spectra 

may be input (discussion of file formats is provided in Appendix J). Experimental spectral 

data may also be brought into Spartan from the Data menu (Chapter 24). 

*Alternatively, molecules may be appended to an existing document either by copy/paste operations using the 

clipboard or by dragging from an external window. Both require that the spreadsheet associated with the 

destination document be open on screen. 
 

To copy a molecule open on screen onto the clipboard, first select (click on) it, and then select Copy from the 

Edit menu. Alternatively, click on its label in its spreadsheet (in the leftmost column), and then select Copy 

from the Edit menu. The latter permits several molecules to be selected (and copied) at once using the Shift 

and Ctrl keys in the usual manner. Once on the clipboard, the molecule or molecules may be moved to the 

destination list by clicking on an empty row header in the spreadsheet (for the destination document) and then 

selecting Paste from the Edit menu. 
 

To copy a document from an external window, drag it onto the open spreadsheet (associated with the 

destination document) inside of Spartan. Several documents can be dragged at once using the Shift and Ctrl 

(Command key for Macs) keys in the usual manner. 

We use the word ñfileò to refer to any information contained in the ñfile 

systemò (the disk on your computer) and the word ñdocumentò to refer 

to files that are native to Spartan. Thus, an MDL SDF file may be read 

into Spartan and then written as a document. Documents may contain 

information on a single molecule or single pharmacophore or on a 

collection of molecules and/or pharmacophores. This collection is 

loosely referred to as a ñlistò or as a ñspreadsheetò (in the context that it 

is presented in a spreadsheet). 



227  

Cartesian coordinates from any of these files (except spectra files which do not necessarily 

contain coordinates) may be replaced by coordinates generated based on atomic connectivity 

using Replace Coords. in the Molecule Utilities dialog (accessible from Properties under 

the Display menu; Chapter 22). Additionally, hydrogen atoms that are missing in the input 

structure may be provided using Add Hydrogens from the Utilities tab in the Molecule 

Properties dialog. Non-native files are normally hidden from view but may be seen by 

selecting All Files from the Files of type menu at the bottom of the dialog. 

 

Close  

Closes the document containing the selected molecule, as well as any document specific 

dialogs. If the document has not previously been saved, a name is requested. If a previously-

saved document has been altered, verification that the changes are to be saved is requested. 

Open Recent Documents  

Brings up a list of (at most) the ten recent documents. Clicking on one opens the document. 

 

Save  Save As...  

Saves the document containing the selected molecule exactly as it appears on screen. 

Opening the document will bring it on screen exactly as it was last saved. If the document 

has not previously been named, Save behaves as Save As.... Documents may either be saved 

in native format or in one of the formats listed under Open. In addition, bitmap (.bmp), 

JPEG (.jpg) and PNG (.png) graphics file formats are supported as is the Spartan Database 

(.spentry) format for creating custom databases (see Appendix H). Selection is made under 

the Save as type menu in the Save As dialog. 
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The contents of the spreadsheet (Spreadsheet under the Display menu; Chapter 22) may 

be printed using Print from the contextual menu. The results of a reaction energy calculation 

(Reactions... under the Display menu; Chapter 22), may be printed using Print from the 

contextual menu. 

 

Save Image As...  

Saves your current molecule system, surface (etc.) as a high resolution PNG (.png), JPEG 

(.jpg) or bitmap (.bmp) file. Upon save, a new dialog will prompt for dimensions, allowing 

users to specify height and width (in pixels), PNG format allows saving with a transparent 

background. 

Save to Database...  

Saves the current molecule(s) in the SSPD format. This is a new menu item in Spartanô26 

and will only be selectable if your system has been submitted as an SSPD Compatible 

(task).  See Chapter 21 (Setup menu).  
 

Access PDB Online...  

Provides access to the online Protein Data Bank (PDB)* comprising more than 253,000 

protein and nucleotide structures. Selection results in a dialog.  

To access a PDB structure, enter the four-character identification code in the box to the right 

of PDB ID and click on Open. If the PDB entry contains more than one structure (typical 

with protein structures obtained from NMR spectroscopy) and/or the PDB ID yields more 

than one entry, all structures will be returned in a single document. The literature reference 

from PDB is available from Molecule Reference (Display menu; Chapter 22). 
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A ribbon model of the PDB file will appear on screen.* A Ramachandran plot associated 

with a protein structure may either be drawn upon initial retrieval of the PDB file by 

checking the box to the left of Draw Ramachandran Plot or later from Ramachandran 

Plot under the Model menu (Chapter 18). 
 

Extract Ligands  

This allows ñligandsò to be extracted from PDB files**  either as molecular structures or as 

footprints (pharmacophores) that these structures leave behind. The latter is separated into 

three parts, the first two of which follow from the molecular structure of the ligand and the 

third which follows from the immediate (protein or nucleotide) environment: 

(i)  hydrogen-bond donor/acceptor sites and positive/negative ionizable sites 

(ii)   hydrophobes 

(iii)   excluded volumes 

A pharmacophore can be constructed by requiring (i) to account for hydrogen-bonded and 

electrostatic interactions and (optionally) either (ii) or (iii) to account for steric interactions. 

Selection of (ii) leads to a pharmacophore that is visually simpler, but selection of (iii) may 

provide a more realistic picture. 

 

Selection of Extract Ligands leads to a message at the bottom of left of the screen. 

 Selection is made by clicking on one of space-filling ligand models. Ligands in 

PDB files are represented as a transparent space-filling model. Clicking on a ligand selects 

it and displays the PDB HET name* at the bottom of the screen (if a HET name is available). 

Multiple ligands may be selected if desired by holding down on the Ctrl key. 

 

All ligands may be selected by clicking on the Select All 

Ligands button at the bottom right of the screen. After one 

or more ligands have been selected, clicking on the Extract 

Ligands button at the bottom right of the screen brings up 

the Extract Ligands dialog. This allows selection of Ligand 

Structures of one or more pharmacophore elements 

(HBA/HBD and +/- Centers, Hydrophobe Centers 

including aromatic centers, Excluded Volume Centers) or 

both structure and one or more pharmacophore elements.  

Additionally, amino acids and/or nucleotide residues in close hydrogen-bonding or charge-

charge contact with the ligand (Environmental Structures) may be identified. This panel 

also allows the Protein/Nucleotide Structure (minus all ligands) to be extracted.  

 

 

*  If the PDB file does not contain a macromodel structure suitable for rendering in ribbon 

  display, choose an alternate Model style from the Model menu. 

** This capability is not restricted to files in PDB but extends to files written in PDB format. 
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In the case of extraction of Ligand Structures, the Extract Ligands dialog also provides a 

set of utilities: 

(i)  Grow Hydrogens 

If checked, adds hydrogens wherever they appear to be missing, based on the actual 

geometry and on normal valence rules. This function is also available under Grow 

Hydrogens in the Molecule Utilities dialog (Properties under the Display menu; 

Chapter 22). 

(ii)  Repair Bonds 

If checked, attempts to fix bonding errors based on the actual geometry in the PDB 

entry and on normal valence rules. Clicking on OK at the bottom of the Extract 

Ligands dialog extracts the ligand(s) or pharmacophore(s), placing them in a 

single new (unnamed) document. Clicking on Cancel dismisses the dialog without 

ligand (pharmacophore) extraction. 

 

 

Print  

Selection leads to a dialog in order to designate a printer, specify print layout and number 

of copies. It also allows printing to a file. 

 
Embedded Data  

Is the location where the moleculeôs thumbnail image and additional data can be stored 

(within the .spartan format). 

 

View Toggle 2D/3D  

Controls master view mode and toggles between views. When in 3D, only the 2D toggle 

option is displayed, when in 2D, only the 3D toggle option is displayed. 

 

Exit  

Closes Spartan, that is, clears the screen and closes all open documents. A prompt is 

provided for each document that has not previously been saved. 
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Chapter 17 
The Edit Menu 
 

 

 

Operations under the Edit menu provide for undoing commands, copying items to and from 

the clipboard, finding text and graphics, centering molecules on screen and clearing the 

selected molecule. 
 

Undo  

Undoes the last operation from the Build and Edit menus and from the Molecule Utilities 

dialog. Undoes transition-state formation and retrieval from Spartanôs databases. 

 

Cut , Copy , Paste  

Cut moves the selected item to the clipboard and removes it from the document. Copy 

copies the item to the clipboard. The item is unaffected. Paste transfers the contents of the 

clipboard to the selected location. The contents of the clipboard are unaffected. Among the 

important uses of the clipboard within Spartan are: 

(i) Transferring on-screen graphics into other applications such as Microsoft 

Word® and PowerPoint®. 

(ii)  Temporary storage of a molecular structure for use in molecule building. 

(iii)  Transferring data between Spartan spreadsheets and between a Spartan 

spreadsheet and other applications such as Microsoft Excel®. 

(iv) Making multi-molecule documents and/or transferring molecules between 

documents. 

Cut operations for (i) and (ii) require drawing a selection box. Position the cursor slightly 

above and slightly to the left of the item to be transferred, hold down both left and right 

mouse buttons and drag the mouse to a location slightly below and slightly to the right of 

the item to be transferred and release both buttons. Copy operations for (i) and (ii) also refer 

to the contents of a selection box if one has been drawn, or to the selected molecule if a box 

has not been drawn. Copy operations from a Spartan spreadsheet refer to all information 
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associated with a molecule if selection is made on the header cell of the leftmost column, 

but only to the selected (text) information if selection is made on any other column. Further 

discussion relating to use of the clipboard in molecule building is provided in Chapter 20 

and for moving data in and out of the spreadsheet is provided in Chapter 22. 

 

Select All  

Selects all atoms in the selected molecule. 

 

Find... , Find Next  

Find locates a text string defined in the Find dialog if an output window or a spreadsheet is 

selected, or a structure sequence defined on the clipboard if an on-screen model is selected. 

Find Next locates the next occurrence of a text string or a structure sequence. 

 

Center  

Centers on screen all molecules in the document for which the selected molecule is a 

member (only the selected molecule is displayed). 

 

Clear  

Clears (deletes) the structure and other information for the selected molecule and brings up 

a model kit. No information is actually removed from the file system until the document is 

saved. 
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Chapter 18 
The Model Menu 
 

Structure styles available under the Model menu include: Line, Wire, Ball-and-Wire, Tube, 

Ball-and-Spoke, and Space-Filling (CPK) models. A number of additional items can be 

toggled on or off, including display of hydrogens, hydrogen bonding, R/S chirality labels, 

chemical functional descriptors (CFDôs), ribbon displays for biopolymers, and 

Ramachandran plots for proteins from the Protein Data Bank (PDB). Additional options 

are available for display of Labels (atom and residue), Objects (such as constraint markers, 

frozen atoms, and user defined planes), Ribbons (custom color and style options) and 

CFDôs. Global Model toggles settings in the Model menu between being applied to 

individual or to all molecules in a document and Coupled toggles between manipulations 

applied to individual molecules or to all molecules in a document. Configure sets default 

labels for atoms, ribbons, CFDôs and a variety of other objects. 

 

Only one model style Wire , Ball and Wire, Tube, Ball and Spoke, Space Filling, Line or 

Hide) may be selected. The selected model is designated by being highlighted in the Model 

menu. Global Model, Coupled, Hydrogens, Labels, Ribbons, Hydrogen Bonds, 

Chirality , and CFDôs operate as toggle switches.
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Wire  

This represents the molecule as a wire model where the vertices represent the atoms. 

 

 

Wire Model 

 

 

 

The bonds are drawn in two colors, one for each of the atoms making up the bond. Default 

atom colors are given in terms of Periodic Table in Figure 18-1. These are different than 

the defaults used in previous versions of Spartan. You can return to the old scheme from 

the Miscellaneous tab (Preferences... under the Options menu; Chapter 25). Select Classic 

under Atom Color Set. 

Atom colors apply globally (to all atoms of given type) and may be changed using the Set 

Colors dialog (Colors under the Options menu; Chapter 25). Colors of individually 

selected atoms may be set using the Atom Style dialog (Properties under the Display menu; 

Chapter 22). All models use the same color scheme for atoms and provide for the same 

mechanism of changing colors globally or individually. 

All structure models, and graphics may be displayed either in orthogonal or 

perspective projections. The latter may be valuable in helping to visualize 

large molecules. Selection is done in the Settings tab (Preferences... 

under the Options menu; Chapter 25). Both structure models and 

graphics may be presented in 3D stereo. This may be controlled from 

the Settings tab or by toggling the 3 key on the keyboard. Stereographic 

displays require perspective projections. 
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Figure 18-1:Default Atom Colors 
 

 

 

Ball and Wire  

This represents atoms by small balls and bonds by wires. 

 

 

Ball-and-Wire Model 

 

 

 

The balls are color coded according to atom type, and the wires representing bonds are drawn 

in two colors (as in wire models). 

 

Tube  

This is similar to the wire model, except that tubes instead of wires are used to represent 

bonds. As with wire models, bonds are drawn in two colors. 

 

 

Tube Model 
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Ball and Spoke  

This represents atoms by balls (the size and color of which depend on atom type), and bonds 

by spokes. 

 

Ball-and-Spoke Model 

 

 

 

Bond (spoke) color is gray (by default) but it may be changed using the Set Colors dialog 

(Colors under the Options menu; Chapter 25). Colors of individually selected bonds may 

be set using the Bond Style dialog (accessible from Properties under the Display menu; 

Chapter 22). 

 

Space Filling  

This represents the molecule as a composite of spheres, the radii of which have been chosen 

to approximate van der Waals contact distances.* Also known as CPK models, space-filling 

models are intended to portray overall molecular size and shape. 

 

 

Space-Filling Model 

 

 

 

Volume, surface area and polar surface area (PSA)**  displayed under the QSAR tab in the 

Molecule Properties dialog (accessible from Properties under the Display menu; Chapter 

22) correspond to a space-filling model. 
 

Line  

A line model is a 2D representation (similar to that provided from drawing programs such 

as ChemDraw, MarvinSketch or Biovia Draw). It designates carbons as the termini or the 

intersection of lines and non-carbons by their elemental symbols without use of color. 

 

 

Line Model   

 
 

* Default values for van der Waals radii may be changed from the VDW Radii dialog accessible from 

Preferences under the Options menu (Chapter 25). Settings apply to all atoms of given atomic number. 

** By default, polar surface area is defined as the area due to nitrogen and oxygen and any hydrogens attached 

to nitrogen and oxygen. Other combinations of atoms may be employed to define a polar surface area. See 

Formulas under the Display menu (Chapter 22). 
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Line models include stereochemical cues  (     and    ) if these have been provided in the 

2D drawing or if they are specified from the Bond Properties dialog (accessible from 

Properties under the Display menu; Chapter 22). 

 

Hide  

This removes the molecular structure model from the screen. This may be desirable where 

its display may lead to unnecessary crowding, for example, in proteins where ribbon displays 

are more appropriate. A structure model may be restored by selecting it from the Model 

menu. 

 
 

Global Model  

If highlighted (turned on), this signifies that all molecules in a document will share 

attributes. These include presentation of hydrogens, atom and other labels, hydrogen bonds, 

CFDôs and ribbon displays. Global model style is controlled from the Molecule tab 

(Preferences... under the Options menu; Chapter 25). Global Model acts in a toggle 

manner, switching between global and local display. Global Model is on by default. 

 

Coupled  

If highlighted (turned on), this signifies that all molecules in a document selected for 

simultaneous display will move together. Coupled is turned on following molecule 

alignment (see Align under the Geometry menu; Chapter 19) as well as after either 

Generate Isomers or Generate Tautomers has been utilized (see Geometry menu). 

Coupled acts in a toggle manner, that is, repeated selection couples or decouples. 

 

Hydrogens  

If highlighted, this signifies that hydrogens are to be included in the model. Note that 2D 

SD files, CIF files, as well as structures retrieved from the Cambridge Structural Database 

Different parts of a molecule may be rendered in terms of different model 

styles and colors. This allows focus on specific regions of a molecule. 

Regions may be individual atoms and/or bonds or any collection of atoms 

and/or bonds, contiguous or not. They are selected either by clicking on 

an individual atom or bond or, with the aid of the Ctrl (select multiple) 

or command key (Macintosh), Shift (select over a range), and Alt (select 

all bonded) or option key (Macintosh), by clicking on a set of atoms 

and/or bonds, or by defining a selection box. Discussion provided in 

Chapter 1. Style and color of selected model components is by way of 

the ñSelectedò Style dialog accessible from Properties under the Display 

menu (Chapter 22). 
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or the Protein Data Bank may lack hydrogens. These need to be added to the model before 

CFDôs (Chemical Function Descriptors) can be assigned (see discussion later in this chapter) 

and before calculations may be performed. This may be done either upon retrieval (see 

Databases and Extract Ligands under the Search menu; Chapter 23) or using Grow 

Hydrogens in the Molecule Utilities dialog (accessible from Properties under the Display 

menu; Chapter 22). Hydrogens acts in a toggle manner, that is, repeated selection turns the 

display of hydrogens on and off. 

Labels  

If highlighted, this signifies that labels associated with atoms, ribbons and bonds as well as 

with other attributes specified in Configure... (see discussion later in this chapter) are to be 

displayed in the model. Labels acts in a toggle manner, that is, repeated selection turns 

display of labels on and off. Labels is automatically turned on following selection of Apply 

or OK in the Configure dialog. 

 

Ribbons  

If highlighted, this signifies that ribbons are to be displayed along with the selected model. 

(If only ribbons are desired, select Hide for the model style.) Ribbons acts in a toggle 

manner, that is, repeated selection turns display of ribbons on and off. 

Ramachandran Plot  

If highlighted, this draws a Ramachandran plot for a protein input from the Protein Data 

Bank (see Access PDB Online under the File menu; Chapter 16). Ramachandran Plot 

acts in a toggle manner, that is, repeated selection turns the plot on and off. Note that coloring 

of the points on the plot (red for a-helices, blue for ü-sheets, green otherwise) is not based 

on the actual 3D geometry but rather on assignments in the PDB file. The plot may be 

removed by again selecting Ramachandran Plot. 

 

Hydrogen Bonds  

If selected, this signifies that hydrogen bonds are to be drawn as part of the model. Hydrogen 

bonds are defined as non-bonded contacts between a nitrogen or oxygen and a hydrogen 

attached to nitrogen or oxygen separated by a distance ranging from 1.6 to 2.1Å and making 

an XïH--Y (X,Y = N, O) angle of >120°. Note that hydrogen bonds are not used in either 

molecular mechanics or quantum chemical calculations. Hydrogen Bonds acts in a toggle 

manner, that is, repeated selection turns display of hydrogen bonds on and off. 

 

R/S Chirality  

If selected, this adds R/S chirality labels to the model. R/S Chirality acts in a toggle manner, 

that is, repeated selections turns R/S labels on and off. 
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CFDôs  

If checked, this signifies that Chemical Function Descriptors (CFDôs) are to be displayed 

along with the structure model. CFDôs are descriptors given to a molecule in order to 

characterize or anticipate its chemical behavior or to identify commonality among molecules 

with different structures. They parallel terms in a chemistôs vocabulary such as lone pair (to 

suggest the role of a hydrogen-bond acceptor) and sterically crowded (to suggest that getting 

close may be difficult). 

Spartan uses seven different kinds of CFD, the first six of which may 

be thought of as attributes of a molecule. 

 

 

Default CFD assignments follow from atomic connectivity and rules covering common 

organic functional groups. They may be modified on a case-by-case basis using the CFD 

Properties dialog (accessible from Properties under the Display menu; Chapter 22). 

CFDôs (represented by *ôs in the figures below) may either be atom centered, or they may 

be centered in between atoms. For example, a hydrogen-bond acceptor CFD is placed on an 

ether oxygen, while an aromatic CFD is placed at the center of a benzene ring. 
 

 

CFDôs may also be associated with a number of common functional groups. For example, a 

single CFD is provided for the carboxylic acid group, sited in-plane and equidistant from 

the carbon and two oxygens. 

The CFDôs for this and other functional groups may depend on pH. At neutral (or basic) pH 

this CFD should be designated both as a hydrogen-bond donor and a hydrogen-bond 

acceptor, whereas at acidic pH it should be designated as a negative ionizable site. 

 

CFD 

1.hydrophobe 

2.aromatic 

3.hydrogen-bond donor 

4.hydrogen-bond acceptor 

5.positive ionizable site 

6.negative ionizable site 

chemical language 

sterically-crowded region 

aromatic ́ system 

acidic hydrogen 

lone pair 

basic site  

acidic site 
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Finally, note that default assignments for hydrogen-bond donors and acceptors depend not 

only on atomic type (N, O, . . . ) and (in the case of hydrogen-bond donors) on the availability 

of hydrogens, but also on known (or presumed) chemical behavior. For example, because 

an amide nitrogen would generally not be considered to be a hydrogen- bond acceptor, no 

(hydrogen-bond acceptor) CFD is provided. It is assigned to be a hydrogen-bond donor (if 

hydrogens are available) and the amide oxygen is assigned as a hydrogen-bond acceptor. 

 

 

 

A seventh CFD type, excluded volume, derives from knowledge of a molecule incorporated 

into a host. Excluded volumes may be obtained for ligands extracted from PDB files using 

the Ligands dialog (Extract Ligands under the File menu; Chapter 16). 

Configure...  

This selects the types of labels attached to atoms and other molecule attributes. 

 

 

 

 

Note that hydrogen-bond acceptor and donor CFDôs may be related to the 

electrostatic potential obtained from quantum chemical calculations. For 

example, a negative potential associated with an oxygen center suggests that it 

might serve as a hydrogen-bond acceptor, while a positive potential associated 

with a hydrogen attached to such a center suggests its role as a hydrogen-bond 

donor. While a chemist would reach the same conclusions simply by looking at 

the molecule, the calculations may be able to say which acceptor or donor sites 

are likely to be strong and which are likely to be weak. 

Calculated electrostatic potentials may offer significant advantage over CFDôs 

and other qualitative descriptions when there are no heteroatoms and hydrogen 

bonding is not possible. The ́ system of benzene and other aromatics provide the 

most common examples. The same conditions that make the ring susceptible to 

electrophilic aromatic substitution mean that it repels other electron-rich regions 

(and attracts electron-poor regions). 
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Labels 
 

Under Atom, labels may be selected from among the following: Labels, a unique 

element/number combination that may be changed from the Atom Properties dialog 

(accessible from Properties under the Display menu; Chapter 22), Element, Mass 

Number, Mulliken Charge, Electrostatic Charge, Natural Charge, Strand: 

Residue\Label (polypeptides and polynucleotides), and Exposed Area (of an atom in a 

space-filling model), Chem Shift, Expt Chem Shift and Calc-Expt Chem Shift. Selection 

of Custom leads to a text box into which a formula defining an atomic label may be entered. 

Details are provided in Formulas under the Display menu (Chapter 22). Under Bond, 

either Label a unique number prefaced by the word ñBondò that may be changed from the 

Bond Properties dialog (accessible from Properties under the Display menu; Chapter 22) 

or Custom entered in a text box. Under Other, Hydrogen Labels, Point Labels, Plane 

Labels, Constraint Labels, Residue Labels, Reaction Labels, Coupling (coupling 

constant) and/or CFD Labels may be provided. Default settings (for a new molecule) are 

made in the Molecule tab (Preferences under the Options menu; Chapter 25). 

Objects 

Clicking on the Objects tab leads to the Configure Objects dialog: 
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If checked, Constraint and Frozen markers, Points and Planes, Reaction arrows and 

CFDôs attach to the model. If not checked, these are shown only in the respective modes, 

for example, Frozen markers are shown only if Freeze Center is selected. Images and 

Annotations refer to images and text, respectively, associated with the molecule display. 

An image or text string may be associated by first putting it on the clipboard and then pasting 

it on screen. Either may be positioned on screen and sized. HH and CH refer to 

experimentally assigned HH and CH couplings. 

 

Ribbons 

Clicking on the Ribbons tab leads to the Configure Ribbons dialog: 

 

Ribbon coloring may be selected in a menu from among the following: Monochrome, By 

Secondary Structure, By Strand or By Residue. Ribbon style may be selected in a menu 

from among the following: Ribbons, Extended Ribbons, Beads or Lines. 

 

CFDôs 

Clicking on the CFDôs tab leads to the Configure CFDs dialog: 
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This allows for turning CFD descriptors excluded volumes on or off. 

The Configure dialog is removed from the screen with all changes maintained by clicking 

on OK . Clicking on Cancel or on        removes the dialog but changes are lost. Clicking on 

Apply maintains the changes but leaves the Configure dialog on screen. Note that Labels 

(from the Model menu) will be turned on following either clicking on OK or Apply . 
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Chapter 19 
The Geometry Menu 
 

Functions available under the Geometry menu allow querying and changing bond lengths, 

angles and dihedral angles, defining points and ligand points, planes and chemical function 

descriptor (CFD) locations, setting geometrical constraints (distances, angles and dihedral 

angles) or ranges of constraints, freezing atomic centers, altering default bond and ring 

conformer assignments, introducing NOEôs (maximum intramolecular distances) in 

conformational searching, selecting atoms or CFDôs for similarity analysis and aligning 

molecules. Generation of tautomer list has been moved from the Search menu and the ability 

to generate a list of stereo and/or regioisomers, and set (ñcheckò) atoms for BSSE and NICS 

NMR calculations. 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Measure Distance          Angle         Dihedral       

Measure Distance displays the distance (in Ångstroms) between any two atoms. Selection 

results in a message at the bottom left of the screen: 

 

Clicking on two atoms displays the distance at the bottom right of the screen: 

 

 

Alternatively, clicking on a bond displays its length: 
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Measure Distance may also be used to alter the distance between atoms by clicking inside 

the box to the right of Distance (A,B) = or Length (A)=, and either typing or using the 

number pad. Spartan includes the ability to alter bond distances inside rings. This is 

accomplished by temporarily imposing distance constraints followed by molecular 

mechanization and then removing the constants. 

The distance (length) may be entered into the spreadsheet by clicking on  to the right of 

its display (see Spreadsheet under the Display menu; Chapter 22). Alternatively, the label 

ñDistance (A,B)=ò or ñLength (A)=ò may be dragged into the spreadsheet, the formula 

editor (see Formulas under the Display menu; Chapter 22) or into any of the dialogs 

associated with the Spartan Spectra and Properties Database (see Databases under the 

Search menu; Chapter 23). 

Angle and dihedral angle queries and charges are handled in a similar manner. Angles 

require that three atoms or two bonds be identified in the proper order while dihedral angles 

require that four atoms or three bonds be identified in the proper order. 

 

Freeze Center  

This allows one or more atoms to be held in place during minimization (in the 3D builder) 

or (optionally) during equilibrium or transition- state geometry optimization, conformational 

searching, or energy profile generation using molecular mechanics or quantum chemical 

methods. In the latter case, use of frozen atoms needs to be explicitly indicated in the 

Calculations dialog (Chapter 21). 

Atom freezing may be useful in a number of situations, among them guessing a transition-

state geometry for a reaction that is closely related to one for which a transition state is 

available. For example, a good guess at the transition state for pyrolysis of cyclohexyl 

formate will be obtained by modifying the transition state for pyrolysis of ethyl formate, 

freezing all but the modified sections (designated in bold in the following figure) and then 

minimizing. 

 
 
 

Selection of Freeze Center leads to a message at the bottom left of the screen: 
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Clicking on an atom freezes it, clicking again thaws it. Buttons at the bottom right of the 

screen allow for freezing all atoms (Freeze All), freezing all non-hydrogen atoms (Freeze 

Heavy) and for thawing all atoms (Thaw All ). 

 

Another important use of frozen atoms is to adjust XH bond lengths in structures resulting 

from a search of the Cambridge Structural Database (see Databases under the Search menu; 

Chapter 23). Hydrogen positions are more often than not poorly located in small molecule 

X-ray structures, and XH bond lengths are commonly shorter than they should be. Structures 

incorporating such bond lengths are inappropriate for energy and property calculations and 

may also be problematic as starting geometries in quantum chemical calculations. Protein 

crystal structures often lack hydrogens, and hydrogen positions of bound ligands extracted 

from PDB files may be poorly defined. A reasonable solution to both problems is to freeze 

all heavy (non-hydrogen) atoms (Freeze Heavy) and then to carry out molecular mechanics 

optimization using either Minimize  from the Build  menu (see discussion in Chapter 20) or 

from Calculations... under the Setup menu (see discussion in Chapter 21). 

Frozen atoms are indicated by magenta colored markers (). Whether or not these are 

included with the model (outside of Freeze Center mode) is controlled by the Molecule 

Preferences dialog under Preferences... in the Options menu (Chapter 25). 

 

Set Torsions  

Spartan automatically identifies bonds and rings for conformational searching and specifies 

default step sizes. 

 

Set Torsions allows these defaults to be altered. Selection results in rotatable bonds being 

marked by a gold cylinder and flexible rings being marked by a gold circle around one or 

more atoms, and a message at the bottom left of the screen: 

Three different rule sets have been provided. Normal is appropriate to 

determine lowest-energy conformation or to establish a distribution of 

low-energy conformers, Skeletal is used to build conformer libraries for 

use in similarity analyses and removes conformers that only involve 

hydrogen positions. Normal and Skeletal rule sets consider only chair 

conformers for saturated six-membered rings, for example, cyclohexane. 

Thorough considers twist-boat conformers in addition to chair 

conformers. (Different modes of conformational analysis are discussed 

in Chapter 21.) Selection of rule set is made in the Settings Preferences 

dialog (Preferences... under the Options menu; Chapter 25). 
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Clicking on a bond or an atom contained in a ring selects it for rotation. In the case of a ring, 

rotation means that the atom is to be puckered up and down (restricted rotation). The default 

rotation is provided in a box to the right of Fold at the bottom right of the screen. With 

Normal rules, this is typically 2 or 3 for a single bond (step size of 180° and 120°, 

respectively) and 3 for a flexible ring. A value of either 0 or 1 indicates that the bond (ring) 

is not to be rotated (rotation by 360°). Other integer values may be entered into the box using 

the number pad that appears immediately above. The original settings may be retrieved by 

clicking on Defaults at the bottom right of the screen. Double clicking on a marked bond or 

ring atom removes the marker and eliminates the conformational degree of freedom. 

While conformational degrees of freedom in acyclic molecules are ñeasyò to define (and 

default selections usually appropriate), dealing with medium to large rings can be 

problematic. Experience suggests that torsions applied to ring bonds are likely to be more 

effective in ñcatchingò the multitude of possible conformers than puckering motions applied 

to atoms. Experimentation may be necessary. 

 and  buttons at the bottom right of the screen are available to step through the possible 

single-bond conformers (ring conformers are not provided). Geometries have not been 

optimized and some conformers may be severely crowded. Any conformer can be selected 

in lieu of the initial structure. The full set of single-bond conformers may be placed in an 

unnamed document by clicking on  (to the right of the step buttons) and then clicking OK 

in the dialog that results. Note that duplicate conformers are not removed. 

The total number of conformers (excluding ring conformers) that will be examined in a 

systematic search (see discussion in Chapter 21) is indicated at the bottom right of the 

screen Conformers = xx. This is an upper bound to the number of conformers that will 

actually be kept as duplicates and high-energy conformers are eliminated. This can be 

dragged into the spreadsheet (see discussion in Chapter 22), into the Formulas dialog (see 

discussion in Chapter 23), or into any of the dialogs associated with the Spartan Spectra 

and Properties Database (see discussion in Chapter 23). The number of conformers is also 

available under the Molecule tab in the Molecule Properties dialog (Properties under the 

Display menu; Chapter 22). This can be dragged or posted to the spreadsheet. 

 
 

 

 

 

In practice, an efficient systematic search scheme is employed for 

molecules that incorporate both flexible rings and acyclic free rotors. 

This divides the search into two parts, the first involving only rings and 

concluding with the few lowest-energy conformers and the second starting 

from these conformers to explore the conformations of the acyclic rotors. 
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Generate Isomers  

This generates a list of regio and/or stereoisomers starting from a single structure. Itôs use 

may simply be a convenient way to examine the relative energies of possible isomeric 

products of a chemical reaction or to see which of these products best fits on observed NMR 

spectrum. We first illustrate the more common task of stereoisomer generation. Starting 

from endo-chlorobicyclo[2.2.1]hept-5-ene-2-carbonitrile*, selection of Generate Isomers 

leads to a structure decorated by R/S labels. 

Inversion of C2 and C7 leads to four possible stereoisomers. To select, click on them in turn, 

following which they will be encircled in green. 

 

Clicking on Generate List to the right of Isomers at the bottom right of the screen lead to 

a dialog requesting if the list is to be placed in a new document or added to the current 

document. The four isomers are shown below. 

 

Regioisomer generation is signaled by clicking in order on three bonds, for example, in a 

C1-C2, C2-C3 and C3-C4 in 1-methyl-7- chlorobicyclo[2.2.1] hept-2-ene-2-carbonitrile. 
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*  More precisely this is the syn (chloro), endo (cyano) stereoisomer. 

 

 
 

Clicking on Generate List gives rise to a pair of regioisomers. 

 

Markers for regio and stereoisomers may be applied together. 

Set Isomers can also be used to generate a list of transition states (that would lead to 

stereoisomeric products) starting from a single transition state. We use the Diels-Alder 

transition state leading to the four stereoisomers of 7-chlorobicyclo[2.2.1]hept-5-ene-2-

carbonitrile. The procedure is the same. Starting from a transition state for one of the 

isomers, select Set Isomers and click on C2 and C7. 

 

Clicking on Generate List then provides the four transition states which will lead to the four 

stereoisomeric products. 
 

Generate Tautomers  

This allows tautomers, that is, isomers arising from rapid transfer of hydrogens among 
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heteroatoms, to be identified based only on the structure. Tautomer identification is 

especially important in dealing with heterocyclic compounds where two or more different 

tautomers may exist in equilibrium, and the identity of the dominant species may not be 

obvious. For example, while 2-hydroxypyridine is an aromatic molecule and would be 

expected to be unusually stable, the non- aromatic 2-pyridone molecule is actually 

thermodynamically favored. 

 

This, of course, has consequences in trying to locate a particular molecule in a database 

where it may be represented by a different tautomer. 
 

 

 

The procedure incorporated into Spartan is limited to tautomers involving nitrogen, oxygen, 

phosphorous and sulfur. Tautomers involving carbon have intentionally been excluded. 

There are too many of them, and inclusion would swamp the more likely heteroatom 

tautomers. Also excluded are zwitterion tautomers, for example, H3N
+CH2CO2

ï as a 

tautomer of glycine. In the gas-phase, these are likely to be much less stable than ñneutralò 

forms. Within these limits, all possible tautomers will be identified. 

 

The existence of (heteroatom) tautomers is signaled by the word Tautomer displayed at the 

bottom right of the screen. If tautomers exist, individual structures may be examined or a 

complete list of structures generated by selecting Tautomers from the Search menu (or 

In contrast, Spartan almost always recognizes different ways to draw 

the same structure. For example, benzene can be represented as one 

of two structures with alternating double and single bonds or a single 

delocalized structure in which all bonds are the same and intermediate 

in length between single and double bonds. 

or or 

All of these translate into the same molecule. 
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clicking on the  icon on the top of the screen). Following this, clicking on the step buttons 

at the bottom right of the screen moves through the list of tautomers. Any one of these may 

be used in place of the original. The full list of tautomers may be generated by clicking on 

 (at the bottom right of the screen). This leads to a dialog. 

Clicking on OK dismisses the dialog and leads to a new document containing the full list of 

tautomers. (The original document is unaffected.) Clicking on either Cancel or         dismisses 

the dialog without generating a tautomer list. 

 
 

Constrain Distance       Angle        Dihedral        

These introduce one or more geometric constraints during structure minimization (in build 

mode), and (if requested) during equilibrium or transition-state geometry optimization or 

conformational searching using methods specified in the Calculations dialog 

(Calculations... from the Setup menu; Chapter 21). They also allow for setting a range of 

constraints needed for generation of Energy Profile calculations. Constraints may be useful 

in a number of situations, among them: 

 

 

(i) Constructing conformational energy profiles where one or more dihedral angles need 

to be fixed while other geometrical variables are optimized. 

(ii)  Optimizing molecular structures where the values of certain key parameters are 

known, for example, optimizing the geometry of a molecule with an intramolecular 

hydrogen bond or a disulfide linkage. 

(iii)  Building molecules with unusual geometries, for example, molecules with very long 

bonds, as might be required in the construction of transition states and intermolecular 

complexes. 

Selecting Constrain Distance results in a message at the bottom left of the screen: 

 

 

Clicking on two atoms, or a bond results in a message at the bottom right of the screen: 

 

Tautomers are generated without consideration of steric crowding and 

should be minimized with molecular mechanics (Minimize under the 

Build menu; Chapter 20) prior to using them for quantum chemical 

calculations. It may also be important to perform a molecular mechanics 

search to obtain a guess at the lowest-energy conformer (see 

Calculations... under the Setup menu; Chapter 21). 
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Clicking on  changes it to  and shows the current distance: 

This (constraint) distance can then be changed by clicking inside the box and either typing 

or using the number pad that appears immediately above. Alternatively, the existing distance 

may be used as the constraint distance. If the selected distance had previously been 

constrained, the icon        would have been initially displayed. Clicking on     turns the 

constraint off and returns the icon to      . Finally, the value of the constraint (that may be 

different from the value of the current distance*) may be entered into the spreadsheet by 

clicking on  to its right. Alternatively, the label Constraint (A,B)= may be dragged into 

the spreadsheet, the formula editor (see Formulas under the Display menu; Chapter 22) or 

into any of the dialogs associated with the Spartan Spectra and Properties Database (see 

Databases under the Search menu; Chapter 23). 

This sequence of operations (bond identification followed by turning the constraint on and 

off) may be repeated as many times as necessary. Any bonds or non-bonded distances on 

which constraints are to be imposed are indicated by magenta colored markers. Any 

constraints introduced are automatically enforced only upon energy Minimization in Build 

mode , but needs to be requested for methods specified in the Calculations dialog 

(Calculations... from the Setup menu; Chapter 21). 
 

Angle and dihedral angle constraints are handled in a similar manner. Note that points and 

planes may not be used to define constraints. 

Locking in a constraint leads to two additional text boxes at the bottom right of the screen. 

This allows a sequence of constraints to be defined (from some initial value to some final 

value in a given number of steps) for the purpose of constructing an energy profile along a 

predefined set of coordinates (see Calculations... under the Setup menu; Chapter 21): 

 

The leftmost box specifies the initial value of the constraint, the middle box to the right of 

to the final value, and the rightmost box to the right of Steps: the number of steps. Values 

are specified by clicking inside the appropriate box and using the number pad. For example, 

were the initial value set to 0°, the final value to 180° and the number of steps to 10, then a 

series of ten constraints (0°, 20°, 40°,... 180°) would be specified. This can also be 

accomplished using the Constraint Properties dialog, and the value of the constraint posted 

to the spreadsheet. 
 

*  Note, however, that it may be problematic to carry out a constrained geometry optimization starting from a 

structure that is very different from that satisfying one or more constraints. 



253  

Whether or not constraint markers are included as part of the model (outside of constrain 

distance, constrain angle or constrain dihedral mode) is controlled from the Molecule 

Preferences dialog (Preferences... under the Options menu; Chapter 25). 

 

Define Point  

This defines a point as the geometric (unweighted) center of selected atoms (or points) 

previously defined. Selection results in display of a message at the bottom left of the screen: 

 

Clicking on atoms (or points) in any order and clicking a second time on any one of the 

atoms (or points) defines a point (depicted as a small sphere). As many points as desired can 

be defined and these are treated in the same way as an atom in defining distances, angles, 

etc. Points move with the molecule as its geometry is altered. 

 

Define Ligand Point  

This defines a point of attachment directed perpendicular to the geometric center of the plane 

defined by three atoms (or best plane in the case of four or more atoms). Clicking on atoms 

(or points) in any order and clicking a second time on any one of the atoms (or points) defines 

a ligand point (depicted as a small sphere). As many ligand points as desired can be defined. 

A ligand point shares all the characteristics of a normal point, but may also be used to bond 

to atomic fragments, functional groups, etc. See Make Bond under the Build menu 

(Chapter 20) for a discussion. Ligand points move with the molecule as geometry is altered. 

 

Whether or not points and ligand points are shown as part of the model is controlled from 

the Molecule Preferences dialog (Preferences... under the Options menu; Chapter 25). 

 

Define Plane  

This defines and displays a reference plane. Selection results in display 

of a message at the bottom left of the screen: 

Clicking on three atoms or points defines a plane. As many planes as desired may be defined, 

and these may be used in defining distances, angles, etc. Planes move with the molecule as 

its geometry changes. 

Delete from the Build menu        or the Delete key may be used to remove a 

point or ligand point. 
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Whether or not planes are included as part of the model for an is controlled from the 

Molecule Preferences dialog (Preferences... under the Options menu; Chapter 25). 

 

Define NOE  

Define NOE is used to specify non-bonded distances that need to be kept below a threshold 

value. These follow from NOE (Nuclear Overhauser Effect) measurements and may be 

referred to as NOE conditions or simply NOEs. NOEs are specified by clicking on two (non-

bonded) atoms. In response, a message appears at the bottom of the screen: 

 

Clicking on  changes it to  and enters the default value for the NOE threshold into 

the box. This value can be changed. A line is drawn between atoms that are to be kept within 

the threshold value. 

 

Once set, NOEs are used in conformational searching (conformer distribution only; see 

discussion under Calculations... under the Setup menu; Chapter 21) without further user 

intervention. They act as a post-processor filter to eliminate conformers that do not satisfy 

the constraints and do not affect the speed of the search. 

 

Define CFD  

This defines the position of a new CFD. The CFD Properties dialog (accessible from 

Properties under the Display menu; Chapter 22) allows CFD size and type to be specified. 

Selection results in display of a message at the bottom left of the screen: 

 

 

Delete from the Build menu ( ) or the Delete key may be used to 

remove a plane. 
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Clicking on atoms (or points) in any order, and clicking a second time on any one of the 

atoms (or points) defines the position of a CFD (depicted as a transparent sphere labeled 

Null). Clicking twice on only one atom locates the CFD on the atom. As many CFDôs as 

desired can be defined. These move with the molecule as its geometry is altered. 

Whether or not CFDôs are included as part of the model is controlled from the Molecule 

Preferences dialog (Preferences under the Options menu; Chapter 25). 

 

Set Similarity Centers  

This specifies the set of atomic centers, or Chemical Function Descriptors (CFDôs) or 

pharmacophore elements that are to be used in similarity analysis. Choice of whether the 

similarity analysis is to be based on structure or CFDôs (pharmacophore elements) is made 

from a menu that appears at the bottom right of the screen following selection of Set 

Similarity Centers. This menu is also accessible from the Similarity Analysis task in the 

Calculations dialog (Calculations... under the Setup menu; Chapter 21). 

 

Similarity Based on Structure 

Selection of structure from the Similarity by menu at the bottom right of the screen results 

in a message at the bottom left of the screen: 

Clicking on an atom designates it as an alignment center and it marks it with a violet circle. 

Clicking on the circle removes the designation (and the circle). Hydrogens are not used in 

similarity analysis and may not be selected. 
 

The computer time required for similarity analysis based on structure 

depends on the number of molecules in the query, the number of molecules 

in the library to which comparisons are being made and the choice of 

similarity centers. Single atoms should never be selected as similarity 

centers unless they are unique. Rather, contiguous groups of atoms that 

are likely to be unique should be chosen. For example, analysis carried 

out on morphine based on selection of its phenol and trialkalkylamine 

components (left) will be much faster and more informative than that 

based on selection of the phenol oxygen, two carbons on benzene and the 

nitrogen (right). 
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Similarity Based on CFDôs 

Similarity analysis may also be based on CFDôs. These indicate whether a particular center 

is likely to act as a hydrogen-bond donor or hydrogen-bond acceptor, is likely to take on 

positive or negative charge or is a hydrophobe. This is accomplished by selecting CFD from 

the Similarity by menu at the bottom right of the screen. In response, the selected molecule 

is augmented with CFDôs, and a message appears at the bottom left of the screen: 

Clicking on a CFD designates it as a similarity center and marks it with a violet circle. 

Clicking on the circle removes the designation (and the circle). 
 

 

 

HO* * 
* 

HO* 
* * 

* * * * 

O H 
* 

O H 
*  *   

* 

* 
HO 

HO 

good bad 

This is because there will be many fewer occurrences of phenol and 

trialkylamine substructures in the library entries than there will be 

aromatic carbons and nitrogen atoms and fewer permutations that need 

to be examined and fewer false positive results. 

The computer time required for similarity analysis based on CFDôs 

depends on the number of molecules and/or pharmacophores in the query, 

the number of molecules and/or pharmacophores in the library and the 

nature of the selected CFDôs in the query. For each query/library pair, 

where the query is represented by i CFDôs of type A, j CFDôs of type B, 

k CFDôs of type C, etc., the number of different alignment combinations 

that need to be considered is given by: 

i!j!k! . . . 

(! is the factorial symbol.) This rapidly becomes unmanageable. For 

example, if there are 6 CFDôs of type A, 3 of type B and 2 of type C, the 

number of combinations is 6!3!2! or 8640. Considerable savings can be 

achieved by limiting the number of CFDôs of a given type in the overall 

representation. 
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Similarity Based on a Pharmacophore 

Finally, it is possible to base similarity on a pharmacophore. This is set up in exactly the 

same way as similarity based on CFDôs insofar as the elements of a pharmacophore are 

CFDôs (see previous section). 

 

Align  

This aligns the selected molecule to all other molecules in the same document based either 

on atom labels, on structure, or on CFDôs. If the selected molecule is a pharmacophore, this 

aligns the pharmacophore to all molecules in the same document (based on CFDôs). Choice 

of whether alignment is based on labels, structure or CFDôs is made from the Align by menu 

that appears at the bottom right of the screen. 

Align Based on Labels/Align Based on Structure 

Selection of either Labels or Structure from the Align by menu results in a message at the 

bottom left of the screen: 

The terms ñalignmentò and ñsimilarity analysisò have subtly different 

meanings inside of Spartan. Alignment refers to the operation in which 

the molecules in a document are reoriented to best coincide with the 

selected molecule (or pharmacophore). Where a molecule is selected, 

alignment may either be based on a set of atoms or on a set of CFDôs. 

Where a pharmacophore is selected, alignment is based on a set of CFDôs. 

A single reorientation is provided for each molecule in the document that 

can be aligned to the selected molecule (pharmacophore). 

Similarity analysis refers to the operation in which all molecules in a user- 

specified library comprising one or more documents are compared one- 

on-one to all molecules and/or pharmacophores in the selected document 

(in the graphical user interface). As with alignment, either structural 

elements or CFDôs may be employed. The result is a similarity score 

from 0 to 1 (1 is perfect) and a manipulable model of the two molecules 

(or molecule and pharmacophore). It is likely that most comparisons 

will not be successful, and also that some comparisons may lead to 

more than one score (corresponding to different orientations of the two 

components). Similarity analysis both by structure and CFD as well as 

to a pharmacophore is discussed further in Chapter 21. 

In short, the role of alignment is to orient molecules and/or pharmacophores 

in order to highlight their common features, while the role of similarity 

analysis is to rank pairs of molecules or molecule/pharmacophore pairs 

according to the extent of their common features. 
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Clicking on an atom designates it as an alignment center and marks it with a red circle. 

Clicking on the circle removes the designation (and the circle). Following selection of 

alignment centers, clicking on the Align by button at the bottom right of the screen aligns 

the molecules. If no atoms are selected prior to clicking on Align by , then alignment is based 

on all (non-hydrogen) atoms. 

Following alignment, two or more molecules may be displayed at once (see Spreadsheet 

under the Display menu; Chapter 22). Their motions (coordinates) will be coupled 

following alignment but may be uncoupled allowing the aligned molecules to move 

independently (see Coupled under the Model menu; Chapter 18). Note that alignment 

center selections are kept and molecules can be realigned by again selecting Align from the 

Geometry menu (or clicking on ) followed by clicking on the Align by button. 

Align Based on CFDôs 

It is also possible to base molecule alignment on CFDôs. These indicate whether a particular 

center is likely to act as a hydrogen- bond donor or acceptor, is likely to take on positive or 

negative charge or is a hydrophobe. This is accomplished by choosing CFD from the Align 

by menu at the bottom right of the screen followed by clicking on the Align by button. In 

response, the selected molecule is augmented with CFDôs, and a message appears at the 

bottom left of the screen: 

Clicking on a CFD designates it as an alignment center and marks it with a red circle. 

Clicking on the circle removes the designation (and the circle). 

The CFD Properties dialog (accessible from Properties under the Display menu; Chapter 

22) allows definitions of the individual CFDôs to be altered. 

Following selection of CFDôs, clicking on the Align by button at the bottom right of the 

screen aligns the molecules. If no CFDôs are selected prior to clicking on Align by , then 

alignment is based on all CFDôs. 

Following alignment, one or more molecules may be displayed at once using spreadsheet 

functions (see Spreadsheet under the Display menu; Chapter 22). Their motions 

(coordinates) will be coupled following alignment but may be uncoupled allowing the 

aligned molecules to move independently (see Coupled under the Model menu; Chapter 

18). Note that alignment center selections are kept and molecules can be realigned by again 

selecting Align from the Geometry menu (or clicking on ) followed by clicking on the 

Align by button. 

 

Align to Pharmacophore Definitions 

Finally, it is possible to align molecules to a pharmacophore contained in the same list. This 

is set up in exactly the same way as alignment based on CFDôs insofar as a pharmacophore 

element is a CFD (see previous section). 

For both structure and CFD alignment (and for alignment to a pharmacophore), an alignment 
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score from 0 to 1 (perfect alignment), is available in the spreadsheet. This is accessed by 

clicking on the Add button at the bottom of the spreadsheet and selecting Alignment Score 

from the Molecule List tab of available properties (see Spreadsheet under the Display 

menu; Chapter 22). A score of 0 is assigned to molecules that cannot be aligned to the 

selected molecule. 

 
Check Mark  

Check Mark is used to designate specific atoms in BSSE (Basis Set Superposition Error) 

calculations as well as designation of (typically ring) atoms in NICS calculations (Nucleus 

Independent Chemical Shifts). 
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Chapter 20  
The Build Menu 

 
 

 

The Build menu provides access to a sketch palette for drawing organic and organometallic 

molecules in 2D, model kits and associated tools for building and editing organic, inorganic 

and organometallic molecules as well as polypeptides and polynucleotides in 3D, for 

guessing transition-state structures and a facility for generating lists of substituted 

molecules. The Windows version provides a seamless access to ChemDraw. 2D to 3D 

conversion and 3D structure refinement is by way of molecular mechanics. With 

Spartanô26, the Build menu gives the ability to attach experimental proton and 13C NMR 

chemical shifts as well as observed HH and CH couplings to either 2D drawings or 3D 

models. 

Specification of 3D molecular structure is a necessary first step to any molecular mechanics 

or quantum chemical calculation. Spartan provides a variety of tools. Organic and 

organometallic molecules can either be rendered as 2D sketches and later brought into 3D, 

or directly constructed from 3D fragments. Polypeptides and polynucleotides need to be 

built in 3D. 

 

2D Sketch Palette 

The 2D sketch palette contains tools for making and manipulating drawings. There are also 

tools for specifying charges and radical sites, for adding cues to designate stereochemistry 

and for setting limits for a substructure search. Directly above the palette are icons that place 

curved arrows on 2D drawings thereby defining chemical reactions as well as for attaching 

experimental proton and 13C chemical shifts and observed HH and CH couplings to 2D 

drawings. 

 

 
 

 

Palette Atoms. H, B, C, N, O, F, Si, P, Cl, Br and I only. 
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More: Periodic Table/Groups/Ligands/Substituents. Clicking on the More button that 

appears below H and B, leads to a dialog that allows any atom to be specified from the 

Periodic Table (Periodic Table tab), a variety of common functional groups (Groups 

tab) and a number of common organometallic ligands (Ligands tab). Clicking on an 

element, group or ligand dismisses the dialog and results in whatever was selected being 

placed in the icon and available for use. 

Common Rings. Three icons facilitate the rapid addition of common rings. The upper 

icon is for benzene        , the middle icon is for cyclohexane, both as a  ñflatò        drawing      

and as a chair , and the lower icon is for cyclopropane , cyclobutane , 

cyclopentane  and cycloheptane . In the latter two ring icons, double-tap or 

double-click exposes the additional selection options. 

Common Carbonyl Groups. Three icons facilitate the rapid addition of carbonyl , 

carboxylic acid/ester  and amide  groups to drawings. In the latter two icons 

double-tap/double click exposes alternate attachment options. 

Stereochemical Markers. Wedges and dashes, represented by   and       , can be used 

to designate in-out stereochemistry. Immediately to the right is a single-bond (unwedged) 

marker . Once a stereochemical marker has been added to a drawing, it is possible to 

designate the orientation of hydrogen atoms and/or substituents bonded to six-member 

rings as ax(ial) or eq(uatorial) (ax and eq labels appear only on the drawing, not in the 

palette). 

 

Open-site Markers.  designates an ñopen-siteò in a drawing. Searching a database will 

return all structures with any atoms (including hydrogen) or groups in open sites. 

Charge/Radical Markers. Conventional bonding rules (neutral C makes 4 bonds, neutral 

N makes 3 bonds, and so on) are enforced when 2D perspective drawings are converted into 

3D models. This is accomplished by adding hydrogen atoms to the drawing. For example, a 

single carbon on screen will give methane, a single line, ethane, and a double line, ethylene. 

(Hydrogen atoms are added to nitrogen, oxygen, phosphorous and sulfur in the 2D 

drawings.) When another outcome is desired, for example, for an ion or free radical, charge 

or radical markers must be added to the drawing. 

Two icons        and , are used to label atoms that bear formal charges.      . is used to label 

atoms that are neutral, open-shell radicals. Each of these markers affects the number of 

electrons and the number of hydrogen atoms added to the 3D model. For example, O will 

produce a 3D model of water, H2O. However, adding the appropriate marker will result in 

3D models of H3O
+ , HOï , or HO radical , respectively. Only one charge/radical 

marker can be assigned to an atom (radical cations and radical anions cannot be specified in 

this way) but as many atoms as desired may be provided charge or radical designations. The 
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sum of charges and radical sites will be used to determine overall molecular charge and 

number of unpaired electrons needed for a quantum chemical calculation. 

Only one charge/radical marker is displayed on the palette, but clicking on the icon will 

cause each marker to appear in turn. Examples of the use of reaction arrows is provided in 

Chapter 23. 

Transition State Searching.  The Guess Transition States Icon remains available from 

the tool bar or the Build menu and allows for designation of one or more reaction arrows 

enabling access to Spartanôs automated procedure for guessing transition states. The tail of 

the arrow corresponds to the source of the electron pair. If the source is a lone pair, then 

select the atom that holds the lone pair. If the source is a bond, then select the bond. Clicking 

on an atom or bond highlights (colors gold) the atom or bond. Clicking again on the same 

atom (or same bond) removes the highlighting. The head of the arrow corresponds to the 

destination of the electron pair. If the destination is an atom (leading to a lone pair), then 

select the atom that will hold the lone pair by clicking on it two times. If the destination is 

an existing bond (leading to an increase in bond order from single ­ double or double ­ 

triple), then select (click on) the bond. If no bond presently exists, select (click on) the two 

atoms that will become bonded upon reaction. These operations result in a curved arrow 

being drawn on the reactant structure. This extends from an atom, or the center of a bond to 

an atom, or the center of a bond, or the center of a dotted line that has been drawn between 

atoms that are to be bonded. 

Note that the head and tail do not need to reside on atoms or bonds on the same fragment. 

Also the tail may involve atoms of two detached fragments. 

The process (tail selection followed by head selection) is repeated as necessary to fully 

define the reaction. Incorrect reaction arrows may be removed by clicking on      from the 

palette and clicking on the arrow. You then need to select         to continue arrow selection. 

Once defined, reaction queries can be used to relate the properties of the products of 

chemical reactions to those of the products for the purpose of mining the Spartan Spectra 

and Properties Database. Full discussion is provided in Databases in Chapter 23. Reaction 

queries can also be used to search the Spartan Reaction Database for transition-state 

structures associated with the defined reaction (also discussed in Databases). In both of 

these cases, Open-Site Markers or structure queries (discussed in Structure Query in 

Chapter 23) will also normally be employed. Finally, reaction queries may be employed to 

automatically provide a guess at a transition state based on similarity to an entry in the 

Spartan Reaction Database (see discussion in Transition State in Chapter 23). Here, no 

additional information is required. 

Drawing Tools.  undoes the most recent drawing operation.  removes or modifies 

parts of a drawing.  deletes an entire drawing (a warning is provided).  improves the 

readability of a drawing by applying a ñclean upò procedure.       exits sketch mode. 
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Four icons (in addition to the Edit icon ) appear on top of the tool palette. These allow 

ñcurly arrowsò to be added to the sketch to define a transition state, input of experimental 

proton and 13C chemical shifts and identification of observed HH and CH couplings. 

 

Experimental Data 

Proton and 13C Chemical Shifts ( ) 

Experimental proton and/or 13C chemical shifts can be added to a 2D drawing. Starting from 

a 2D sketch (promophyllin A), click on         above the sketch pad and then on a carbon. If 

it is a quaternary carbon (as shown below) the only change to the sketch will be that the 

letter C will appear. 

 

 

 

 

click on a carbon Ą 
 

 

Click on Edit to the right of Expt. Chem. Shift at the bottom right of the screen and enter 

a value for the experimental 13C shift using the keypad that results. Click on Enter and the 

keypad will be dismissed, and the chemical shift will be attached to the sketch. 

 

If the selected carbon had one or more attached hydrogens and experimental chemical shifts 

were to be entered, these will be shown with the selected carbon. 
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Clicking on one of these hydrogens (only a single hydrogen in the example) results in a 

keypad into which the experimental proton shift may be entered. Clicking on Enter again 

dismisses the keypad and attaches the chemical shift onto the sketch. 

 

 

CH Couplings     

Experimental 2-bond (H-C-C) and 3-bond (H-C-C-C) CH ñobservedò couplings (not 

numerical values for coupling constants) may be attached to a 2D sketch (with or without 

experimental chemical shifts attached) by clicking on a carbon (H-C-C or H-C-C-C). If there 

is only one hydrogen as in this first example, it will be drawn and all carbons which either 

2 or 3-bond coupling can occur will be highlighted by translucent red circles. Clicking on 

one of these carbons (in this case three bonds removed)will remove the circles and draw an 

arrow between the first selected carbon (corresponding to the H in H-C-C-C) and the second 

selected carbon (corresponding to H-C-C-C). 

 

  
 

The arrow indicating a 3-bond coupling will remain in place. 

 

If on the other hand, the initially selected carbon is bonded to more than one hydrogen, an 

additional click is required to identify which hydrogen before a destination (carbon) is 

selected. 
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HH Couplings     

Experimental 3-bond HH observed couplings (not numerical coupling constant values) 

(HCCH) may also be attached to a 2D stretch. There are several cases depending on whether 

more than one hydrogen is attached to one or both of the carbons and whether or not one or 

both of the hydrogens are explicit in the 2D sketch. 

If one of the hydrogens is explicit, click on it following selection of JHH). This results either 

in one or more carbons being marked with a translucent green circle. Select the relevant 

carbon (there is only one in this example) and click on it to display the hydrogens attached 

to it (there are two in this example, if there were only one, the selection of the carbon would 

have eliminated the step). These are also marked by translucent green circles. Click on the 

appropriate hydrogen and the coupling will be displayed by a green arrow. 

If hydrogens are not explicit, click on the carbon to which they are attached. Click on the 

appropriate hydrogen and a coupling arrow will appear. 

 
















































































































































































































































































































































































































































































































































































































































































